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1.1 Objectives 

 Understand what is a Civil Terrain Model 

 Learn how to import a Civil Terrain Model from a .tin 

 Learn how to display a Civil Terrain Model 

1.2 Definitions 

A Terrain Model is a set of three-dimensional triangles mathematically computed from point data 

collected on the surface being modeled. Models are used to define highly irregular surfaces, 

particularly the surface of the earth, but can be generated for proposed surfaces, subsurface 

geotechnical layers, and etcetera. Terrain models are also referred to as digital terrain models 

(DTMs), triangulated irregular networks (TINs), or triangulated surfaces. 

The MicroStation Terrain Model tools support importing and labeling terrain contours and spots 

on terrain models. You can import a terrain model into a DGN to use its data. Terrain models 

imported from the LandXML file format are supported within MicroStation. However, any 

manipulation or importing from Civil products must be done within Bentley Civil. 

1.3 Terrain Model as a MicroStation Element 

A terrain model is recognized as a MicroStation element type as of MicroStation V8i 

(SELECTseries 4). When you select a terrain model, the Element Selection tool Element Type tab 

indicates that it is a Terrain element type. 

1.4 Terrain Models and Feature Definition 

The display of terrain model properties can be controlled by using a feature definition. You can 

apply it to any terrain model. 

 

 

1.4.1 Applying an Feature Definition to a Terrain Model 

1. Open the MicroStation file where the terrain model was created. 

2. Use the Element Selection tool to select the terrain model. 
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3. In the Heads-up display toolbox, select 

Properties.  

4. Or select the Element Information tool.  
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5. On the General tab click the arrow to the right of the Template property 

and select an element template. 

 

The properties of the selected element template are applied to the terrain model. 

1.5 Referencing Terrain Models 

People in different job roles may want to see terrains displayed differently. For example, a 

designer of surfaces may need to see triangles, while a designer of drainage features may need to 

see contours. Rather than duplicating the terrain model in various places, the best workflow is to 

maintain a single terrain model and reference it into other DGN files. 

When a DGN file containing a terrain model is referenced into another DGN file, you can allow 

the terrain model to be displayed differently in the other file. This allows the presentation to vary 

for different purposes, without changing the terrain model display in the original DGN file. 

To Override the Symbology of a Terrain Model 

1. Attach as a reference the DGN file containing the terrain model by 

selecting the References  icon from the Primary Tools. 
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2. Select the terrain element from the MicroStation view. 

 

3. From the Primary Tools toolbox, select the Element Information tool. 

The Element Information dialog opens. 

4. On the Reference tab set the Override Symbology property to Yes. 

 

5. Change other display properties as needed or select an element template to 

apply to the terrain model. 

The display of the terrain model changes in your DGN file according to these settings, but not in 

the original DGN file. 
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1.6 Overview of Civil Terrain Model 

Terrains Models (TM) play a key role in Infrastructure and Mapping workflows. The data 

collection methods underlying these models are ever increasing in detail and coverage. Therefore, 

resulting terrains need to be accessible across a variety of Infrastructure and Mapping workflows. 

Data in a variety of formats including raw graphical elements 2D and 3D can be provided for 

consumption into the terrain model. The existing ground terrain model can also be used as the 

starting point for the creation of a proposed design terrain model using the Corridor Modeling 

tools. 

1.7 Terrain Model Features 

The concept of feature types is used throughout the Terrain Model tools. The available feature 

types are defined below. 

1.7.1 Spot or Spot Elevation 

Points (with X, Y, Z data) that have no functional relationship to any other point. Random survey 

shots in open terrain would be an example of random spots. Point elements such as cells, circles, 

and text strings are typical MicroStation elements used to graphically define spot elevations, lines, 

 

line strings, and other longitudinal elements are equally valid. The software creates a spot 

elevation for each vertex of each longitudinal element. 

If a section is cut through this digital terrain model at the location A-A, where the elevation of the 

triangle leg as linearly interpolated between the triangle vertices is plotted along the distance of 

the section, the section would look as shown in the picture below. 
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1.7.2 Break Lines 

Breaks are used to designate linear features such as edges of pavement, ditch bottoms, ridges, 

etcetera where an abrupt change of slope occurs. Any longitudinal element may be defined as a 

break line. Triangles will not cross a break line in the terrain model. 

Adding a break line to the same set of points (used in the above illustration) will produce the 

terrain model as shown below. 

 

Cutting a section at the same location will produce very different results as shown in the section 

below. 

 

1.7.3 Soft Break Line 

A soft break line is a break line; however, if it crosses a break line, it will not affect the 

triangulation and is ignored.  This feature type is not frequently used.  It can be used during 

survey collection to identify a feature that is a breakline, but is known to cross another break line, 

resulting in crossing breaklines. 

1.7.4 Graphic Break Line 

A graphic break line is a soft break line that is not stored in the terrain model.  This feature type is 

not frequently used. 

1.7.5 Contour 

A contour is an element or set of elements of the same elevation. Contours may be used as source 

data to generate a terrain model, or may be computed (drawn based on terrain model).  For 

example, you may want to create a terrain model from digitized contours from an old plan. 
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1.7.6 Hole 

An area defined by a closed shape that demarcates a region where the current terrain is ignored 

and the underlying terrain is utilized.  For example, holes can be used for marking areas where 

you would not want to disturb during a design. 

 

1.7.7 Boundary 

A boundary is the maximum external limits a terrain model can extend.  No triangles will be 

created outside of this boundary.  For example, a boundary can be changed on a terrain model by 

deleting triangles or changing the Edge Method.  A new boundary can be added to an existing 

terrain model using the Add Features command. 
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1.7.8 Drape Boundary 

A drape boundary is a surface boundary that determines its elevations by draping on the 

underlying surface. For example, you may use a drape boundary to limit the extent of the triangles 

by drawing the boundary as an element, using the Add Features command to add the boundary to 

the terrain model.  The new boundary would use the elevations of the underlying surface as the 

boundary elevations.  

1.7.9 Voids 

An area defined by a closed shape that demarcates a region of missing data or obscure areas. No 

point or break data located within the void area is utilized and no triangles are created inside the 

void areas. The Void coordinates are included in the triangulation and void lines between 

successive void coordinates are inserted as drape lines on the surface. Therefore, they do not 

change the slope or elevations of the surface. 

 

1.7.10 Drape Void 

An area defined by a closed shape that demarcates a region of missing data or obscure areas. No 

point or break data located within the void area is utilized and no triangles are created inside the 

void areas. In the drape void, the void coordinates are not included in the triangulation. Voids are 

inserted post triangulation. The void coordinates and lines are draped on the terrain model surface. 

Even though a user must provide an elevation for Drape Void vertices, the user elevations are 

changed to the elevation of the terrain model surface at the XY Drape Void coordinate position.  

For example, if you don’t have accurate survey data for the void area, you may want to use the 

drape void. 

 

VOID AREAS 



GEOPAK Road 1 Chapter 1 – Introduction to the Terrain Model   
 

 

4/11/16 Missouri Department of Transportation 1-9 

 

1.7.11 Break Void 

An area defined by a closed shape that demarcates a region of missing data or obscure areas. No 

point or break data located within the void area is utilized and no triangles are created inside the 

void areas. It differs from Voids and Drape Voids in that it utilizes the vertex elevations of the 

graphical element, while the void lines between successive void coordinates are inserted as break 

lines. Therefore, break voids change the slope and elevations of the surface.  For example, if you 

have accurate survey data for the void area, you may want to use a break void.  These could be 

used for surveyed building footprints or ponds where the points have been accurately surveyed. 

 

1.7.12 Islands 

An area defined by a closed shape that demarcates a region of data wholly within a void. 

Example, islands in the middle of rivers, lakes, etcetera.  

 

  

ISLAND 



Chapter 1 – Introduction to the Terrain Model  GEOPAK Road 1  
 

 

1-10 Missouri Department of Transportation  4/11/16 

 

1.8 Triangulation Options - Edge Method 

Several of the terrain model tools utilize the triangulation options section where the Edge Method 

is specified. 

Many of the external edge triangles are thin and narrow and not representative of the surface. This 

is particularly evident where the edge of the data set is concave in nature. One approach to 

eliminate these triangles is the use of the Edge Method. 

The Edge Method defines which triangles around the edge of a Terrain Model get created. 

There are two options to control the edge triangles. The terrain model is updated dynamically 

when the Edge Method changes so if the results are not acceptable, change the value until the 

results are acceptable. Only triangles along the edge of a terrain model are affected by this 

parameter. Interior triangles are never removed. 

There are three settings for the Edge Method option:  None, Remove Slivers, and Max Triangle 

Length. 

None - No external triangles are deleted. Note the Maximum Triangle Side Length is ignored. 

There are no user defined parameters 

Slivers - Long, thin triangles are dissolved based on a formula hard coded within the software. 

Note the Maximum Triangle Side Length is ignored. There are no user defined parameters. 

Max Triangle Length - External triangles whose external edge is longer in length than the user 

specified distance are deleted. Note the maximum length does not apply to internal triangles, only 

those on the edge of the model. Specify the Maximum Triangle Length in master units. 
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1.9 Terrain Models in Element Information 

As a terrain model is a MicroStation element, a wealth of information can be found in the Element 

Information dialog. One important option is display on/off of terrain model features. For example, 

you can turn on and off the display of the contours, triangles, and voids. 

The element information can be accessed by selecting Element >Information off of the menu or 

by selecting the properties option from the context sensitive toolbar that pops up when the mouse 

hovers over an element when the Element Selection tool is active. 

The element information can be accessed by selecting Element >Information off of the menu.  

Some of the items in the Element Information dialog are informational and cannot be changed.  

Some of the items can only be changed if you are in the MicroStation file that contains the Terrain 

Model.  Following are descriptions of the functionality of each tab in the Element Information 

dialog. 

1.9.1 General 

This displays the terrain model Description and Name.  It also identifies the display symbology of 

the terrain model.  The symbology is only used if the Feature Definition was not defined during 

the creation of the terrain model.  You can also select a Template in order to change the display of 

the terrain model within the General tab. 
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1.9.2 Extended 

Allows you to set the terrain to Snapable or Not Snapable, Lock or Unlock the terrain, and view 

the model it is in, its creation date, and the modification state of the terrain. 

 

1.9.3 Information 

Lists the X, Y, Z range of the selected terrain model. In addition, it has the number of each type of 

source features, i.e., the number of points, voids, or break lines. 

 

1.9.4 Edge Method 

This displays the Edge Method used when creating the terrain model. 
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1.9.5 Calculated Features 

Turns the display off or on for any data in the terrain model that is not source data. Example, 

triangles, high points, low points, and flow arrows. The change is immediately visible on the 

screen, it is not necessary to exit the file and re-enter. 

 

1.9.6 Source Features Display 

Turns the display off or on for any data that was used to create the terrain model. The change is 

immediately visible on the screen, it is not necessary to exit the file and re-enter. 
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1.9.7 Feature 

Element Information will list the feature name and feature definition of the selected terrain model. 

 

Quick Properties of Terrain Models 

Selecting the terrain model using the Element Selection tool and clicking on Properties opens the 

terrain model Properties pop-up where you can set the maximum triangle length, turn on/off 

various graphical features and change the feature name and definition. 

   

1.10 Terrain Model Create Toolset 

 

Terrain Model Create - Contains tools to create a terrain model from graphical elements, ASCII 

files, point clouds, LandXML, and import existing surface files. Tools are also available to merge 

two or more models together and/or to clip models. 
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 Create From File creates a Terrain Model by importing an existing digital terrain model 

file.  The file types supported include the GEOPAK .tin and .dat file types.  Import options 

include Import Terrain Only, Import Features Only and Import Both.  Importing features only 

writes the features to the design file as MicroStation graphics not tied to the Terrain Model. 

 

 Create Terrain Model from ASCII File creates a terrain model by importing from an 

ASCII file type using customized user file formats. 

 Create Terrain Model by Graphical Filter is an automated way of storing search settings 

for graphic elements to automate Create Terrain Model by Filter Elements. Uses the settings 

stored by Graphical Filter Manager  to create the terrain. The Graphic Filter Manager icon is 

located in the Terrain Model tasks group. 

 

 Create from Point Cloud creates a terrain model from MicroStation Point Cloud data.  The 

Point Cloud has to be attached to the dgn prior to being able to create a Terrain Model. 

1. Select MicroStation File >Point Clouds. 

2. Select File > Attach. 

 Create from Elements creates a terrain model from 3D graphical elements.  The elements 

can be in a reference file. 

 Create Complex Terrain Model creates a new Complex terrain model by 

merging/appending multiple terrain models. 

 Create Clipped Terrain Model creates a terrain model by clipping an existing terrain 

model and providing an optional horizontal or vertical offset.  
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 Create Delta Terrain Model creates a new terrain model using the difference between 2 

terrain models or a terrain model and a plane (elevation).  Vertical offsets can be assigned to the 

Terrain Models in the Terrain Model to Terrain Model method. 

 Create Terrain by Text Level Interpolation creates a terrain model from 2D graphics 

which also contain an elevation label. 

 Create Corridor Alternate Surfaces is used to manage alternate surfaces in the template.  

This command is useful for the generation of surfaces to be exported to Automated Machine 

Control LandXML files. 
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1.11 Individual Exercise: J2P0200 Terrain Model 

1. Within the data_01\data folder,  open the file: Introduction_To_Terrain_Models.dgn 

2. Select File > New and create a new MicroStation file using the Source File:  

pw:\CADD_Standards\Seed Files\Design - English\i_project_3d_PowerGEOPAK.dgn 

Note: If this is not the default seed file, use the Seed… button to locate this seed file in the 

Projectwise.   

   

3. Key in the new file name Terrain_J2P0200_Existing.dgn.  This will be the existing 

ground file for the project.  It will be created in project wise. 

4. In the Folder section, save the file to the folder Data  

5. Select OK. 

6. Check in the file Introduction_To_Terrain_Models.dgn. 

7. Expand the Terrain Model Tasks group. 

8. Select   Create From File icon.  
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9. In the Select Files To Import dialog select: J2P0200.tin 

10. Click Add and OK.  This will bring up the Import Terrain Model(s) dialog. 

11. In the Filter section, set the Source File Units to US Survey Feet. 

12. Set the Feature Definition to Feature Definition > Existing Triangles. 

13. Set the Import Options to Import Terrain Only. 

  

14. Click Import and close the Import Terrain Model(s) dialog. 

15. Fit the view. 

16. Select the Element Selection tool.  

17. Data point on the boundary of the Terrain Model and wait for the context sensitive menu 

to appear. 
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18. Select Properties. 

19.  Change the Edge Method to Max. Triangle Length.  Set the Length to 150.00. 

20. Toggle On and Off the Source Feature Display items such as Contours, Triangles, etc. 

and review the display 

21. Turn Off the Source Feature Display items. 

22. Open the Project Explorer select the Civil Model tab. 

23. Expand the Civil Data > Terrain_J2P0200_Existing.dgn > Terrain Models folders. 

24. Expand the Terrain Model leaf.  Notice that it has the source file information. 

25. Right-click on the Terrain Model:J2P0200 and review the options in the pop-up menu. 

    

26. Select Element Information and review.  Here is where the terrain model can be 

renamed, a new feature definition assigned, and feature display turned on/off. 
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27. Expand the Feature Field and set the Feature Definition to Existing Contours 10-2. 

 

28. At the top of the Element Information Dialog expand the Calculated Features Display 

leaf and select Contours.  Adjust the Major and Minor Intervals to 5 and 1. 

  

29. Data point on the boundary of the Terrain Model and wait for the context sensitive menu 

to appear. 
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30. Select Properties. 

31. Set the Feature Definition to Feature Definition > Existing Boundary. 

32. Select File > Update Server Copy. 
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2.1 Objectives 

 Understand and use Feature Definitions 

 Create PI based horizontal geometry using the Complex by PI tool 

 Use the OpenRoads Technology heads-up display and element manipulators 

 Associate Design Standards with alignment geometry and review feedback when design 

standards are violated 

 Import geometry from native geometry database 

 Discuss using manipulators and handlers 

2.2 Definitions 

Civil Geometry is a dynamic, interactive, rules-based approach to geometry that provides an 

unprecedented level of associativity by preserving design intent, snaps and Civil AccuDraw input. 

The results of the tools are intelligent MicroStation graphic elements which can be dynamically 

edited and associations between elements are automatically updated.   

In addition, the result of using the Civil Geometry tools are graphical geometry elements that are 

stored as MicroStation elements. No external geometry file is required. The MicroStation 

elements serve as the geometry elements with additional intelligence applied to store the rules and 

associations. 

The Civil Geometry tools are installed as a part of GEOPAK. In order to be consumed by 

processes within GEOPAK, the civil geometry stored in the MicroStation elements must be 

written to the native application coordinate geometry .GPK file. This function can be configured 

to happen automatically based on properties of feature definitions, or it can be done manually. 

2.2.1 Coordinate System 

The Coordinate system is defined with XYZ Coordinates.  The X and Y Coordinates define a 

horizontal plane, while the Z Civil defines the vertical dimension.  All points in a civil geometry 

element are defined by at least an X coordinate and a Y Coordinate.  If an elevation is to be 

stored, the Z Coordinate will also be defined. 
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The XYZ Coordinates can also be referred to in Northing (N), Easting (E), and Elevation (Z) 

Coordinates.  The Northing Civil refers to the Y value, the Easting Civil refers to the X value, 

and the Elevation refers to the Z value. 

 

The user must be aware of the Coordinate system the data is in, and the Coordinate system that 

GEOPAK is using.  When referring to the XYZ coordinate system, the Coordinates are listed as 

(X, Y, Z).   When referring to the Northing, Easting, Elevation coordinate system, the 

Coordinates are listed as (N, E, Elev.).  When translating this to the XYZ coordinate system, the 

Coordinates would be (Y, X, Z). 

2.2.2 Points 

Points are defined by a single set of Coordinates.  Each point will have an X and a Y Coordinate.  

The point may also have a Z coordinate if an elevation is defined.   

Point names are alpha-numeric.  If alphabetic characters are used, they must come before any 

numeric characters.  The point name must contain at least 1 numeric character at the end of the 

name.  Names can be up to 15 characters in length, although limiting the name to 8 characters is 

recommended. 

Points can be stored from a set of Coordinates, or located from other elements.  To define a point 

from another point, a distance and direction need to be defined. 
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Modifiers can be added to the direction and distance.  An offset can be applied.  This will locate 

the point at the specified distance and direction from the starting point, then perpendicular to the 

specified direction for the specified offset distance.  A positive offset will go to the right of the 

specified direction, and a negative offset will go to the left of the specified direction. 

 

2.2.3 Lines and Linear Elements 

Lines are defined by a location point and a direction, and are infinite in length. 

Civil Geometry Linear Elements are a portion of a line that is defined by a beginning and an 

ending point. 

Linear Element names can be alphanumeric up to 15 characters, but should not be numeric-alpha 

if the elements are going to be brought back to Native GEOPAK. 
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2.2.4 Curves 

Curves are a segment of a circular arc.  Curves can be defined by either the arc method (central 

angle that produces a 100’ arc) or chord definition (central angle that produces a 100’ chord).  

MoDOT uses the arc definition for all new alignments; however the chord definition has been 

used in the past, and may still be shown on old plans.  This is configured in design file settings > 

Civil Formatting. 

A curve has several points associated with it.  These points help to define the curve, and are 

stored automatically when the curve is stored. 

PC – Point of Curvature; Beginning of the curve. 

PT – Point of Tangency; End of the curve. 

PI – Point of Intersection; Point where the two tangents meet. 

CC – Circle Center; Point at the center of the circle from which the curve is segmented. 

 

Curve names can be any alpha-numeric characters up to 15 characters in length to be honored 

when brought back to Native GEOPAK. 

2.2.5 Spirals 

Spirals are a transitional curve.  Typically a spiral will transition from a tangent (infinite radius) 

to a specified radius defined by a curve.  Spirals can also transition between 2 specified radii as 

defined by 2 curves. 
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Spiral names can be any alpha-numeric characters up to 15 characters in length to be honored 

when brought back to Native GEOPAK. 

Several points are also stored with a spiral.  They are as follows: 

TS – Tangent to Spiral Point 

SC – Spiral to Curve Point 

CS – Curve to Spiral Point 

ST – Spiral to Tangent Point 

PISCS – Overall Point of Intersection for the spiral-curve-spiral combination. 

 

2.2.6 Chains 

Chains are a combination of other elements.  They can consist of points, curves, spirals, or other 

chains.  Chains can represent horizontal alignments, or the horizontal location of some element.  

Chains have stationing associated with them.  Locations along the chain can be determined by the 

stationing.  If the stationing is adjusted along the chain a station equation is used.  The stations 

from the beginning of the chain to the first station equation are referred to as Region 1.  The 

stations from the first station equation to the second station equation or the end of the chain are 

referred to as Region 2. 

 

Chain names can be any alpha-numeric characters up to a length of 15 characters. 

2.2.7 Profiles 

Profiles are vertical alignments defined by stations and elevations.  They are associated with 

some horizontal plan element.  Profiles can be stored with or without vertical curves.  Profiles 
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without curves generally represent the existing ground profile, or a ditch profile.  Profiles with 

vertical curves are generally used as proposed corridor. 

 

2.3 Open Roads Preferences 

The seed files delivered in the workspace have MoDOT design file preferences configured. 

2.3.1 Workspace Preferences 

This dialog provides settings for the cursor prompt, manipulators, and various operational toggles.  

Enable this dialog from the Workspace > Preferences menu and selecting the View Options-

Civil category. 

Manipulator Settings 

These settings allow the user to control the settings and symbology of the civil geometry 

manipulators and any associated text. 

Superelevation Settings 

When the super elevation components are drawn into the design file, these two options allow 

the user to specify whether they are to be drawn as Color Shaded Fill or Boundary Only. 

Survey Locator 

This setting is used by the Survey tools to control the display and symbology of the locator. 
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Maximum Error Ellipse 

Survey only - This setting allows the user to specify a major error ellipse value with regard 

to the standard deviation resulting from a Least Squares Adjustment. Any standard deviation 

exceeding this limit results in a graphical flag based on this symbology. 

Medium Error Ellipse 

Survey only - This setting allows the user to specify a medium error ellipse value with 

regard to the standard deviation resulting from a Least Squares Adjustment. Any standard 

deviation exceeding this limit results in a graphical flag based on this symbology. 

Minimum Error Ellipse 

Survey only - This setting allows the user to specify a minimum error ellipse value with 

regard to the standard deviation resulting from a Least Squares Adjustment. Any standard 

deviation exceeding this limit results in a graphical flag based on this symbology. 

2.4 Design File Settings 

  

Design File Settings dialog provides options for civil settings that control civil annotation within 

the design file. Enable this dialog from the Settings > Design File menu and selecting the Civil 

Formatting category. 

 Export Settings 

When Export to Native is set to Use Feature Setting, the native geometry database 

(.GPK, .ALG, .FIL) will sync with civil geometry stored within the design file. For 
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example, the user can store an alignment in the design file and that alignment will be 

automatically stored in the native geometry database as well. Delete an alignment 

from the design file, and that alignment will be deleted from the native geometry 

database. The Export to Native functionality is feature based in that the option to 

”Export to native” must be set to ”true” or ”false” for each particular feature. 

 

If Export to Native is set to Manual, the native geometry database will have to be updated 

manually. 

 Coordinate Settings 

Controls the display and precision of their coordinates within any of the civil dialogs. In 

addition, this setting also controls how any inputted coordinates are interpreted. For 

example, if set to “X, Y” then all coordinates are interpreted and displayed as being in 

the “X, Y” format. If set to “Nothing, Easting” then the same applies. 

 Ratio Settings (Distance:Offset) 

Controls the display and precision of ratios within any of the civil dialogs. In addition, 

this setting also controls how any inputted ratios are interpreted. For example, if set to 

“1:D” then all ratios are interpreted and displayed in this format (1:100, 1:50, etcetera). 

If set to “D:1” then the ratios are similarly displayed and interpreted (5:1, 10:1, etcetera). 

 Station Settings 

Controls the format, delimiter and precision of the station values to be used and 

displayed in the civil dialogs.  Equation can be set to: 

By Name - This is the standard InRoads presentation (A100+00, B105+00, etcetera). 

By Index - This is the standard GEOPAK presentation (100+00 R 1, 105+00 R 2, 

etcetera). 

 Radius Settings 

Degrees of Curve Method - Two options are available, Arc and Chord. 

Degree of Curve Length - This sets the standard definition of a 1 degree of curve. 

Radius Toggle Char - This allows the user to specify which character will be used 

within the civil dialogs to ‘toggle’ between a radius definition and a degree of curve 

definition. The letter d is the default setting. 

 Profile Settings - Controls the precision and display or input formats of slopes and 

ratios within a profile context. In addition, sets the default Vertical Curve Parameter 

Format (Radius, K Value or M Value). 



GEOPAK Road 1  Chapter 2 – Civil Geometry    
 
 

5/6/16 Missouri Department of Transportation 2-9 

2.5 Accessing 

When designing with the Open Roads technology in GEOPAK the geometric data can be written 

back to the native .gpk.  Having an active GEOPAK project facilitates this capability. 

To setup Coordinate Geometry project values, choose the GEOPAK > ROAD > Geometry 

>Coordinate Geometry command and the data in the Coordinate Geometry dialog as noted 

below. 

  

 Project Name: defines the name displayed on reports (60 alphanumeric characters max) 

(Optional). 

 Job: identifies the Civil geometry database (3 alphanumeric characters, max) (Required). 

 Operator Code: identifies a unique 2-character operator code.  Allows multiple user 

access to the database. (Required) (User’s initials suggested). 

 Subject: description of work (48 alphanumeric characters, max) (Optional). 

Once these parameters have been defined, the Coordinate Geometry dialog box will appear. 
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2.6 Features and Feature Definitions  

Access the Feature Definitions Toggle Bar from the Horizontal Geometry tasks group.  

 

Having the Definitions Toggle Bar open and available is very useful for expediting the association 

of a feature definition to a new geometry feature. 

 

Feature definitions are used to define options when creating features. These are the items which 

are created in advance, usually used across multiple projects, and define symbology, annotation 

and quantities. The feature definition is assigned (usually) in the plan model, and optionally in 

profile and 3D feature definitions. 

A Feature is anything that can be seen or located and is a physical part of your design representing 

a real world entity. Examples include curb and gutter, pavement, power lines, trees, etc. 

A feature’s definition is one of its properties. At any given time in the design process, the feature 

will have horizontal geometry, vertical geometry, 3D geometry or a combination to define its 

location. Generally, the feature’s definition is assigned at time of creation, but can be assigned 

after-the-fact. 

Most Civil tools have entry fields for Feature Definition in their dialog as illustrated below. 
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The rules applied to Feature Definitions are: 

 If no Feature Definition is selected, the active MicroStation symbology is used and no 

feature is defined, but you can define a Name Prefix. 

 If a Feature Definition is assigned, a Name Prefix is applied, and the symbology, 

attributes, and annotation defined in the feature definition are applied to the element. 

2.7 Design Standards 

Design standards are used to monitor required curvature and other alignment checks on horizontal 

Civil Geometry elements and slopes and K values on vertical geometry elements.  The standards 

are stored in a design library (DGNLIB) which can be read-only and stored in a central location 

for use by all users and referenced by the configuration variable MS_DGNLIBLIST. A DGNLIB 

is an empty file (does not contain any MicroStation elements) similar to a seed file where you can 

set up various MicroStation and Civil resources. An organization can utilize numerous DGNLIBs 

to facilitate management of their standards. For example, horizontal and vertical standards could 

be stored in one DGNLIB while other standards would be defined in other DGNLIBs. If utilizing 

both Metric and English units, you may want a separate DGNLIB for each. 

The standards are set up within the Project Explorer. Note the hierarchy from the Project Explorer 

is mirrored in the Design Standards Tool Bar pick lists. The hierarchy is customizable to conform 

to your organization’s standards.  As most organizations utilize AASHTO standards, the default 

libraries included in the installation package are based on the 2001 and 2004 versions of  ”A 

Policy on Geometric Design of Highways and Streets.” 

The Project Explorer is accessed by selecting File > Project Explorer from the main menu or 

from the Primary Tools menu bar. It is more efficient to complete the vertical standards first, as 

they are referenced when building the horizontal standards. 
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Right-click on the individual entry and select Properties from the pop-up menu to review the 

settings. 

 

Horizontal Design Standards Properties 
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Vertical Design Standards Properties 

2.8 Viewing and Accessing Horizontal and Vertical Standards 

The Design Standards branch lists the design standards that are available within the active design 

model or a DGN library. The Design standards defines Design standards that are used to assist the 

designer in maintaining required curvature and other checks when performing geometric layouts 

and are normally based on accepted standards for a geographic area or authority, these standards 

are stored in DGN libraries. 

  

The properties for each Horizontal standard are: 

 Design Values 
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Speed - this is the design speed for the standard. 

Default Radius - this is the radius used to populate commands when initiated. 

Minimum Radius - this is the minimum radius for the corresponding design speed.  

Utilizing values lower than this radius will cause a warning to be displayed. 

Transition Type - can be by Table or Equation. 

Table - If transition type is table then this is used to populate the table.  

Include Transitions 

Check Tangency 

 Arcs 

Maximum Arc Length 

Minimum Arc Length 

 Tangents 

Maximum Tangent Length 

Minimum Tangent Length 

Maximum Deflection - the maximum angle between the lines where two tangents join 

without a curve. 

The properties for each Vertical standard are: 

 Vertical Design Standards 

Minimum slope 

Maximum slope 

Maximum difference in grade 

Vertical Table Type 

Table  
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2.9 Civil AccuDraw 

Civil AccuDraw performs many of the same functions as MicroStation AccuDraw but has greatly 

expanded capabilities for the civil designer. It allows the user to define a point location at any 

stage of any placement tool (MicroStation or Open Roads) and accept input that results in more 

sophisticated point locations. 

  Accessing Civil AccuDraw 

Civil AccuDraw can be accessed from Tools> Civil AccuDraw > Activate Toolbar or from the 

Civil Tools task menu General Geometry > Activate Civil AccuDraw Toolbar. 

 

It is recommended that the Civil AccuDraw Toolbar be docked to facilitate use. 

 

The shortcuts have key-ins and are also mapped to icons.    Having the Shortcuts Toolbar 

active and docked can also be a time saver. 

 

Benefits 

There are many benefits in using Civil AccuDraw. 

1. It extends the drafting power of MicroStation by providing Civil point location 

methodologies in all the MicroStation and Civil commands. For example, a user will be 

able to place a cell at an offset using the normal place cell but invoking Civil AccuDraw 

to enter the station and offset. 

2. It will eliminate the need to create temporary construction geometries just to perform 

more complex point locations. For example, to place a line at a given distance from 2 

points a user would need to draw 2 circles at each point with the desired offset as the 

radius of each station and then place a line tangent to these circles, and finally delete the 
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unwanted circles. Civil AccuDraw provides a Distance from Point snap where the point 

can be identified, the offset entered, and the data point applied to the construction. 

3. When used in conjunction with the Civil Geometry commands the resultant elements are 

constrained by rules set by the selection of the Civil AccuDraw ordinates. 

4. The Civil Geometry heads up display options are enhanced when Civil AccuDraw is 

active and the options available are determined by the method selected. 

Use Tips with the Geometry commands 

1. Selecting the Tab key while in an entry field will change focus. 

2. Selecting Enter will set the value in the field and lock it 

3. Selecting the End key will unlock the field 

4. Selecting the left or right arrow key will move through the favorite options. 

5. Selecting the down key will bring up the associated command entry dialog in addition to 

the heads up display. 

2.9.2 Civil AccuDraw Overview 

1. Open any Design file (.dgn) file.  

2. To open the Civil AccuDraw Toolbar, select Tools > Civil AccuDraw > Activate 

Toolbar 

 

The Civil AccuDraw toolbox will open. 

 

 Toggle Civil AccuDraw on/off. 
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 Drop down list of various tools including Civil AccuDraw settings and common 

shortcuts.  This drop-down is also available by pressing space bar when any Civil 

AccuDraw field has focus. 

 

These are the ordinate systems delivered in a default installation.   

 Distance – Direction 

 Distance – Direction Unlinked with two origin points 

 Distance – Distance 

 X – Y 

 Dx – Dy 

 Station – Offset 

 DeltaStation-Offset 

In a three dimensional design file there are two additional icons 

 Sets the elevation ordinate 

 ProfileOffset. 

Some differences between the MicroStation AccuDraw tool and the Civil AccuDraw tool:  

a. Civil AccuDraw compass will always point north regardless of view rotation. 

b. Civil AccuDraw uses a heads-up on-screen prompt at the cursor to allow precise key-

in of distance and direction.  A fixed dialog box becomes available when the down 

arrow is selected. 

c. The Civil AccuDraw compass will always be circular.  MicroStation AccuDraw 

changes the compass to rectangular for Cartesian ordinate systems. 

 Civil AccuDraw Settings 

The Operation tab is similar to that of MicroStation 

AccuDraw. 

 Operations of the same name have the same 

function in both AccuDraws. 

 Selection or de-selection in one AccuDraw 

does not affect the selection in the other 

AccuDraw. 

 Selecting the Show AccuDraw Dialog will 

result in the dialog and the heads up display 

both being available to the user during 

element placement. 
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The Display tab contains settings for: 

 Color of compass axis 

 Points configures the number of points in the compass circle 

 Color of the constraint lines 

 Whether you want to see the constraint lines and color of the constraint lines 

 

The shortcut button brings up the same shortcut list as used by MicroStation AccuDraw. 

Both AccuDraws access the same shortcut.txt file. 

The Coordinates tab contains the same round off and 

indexing settings as MicroStation AccuDraw and 

function the same way.   

 Civil AccuDraw has additional settings that are 

provided to allow the round off of station and 

offset values. 

 The numbers must be changed to values other 

than zero to be accepted. 
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The Favorites tab allows for the configuration of the most commonly used ordinate systems.  It is 

one of the primary differentiators between Civil AccuDraw from MicroStation AccuDraw.    The 

favorite selected determines what input fields are available during the placement of an element. 

 

Ordinate 1 and Ordinate 2 are the measurement methods used in determination of the 

coordinates. 

Common Origin has a Yes/No option. 

 Yes indicates that both ordinate measurements come from the same origin location. 

 No indicates each ordinate has a different location.    

To add a new favorite: 

1. Select Add 

2. Key in the Name  

3. Select the Ordinates. 

4. Select whether the ordinates share a common origin. 

2.9.3 Simple Linked Favorite Civil AccuDraw Workflow  

A Linked favorite has two ordinates or measurement methods that share the same Point of 

Beginning (POB) or Origin.  

 



Chapter 2 – Civil Geometry   GEOPAK Road 1 
   

 

2-20 Missouri Department of Transportation 5/6/16 

1. Ensure Civil AccuDraw is active.  If it is active then the first icon in the toolbox will have 

an orange background. 

2. Set the active symbology or active 

feature.  If no feature is assigned, 

the element will use Default. 

3. Start the tool of interest and place 

the first point.  This can be by XY= 

key-in or a data point.  If the Civil 

AccuDraw XY favorite is active 

the X and Y fields will be available 

in the heads up display. 

4.  Select the Dist-Dir favorite. 

Entries in the distance and 

direction fields present a dynamic 

circle and line feedback for the 

constraints. 

5. Key in a distance and then press the Enter key to lock the distance. 

6. As the cursor moves over one of the compass points (north, south, east or west) there is a 

color change feedback indicating a compass direction locks. 

7. To unlock a value use the End key. 

8. Data Point to accept the value. 

2.9.4 Simple Un-Linked Favorite Civil AccuDraw Workflow 

An Un-Linked favorite has two ordinates or measurement methods each with a unique Point of 

Beginning (POB) or Origin. 

 

1. Ensure Civil AccuDraw is active.  If it is active then the first icon in the toolbox will have 

an orange background. 

2. Select an element placement command. 

3. Set the active symbology or active feature. 

4. Start the tool of interest for example Distance-Direction.  

5. Place the first point.  This can be by XY= key-in or a data point.  If the Civil AccuDraw 

XY favorite is active the X and Y fields will be available on the Heads Up Display. 

6. With the focus in the distance field press the letter (O) on keyboard. Then left click on 

the position to set the origin for measuring distance.  This could be a graphical element, a 

terrain Model element, a Civil Geometry Element or a data point. 
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7. The origin shortcut (O) in Civil AccuDraw waits for a data point before setting the origin.  

This is to provide capability for the (O) shortcut to also choose the baseline for station 

offset ordinates. 

8. Select the Tab key to move focus to the direction field, press (O) again, identify the 

location for the second ordinate point of beginning, and click a second data point to set 

the direction origin.  This results in two independent compasses to measure the distance 

and direction.  Both distance and direction can be locked as needed. 
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2.9.5 Station-Offset Linked Favorite  

The Station and Offset linked favorite pulls the station and offset from the element identified 

after the origin shortcut (O) is entered.  Selecting Tab will lock the value. 
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2.10 Civil Horizontal Geometry Commands 

Civil Horizontal Geometry commands can be accessed by selecting the Horizontal Geometry 

task group from the Civil Tools tasks menu. 

 

or by selecting Tools > Civil Geometry > Horizontal Tools > Open as Tool Box from the 

MicroStation menu. 
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2.10.1 Placing Point Geometry 

There are two point options; Place Point and Equal Space Points.  

 Place Point constructs a civil point element. The point may place a cell based on feature 

definition or a MicroStation point (zero length line) if no feature definition is used. 

1. Open the Civil Tools task pane to the Horizontal Geometry section then click the Point 

icon. Selecting the Point icon will open the Point dialog.  A 3D point can be created if 

given an elevation.  Check the Want 3D Point box and enter an Elevation in the field 

provided if you wish your point to have a vertical value. 

 

2. When you move the cursor into the View, it is equipped with a command prompt that 

says, Enter Data Point, so move the cursor to the location then place the data point to 

accept, or enter the XY value of the location in the MicroStation key-in field. 

 

 Equal Space Points inserts a specified number of 

points, points at a defined interval, or a combination of 

both into the View.  These can be along an element or 

between two points. 
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General Workflow 

1. First select the Placement Method (Between Points or Along Element). 

2. When using the Placement Method Between Points, select the location of the start point 

and key in the number of points.  Select the location of the end point. 

3. When using the Placement Method Along Element, select the element and select the 

Spacing type (Number Of Points option, Interval, Even, or Max Interval),  key in the 

Interval or Number Of Points, and finally key in the Offset from the element 

2.10.2 Placing Line Geometry 

There are five linear element placement options 

 

   Line Between Points – Places a line by Distance and Direction.    

The points can be defined in several ways: 

 Arbitrary Data Points on the screen 

 Using Civil AccuDraw 

 Snapped relative to other elements 

 Previously created geometry point element 

 Any of the values may be locked in the dialog when the tool starts or at any time while 

the tool is active. All of the values on the dialog are dynamically updated as the cursor 

moves 

Without Civil AccuDraw active, the start point is identified and the distance and Direction entered 

to place the second point. 

With Civil AccuDraw active and the XY favorite selected, a heads up prompt will provide XY 

key-in fields. 

 

Changing the AccuDraw favorite will also change the heads up display presenting fields to define 

the location of the end point.  If Linked Distance-Direction is selected in Civil AccuDraw then 

heads up display will have those fields. 
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 Line To Element – This is a series of Line To Element commands indicated by the arrow in 

the right hand corner of the icon.  These pre-customized versions provide a simplified prompt 

sequence for many common construction tools. Right-click on the Line to Element icon then 

choose Show/Hide Arc from Element Tools to access the following options. 

 Simple Line To Element - Creates a line without any transition to another element at 

zero degrees skew angle; applicable only when the To element is a curve, Offset locked at 

zero. 

 Spiral Line To Element - Creates a line with a spiral transition to another element at 

zero degrees skew angle; applicable only when the To element is a curve, Offset locked at 

zero. 

 Curve Line to Element - Creates a line with an arc transition to another element at zero 

degrees skew angle; applicable only when the To element is a curve, Offset locked at zero. 

 By Angle Line to Element - Creates a line without any transition at user defined skew 

angle, Offset locked at zero. 

 Line to Element - Creates a line at a skew to a reference element. 

 Line From Element – This is a series of Line From Element commands indicated by the 

arrow in the right hand corner of the icon.  These pre-customized versions provide a simplified 

prompt sequence for many common construction tools. Right-click on the Line From Element 

icon then choose Show/Hide Arc from Element Tools to access the following options. 

 Simple Line From Element - Creates a line without any transition from another element 

at zero degrees skew angle, Applicable only when the From Element is a curve, Offset locked 

at zero 

 Spiral-Line From Element - Creates a line with a spiral transition from another element 

at zero degrees skew angle, applicable only when the From element is a curve, Offset locked 

at zero 

 Curve-Line From Element - Creates a line with an arc transition from another element 

at zero degrees skew angle, applicable only when the From element is a curve, Offset locked 

at zero 

 By Angle Line From Element - Creates a line without any transition from another 

element at a skew angle you define, Offset locked at zero 
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 Line From Element - Creates a line at a skew from a base element. 

 Line Between Arcs - Constructs a line between two previously placed arcs. This tool has 

the ability to optionally apply a back and/or forward transition between the arc(s) and constructed 

line. 

 Chamfer Between Elements - Planes a corner (i.e., it alters an existing intersection by 

inserting a line between the elements). 

2.10.3 Placing Arc Geometry 

 Circle - Creates a circular element based on the center point of the circle and a through point 

defining the radius. 

 Arc Between Points - Creates an arc between points. The most common usage is Arc 

between 3 points, but other variations are available. Points can be defined in several ways: 

 Arbitrary Data Points on the screen 

 Defined using Civil AccuDraw 

 Snapped relative to other elements 

 An existing geometry point element 

 Simple Arc To Element – This is a series of Simple Arc To Element commands indicated 

by the arrow in the right hand corner of the icon.  These pre-customized versions provide a 

simplified prompt sequence for many common construction tools. Right-click on the Simple Arc 

To Element icon then choose Show/Hide Arc to Element Tools to access the following options.  

 Simple Arc To Element - Constructs an arc to element with a given radius 

 2 Center Arc To Element - Constructs an arc to element with a given radius and a back 

transition 

 Spiral Arc To Element - Constructs a spiral to element 

 Reverse Spiral Arc To Element - Constructs a Double Spiral to an element 

 Arc To Element - Constructs an arc to element with a given radius with the addition of 

offset and end tangent direction 
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 Simple Arc From Element – This is a series of Simple Arc From Element commands 

indicated by the arrow in the right hand corner of the icon.  These pre-customized versions 

provide a simplified prompt sequence for many common construction tools. Right-click on the 

Simple Arc From Element icon and then choose Show/Hide Arc From Element Tools to access 

the following options: 

 Simple Arc From Element - Constructs an arc from an element with a given radius. 

 2 Center Arc From Element - Constructs an arc from an element with a given radius 

and a back transition. 

 Spiral Arc From Element - Constructs a spiral from an element.  

 Reverse Spiral Arc From Element - Constructs a Double Spiral from an element. 

 Arc From Element - Constructs an arc from an element with a given radius with the 

addition of offset and end tangent direction. 

  Simple Arc – This is a series of Simple Arc commands indicated by the arrow in the right 

hand corner of the icon.  These pre-customized versions provide a simplified prompt sequence for 

many common construction tools. Right-click on the Simple Arc icon then choose Show/Hide 

Arc Tools to access the following options.  

 Simple Arc - Creates a radius arc without spirals or tapers at both ends, Offsets locked 

at zero 

 Spiral-Arc-Spiral - Creates a radius arc with spiral transitions but no tapers at both 

ends, Offsets locked at zero 

 Taper Arc Taper - Creates a radius arc with tapers but no transitions at both ends, 

Offsets locked at zero 

 3 Center Arc - Creates a radius arc with radius transitions at both ends, result is a three 

centered curve, Offsets locked at zero 

 2 Center Arc - Creates a radius arc with radius transitions at one end, result is a two 

centered curve, Offsets locked at zero 
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 Arc Between Elements - Constructs an arc between two previously placed elements. 

This tool has the ability to optionally apply a back and/or forward transition and/or taper 

between the elements and the constructed arc. 

 Arc Between Arcs - Constructs an arc between two previously placed arcs. This tool has the 

ability to optionally apply both a back and/or forward transition between the base arcs and the 

constructed arc. 

 Complex Transition between any Element and Arc - Constructs an arc between two 

previously placed elements. This tool has the ability to optionally apply a Back Spiral and/or 

Ahead Transition between the elements and the constructed arc. 

2.10.4 Placing Spiral Geometry 

 Spiral From Element - Constructs a spiral from a previously placed element, using this 

base element to determine tangency at one end. This tool provides chorded spirals only. Other 

spiral-like transitions are not supported. 

 

Spiral Between Elements - Constructs a spiral (or spirals) between two base elements 

that determine tangency. Dependent on the configuration of the base elements, there may be: 

 Single spiral that connects: A line and an arc 

 Two arcs where one arc is contained entirely within the circle of the other arc 

 A compound spiral between two arcs 

 A reverse spiral between two arcs 

This tool provides chorded spirals only. Other spiral-like transitions are not supported. 

2.10.5 Creating Complex Geometry 

  Complex By Elements - Constructs a complex element of previously placed elements by 

joining them in sequence. 

Workflow 

1 .  Click Complex By Elements. The Complex Element dialog displays.  

There are two methods of operation:  Manual and Automatic. 
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2. Using the Automatic method, hover over the beginning element until the directional 

arrow points to the desired direction. Left mouse-click to accept the chosen element. 

 

3. At this point, the complex path will be highlighted. Left-click again to accept the 

complex creation or right-click to cancel. 

 

4. Alternatively, using the Manual method, select each element individually using the left-

click. 

 Complex By PI - Creates a linear element with curves based on user input of PI (point of 

intersection) locations.  The curves can include transitions or set the transitions to none.  

The transitions on the curves can be arc transitions or chorded spirals using the following 

methods: 

 Spiral - Length 

 Spiral - A-Value 

 Spiral - Deflection 

 Spiral - Delta R 

 Spiral - RL 

 Curve - Length 

 Curve - Deflection 

 Curve - Delta R 

 Curve - Ratio 

To access these methods customize the dialog and add the 

method(s) of interest resulting in a customized tool.  

Workflow 

1. Click Complex By PI. The Complex Element By PI 

dialog displays. 

2. Select the Civil AccuDraw favorite to be used in 

placement of the PIs and key-in the placement values in 

the heads up display or Data point to set the beginning 

of the element. 

3. Place the second PI. 
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4. Place the third PI.  Radius always applies to the PI prior to the one where the data point 

is currently being set. You can edit the radius by keying in a new value in the prompt. If 

the back and ahead transitions are set then this is a triple toggle input. Toggle with left-

right arrow keys to set back and ahead transition parameters. 

5. Continue to data point to add more PI points. Click the Reset button to stop adding PI 

points. 

 Start Station - Assigns stationing to an element. You assign a station value and a position 

along the element for that station value. This command can be used on a civil element or a plain 

MicroStation graphic. If this command is never run, then the beginning stationing is assumed to 

be zero. 

 Add Station Equation - Defines a station equation at a designated location on an element. 

If stationing has not been previously defined, then a zero starting station is also assigned. This 

command can be used on a civil element or a plain MicroStation graphic. 

Preferences 

Preferences that affect Start Station and Add Station Equation are stored as DGN settings 

(Settings > Design File Settings > Civil Formatting). 

2.11 Editing Horizontal Geometry  

Once a Civil Geometry Element is placed, selection of that element will display the appropriate 

manipulators, defining the element.   

 

 

 

 

 

 

 



Chapter 2 – Civil Geometry   GEOPAK Road 1 
   

 

2-32 Missouri Department of Transportation 5/6/16 

Manipulators 

Manipulators are available for: 

 Distance and direction on each line segment 

 Radius and transition parameter on each curve 

 Drag handles at PI points 

 

Normal Line Manipulators 

When the line is placed without any snaps and without 

any Civil AccuDraw constraints, you will see the 

onscreen manipulators as shown right. These 

manipulators can be used to edit the line as follows: 

 The distance and direction text manipulators 

can be clicked to allow editing of the value 

 The arrows parallel to the line can be used to 

extend or trim the line (i.e., change the distance) 

 The end point arrows perpendicular to the line can be used to rotate the line (i.e., hold 

the distance and change the direction) 

 The perpendicular arrow at midpoint can be used to move the line parallel 

 The dot at the end points can be used to move the point without constraining the distance 

or direction 

 The dot at the midpoint can be used to move the line in its entirety 

Snap Manipulator 

When a line end point has been snapped, the normal 

manipulators are replaced by a snap manipulator. The end on 

the left was snapped by key point, so you see a single dot 

and an icon indicating the snap type.  
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You can move the snapped end in space by clicking the dot and dragging. This breaks the snap 

and creates a new endpoint location that might be a data point, a different snap or a Civil 

AccuDraw input. 

If you hover over the snapped end point dot, the normal manipulators will appear to allow 

extend/trim or rotate of the line. This also breaks the snap. Similarly, when a line endpoint is 

created by Civil AccuDraw, the normal manipulators are replaced by a single dot and the 

AccuDraw manipulators. The AccuDraw Manipulators are text labels that can be clicked and 

edited. 

Hover over the dot to show the normal manipulators for rotate and trim/extend functions. This 

replaces the AccuDraw input with the new input values. 
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2.12 Horizontal Geometry Properties 

The rule data is also accessible in the properties of the line. Select the line and click Properties 

from the heads up menu. Most data in the property pane can be edited to change the line 

definition.   You can also select the geometry using the Element Selection tool and use the 

Element Information dialog to make changes 

 

Note: When you review geometry the Element Information dialog displays the terrain models 

that the geometry belongs to, if any. 
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2.13 Individual Exercise 1: Route 24 

1. Create a new MicroStation file named Route24.dgn using the  

pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn  
seed file from the MoDOT workspace. 

 

 

2. Go to GEOPAK > ROAD > User Preferences, select COGO Preferences… and verify 

the Job (GPK) Directory: is set to pw:\District 

CADD\Design\Randolph\J2P0200\data_02\. 
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3. Click OK to close the COGO Preferences dialog. 

4. Click OK again to close the User Preferences dialog. 

5. Open the Coordinate Geometry dialog from the GEOPAK > ROAD > Geometry 

menu and enter the following values: 

Job: 011 

Operator Code: your initials. 

 

6. Click OK to dismiss the Coordinate Geometry dialog. 

7. Since this Coordinate geometry database does not exist, you will get the following 

message.  Select Yes in the Alert dialog to continue.  The job will hold geometry in 

native format as the civil geometry is created.  
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Create the alignment as shown per the step outlined on the following pages. 
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Creating the Tangent Elements 

1. Expand the Horizontal Geometry Toolbox in the Tasks menu. 

2.  Select Feature Definition Toggle Bar to open the toggle bar window. 

Hint: the Feature Definition Toggle Bar can be docked at the top or bottom of the screen 

so it is easily accessible. 

3. Set the active feature to Design > Design Standards > Geometry> Geometry Scratch. 

 

4.  Enable the Use Active Feature Definition tool on the Feature Definition Toggle 

bar. 

Setting an active feature definition will cause any geometry elements created to have the 

active feature assigned as its Feature Definition (property). 

5. Verify Civil AccuDraw is active. 

6.  Select the Line Between Points task from the Horizontal Geometry task group 

7. Select the XY favorite from the Civil AccuDraw toolbar. 

.  

8. Using the heads up display, key in the coordinates of the first PI (501), X = 4000            

Y = 2500. 

 

Hint: After locking in a value move the mouse to ensure the value is set. 

9. Data point to accept the point.  

10. When prompted to Enter End Point, make the Distance - Direction favorite active in 

Civil AccuDraw.  This will change the heads display.  
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11. Locate the second point (502)  with a Distance = 450 and the Direction = N59°24'00.0"E  

Hint: Directions or angles can be entered in these formats DD:MM:SS or DD^MM’SS”.  

If Bearing is the MicroStation Definition then the Alpha indicators (N S E and W) should 

be entered with no spaces before the DD and after the SS. 

 

12. Data point to accept. 

13. Place another line with a Start point (505) at X = 5192.19 and Y = 2519.20. 

14. Define the End point (504) as Distance = 360 and the Direction = N 62°28'00.0"W. 

15.  In Civil AccuDraw, make the Direction - Direction favorite active. This will find 

the intersection point based on two directions. 

16.  Select Line Between Points. 

17. Select the end of the first line (point 502) drawn above to make the compass active on the 

end point. 

Hint: To identify a civil Geometry object hover over it and let Civil AccuSnap select 

it for you  

18. Enter the first direction as S54:36:00E and tab to the next Direction field. 

19. Set the origin of the second point by typing the letter O and selecting the ending point of 

the second line (point 504). 

Note:  If presented with angle instead of direction, the Civil AccuDraw compass has 

rotated.  Key in “T” to rotate the compass to the top or “V” to rotate the compass to the 

View. 
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20. Enter the second direction as S45:32:00W and press Tab to view the solution. 

 

21. Data point in the view to accept the solution and place the line. 

22.  Select Line Between Points. 

23. AccuSnap to the end points of the first line placed (at 502) and second line placed (at 

point 504). 

 

This completes the placement of the tangent sections. The curves for Route24 will be placed 

using the Simple Arc command. 

Placing the Curves 

24. Turn off Civil AccuDraw 

25.  Select Simple Arc. 

26. Set the Trim/Extend option to Both and left-click twice to accept the solution. 

27. Enter the 243.2987 as the Radius for the first curve.  
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28. When prompted to Locate First Element, select the first tangent as noted in the graphic 

above then select the second tangent. 
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29. Data Point to accept the arc location. Data Point again to accept the Truncate Option. 

30. Repeat steps 2-6 for the second curve with a Degree of Curve using Second and Third 

Tangents shown above. Second Curve Radius is 142.2416. 

31. Repeat steps 2-6 for the third curve using Third and Fourth Tangents shown above.  Third 

Curve Radius is 147.0171. 

Complex the Elements into one Chain 

32.  Select the Complex by Elements task. 

33. Set the active feature to Design > Drafting Standards > Plan > Alignments > 

MoDOT_Baseline_Proposed. 

34. Set the Method to Automatic. 

35. Key in Route24 in the Name field. 

36. When prompted to Locate First Element, identify the beginning of the first linear element 

placed.   Note: The Arrow indicates the direction the chain will be processed. 

37. If presented with the Job Number dialog, select job011.gpk and select OK. 

 

 

 

 

 

 

Set the beginning stationing 

38.   Select the Start Station. 

39. When prompted to Locate Element, select the Route24 alignment. 

40. Set the Start Distance to 0. Data Point to accept. 

41. Enter 10+12.6 as the Start Station.  The station can be modified in the Element 

Information dialog. 

42. Verify the label for the start station has been changed to POT STA 10+12.60. 

43. Select File > Update Server Copy. 
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2.14 Group Exercise 2: Road 1 Alignment 
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Create a new MicroStation file: Civil_Geometry_ J2P0200.dgn. 

1. Click Seed and select pw:\CADD_Standards\Seed Files\Design - 

English\i_project_2d_PowerGEOPAK.dgn as the seed file 

2. Save the new file to the following location: 

Randolph\data_02\Civil_Geometry_ J2P0200.dgn. 

Note:  You may need to Check In Route24.dgn when creating the new file 

3. Reference the existing Terrain model by selecting Reference File > Tools > Attach.  

Select Terrain_J2P0200_Existing.dgn and set the attachment method as Coincident 

World. 

4. Click OK. Dismiss the Reference file dialog. 

5. Select Fit View. 

6. Create a new GPK using job number 200 and save it to ProjectWise as job200.gpk.  

Use the Civil Geometry tools and follow the steps below to create the alignments as shown on the 

previous page. 

 

Road1 

Beginning Point: X = 1,676,792.0050 Y = 1,260,393.1372 

Ending Point:  X = 1,679,002.6087 Y = 1,257,759.8897 

Beginning station of Road1 is 0+00.00. 

 

Curve Data 
 

 Direction Back  = S 24° 20’ 00.0” E 

 Degree of Curve  = 1° 45’ 00” 

 Direction Ahead  = S 52° 30’ 00.0” E 

7. Set the active feature to: 

Design > Design Standards > Geometry > Geometry Scratch. 

8. Toggle On Use Active Feature Definition. 

9. Toggle Civil AccuDraw to active. 

10. Pin the Task Menu and expand the Horizontal Geometry Toolbox. 

11. Use the “Line Between Points” tool along with Civil AccuDraw to place two lines that 

represent the two tangent sections of the Road1 alignment.  Make sure these two lines are 

long enough so that they overlap each other.  What we are attempting to do is locate the 
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overall PI location of the Spiral-Curve-Spiral using the intersection of the two Civil 

Geometry Lines. 

a. Select the “Line Between Points” tool, and using Civil AccuDraw and it’s XY 

function, key in the coordinates X = 1,676,792.0050, Y = 1,260,393.1372 

b. Once the start of the alignment has been defined, continue to place the line using 

Civil AccuDraw and its Distance-Direction option at a bearing of S 24° 20’ 00.0” E 

at a length that would extend past the PI location of the Curve (a length of at least 

1,750 feet will work).  When typing in a bearing use a colon “:” in-between the 

Degrees:Minutes and Minutes:Seconds.  For this step you would type S24:20E 

Note:  If “Angle” is display instead of “Bearing” in the Civil AccuDraw heads-up 

display select the keyboard keys “R” and then “T”.  This is a Civil AccuDraw 

shortcut to Rotate the compass to the Top view. 

c. Select the “Line Between Points” tool, and using Civil AccuDraw and it’s XY 

function, key in the coordinates X = 1,679,002.6087, Y = 1,257,759.8897 

d. Once the end of the alignment has been defined, continue to place the line using Civil 

AccuDraw and its Distance-Direction option at a bearing of N 52° 30’ 00.0” W at a 

length that would extend past the PI location of the Curve (a length of at least 2,500 

feet will work).  When typing in a bearing use a colon “:” in-between the 

Degrees:Minutes and Minutes:Seconds.  For this step you would type N52:30W. 

Note:  If “Angle” is display instead of “Bearing” in the Civil AccuDraw heads-up 

display select the keyboard keys “R” and then “T”.  This is a Civil AccuDraw 

shortcut to Rotate the compass to the Top view. 

12. Deactivate Civil AccuDraw. 

13. Next store the Curve by selecting the Simple-Arc tool, and defining the tool with the 

following parameters: 

Degree of Curve  = 1° 45’ 00” 

Notes:  

o To switch from Radius to Degree of Curve or vise-versa type in a “d” in the 

Radius field and then add the degree of curve value.   

o When typing in a Degree of Curve use a colon “:” and place in-between the 

Degrees:Minutes and Minutes:Seconds.  For this example you would type          

d 1:45:00 or d 1:45 for short. 

Once the tool is defined with the correct parameters select each tangent and place the 

Spiral-Curve-Spiral trimming both tangents back. 

14. Select Create Complex Element and to turn the individual element into one complex 

element.  Name the complex element “Road1” with no spaces.  Make sure the stationing 

will be flowing (getting larger) in a southerly direction. 

15. Using the “Start Station” tool set the Beginning Station to 0+00.00. 

16. Make sure the MicroStation Drawing Scale is set to 1”=50’. 
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17. Set the active feature to Design > Drafting Standards > Plan > Alignments > MoDOT 

Baseline Proposed. 

a. IF prompted select the 200 gpk. 

18. Generate a Horizontal Geometry Report by “left clicking” on the alignment and 

selecting from the heads up menu the Horizontal Geometry Report Tool. 

a. Verify in the Report that the geometry is correct. 

19. Select File > Update Server Copy.  
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2.15 Individual Exercise 3: Route63 Alignment 

Route 63  
 

Beginning Point: X = 1,676,434.4103 Y = 1,262,365.4715 

Ending Point:  X = 1,678,994.1614 Y = 1,257,205.0288 

 

Beginning station of RTE63 is 9+50.00. 

Spiral-Arc-Spiral Information 

Direction Back   = S 0° 20’ 19.8” E 

Length of the back spiral  = 200’ 

Degree of Curve   = 2° 30’ 00” 

Length of the ahead spiral  = 200’ 

Direction Ahead   = S 45° 39’ 27.2” E 

1. Set the active feature to: 

Design > Drafting Standards > Geometry > Geometry Scratch. 

2. Toggle On Use Active Feature Definition. 

3. Toggle Civil AccuDraw to active. 

4. Pin the Task Menu and expand the Horizontal Geometry Toolbox. 

5. Use the “Line Between Points” tool along with Civil AccuDraw to place two lines that 

represent the two tangent sections of the Route 63 alignment.  Make sure these two lines 

are long enough so that they overlap each other.  What we are attempting to do is locate 

the overall PI location of the Spiral-Curve-Spiral using the intersection of the two Civil 

Geometry Lines. 

a. Select the “Line Between Points” tool, and using Civil AccuDraw and it’s XY 

function, key in the coordinates X = 1,676,434.4103, Y = 1,262,365.4715 

b. Once the start of the alignment has been defined, continue to place the line using 

Civil AccuDraw and its Distance-Direction option at a bearing of S 0° 20’ 19.8” E 

at a length that would extend past the Overall PI location of the Spiral-Curve-Spiral (a 

length of at least 4,000 feet will work).  When typing in a bearing use a colon “:” in-

between the Degrees:Minutes and Minutes:Seconds.  For this step you would type 

S0:20:19.8E 

Note:  If “Angle” is display instead of “Bearing” in the Civil AccuDraw heads-up 

display select the keyboard keys “R” and then “T”.  This is a Civil AccuDraw 

shortcut to Rotate the compass to the Top view. 
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c. Select the “Line Between Points” tool, and using Civil AccuDraw and it’s XY 

function, key in the coordinates 1,678,994.1614 Y = 1,257,205.0288 

d. Once the end of the alignment has been defined, continue to place the line using Civil 

AccuDraw and its Distance-Direction option at a bearing of N 45° 39’ 27.2” W at a 

length that would extend past the Overall PI location of the Spiral-Curve-Spiral (a 

length of at least 4,000 feet will work).  When typing in a bearing use a colon “:” in-

between the Degrees:Minutes and Minutes:Seconds.  For this step you would type 

N45:39:27.2W 

Note:  If “Angle” is display instead of “Bearing” in the Civil AccuDraw heads-up 

display select the keyboard keys “R” and then “T”.  This is a Civil AccuDraw 

shortcut to Rotate the compass to the Top view. 

6. Deactivate Civil AccuDraw. 

7. Next store the Spiral-Arc-Spiral by selecting the Spiral-Arc-Spiral tool, and defining 

the tool with the following parameters: 

Length of the back spiral   = 200’ 

Degree of Curve    = 2° 30’ 00” 

Length of the ahead spiral  = 200’ 

 

Notes:  

 To switch from Radius to Degree of Curve or vise-versa type in a “d” in the Radius 

field and then the degree of curve value.   

 When typing in a Degree of Curve use a colon “:” and place in-between the 

Degrees:Minutes and Minutes:Seconds.  For this example you would type d 2:30:00 or 

d 2:30 for short. 

 

Once the tool is defined with the correct parameters select each tangent and place the 

Spiral-Curve-Spiral trimming both tangents back. 

8. Select Create Complex Element and to turn the individual element into one complex 

element.  Name the complex element “Route63” with no spaces.  Make sure the 

stationing will be flowing (getting larger) in a southerly direction. 

a. IF prompted select the 200 gpk. 

9. Using the “Start Station” tool set the Beginning Station to 9+50.00. 

10. Make sure the MicroStation Drawing Scale is set to 1”=50’. 

11. Set the active feature to Design > Drafting Standards > Plan > Alignments > MoDOT 

Baseline Proposed. 

a. IF prompted select the 200 gpk. 
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12. Generate a Horizontal Geometry Report by “left clicking” on the alignment and 

selecting from the heads up menu the Horizontal Geometry Report Tool. 

a. Using the report verify the Beginning and Ending coordinates are correct to 4 decimal 

places. 

13. Select File > Update Server Copy.  
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2.16  Individual Exercise 3 (Optional): B1 

1. Create a new MicroStation file named B1.dgn 

2. Use the Civil Geometry tools to create chain B1 as shown below.  Verify the area of the 

chain. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hints: 

 Angles at 604 and 605 are not 90 

 

 The tanget lengths of 1,500 and 900 are distances from the point of Curvature. 

 

Store as a Complex Linear Element and verify the area by “left clicking” on the new 

alignment and selecting from the heads up menu the Horizontal Geometry Report tool.  

Use a report called Horizontal Alignment Area to get the area of the alignment. 
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3.1 Objectives 

 Create and store vertical alignments using Vertical Geometry 

3.2 Definitions 

The Vertical Geometry task group is a collection of Open Roads tools that are used to 

graphically create and modify proposed design profiles or modify an existing ground profile.  

These operations may be accomplished through a dialog box and/or by dynamic manipulation of 

graphic elements. 

A profile may also be created with Coordinate Geometry (COGO) input in Native GEOPAK and 

imported into Open Roads Civil Geometry.   

3.3 Vertical Geometry 

  Open Profile Model 

Use the Open Profile Model command to generate a profile view for the chosen feature and gain 

access to the Vertical Geometry tools. 

1. Open the Civil Tools task pane, expand the Vertical Geometry task group, and then click 

the Open Profile Model icon. 

2. Move the cursor into a view and note the command prompt to Locate Plan Element. 

3. Select the plan element with which you wish to work in profile. 

4. The cursor is now equipped with the prompt Select or Open View. 

a. If another View is already open, data point in it to present the selected element in 

profile. 

b. If another view is not open, select a view from the View Groups toolbar that is not 

being used for other models, then data point in the new View.  

5. Use the Vertical Geometry tools to edit your vertical alignment. 

  Set Active Profile 

Use the Set Active Profile command to designate which of profile elements will drive the 3D 

model. The result is the creation of a 3D spline in the 3D model representing the combination of 

the Horizontal alignment plus the Design profile. 
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  Profile from Surface 

Use the Profiles from Surface command to generate a profile whose elevations are determined by 

draping onto a surface. The surface may be a terrain model, a mesh, or mesh solid. 

 Quick Profile from Surface 

Quick Profile from Surface is a companion command that provides the same result but simplifies 

the input by assuming that the entire element is draped and that the offsets are zero. 

  Profile Line between Points 

Use the Profile Line between Points command to construct a profile line between two designated 

points. 

1. Open the Civil Tools task pane to the Vertical Geometry task group then click the 

Profile Line Between Points tool. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model 

 The Profile Line Between Points dialog opens. 

 

 Checking the box next to any field locks the associated value. 

2. When you move the cursor into the Profile View, it is equipped with a prompt. Enter the 

Start Point in the View by data pointing (i.e., left-clicking) at the desired location. 

 

3. When prompted to Enter End Point, data point the location for the end of the profile line. 

Or you can use one of the following methods to establish the Slope or Length (choose 

between the two by striking the left or aright arrow keys to toggle between them): 

 Move the cursor slightly, key in the value, then data point. 

 As you move the cursor, a value is displayed on the prompt.  Data point.  
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 Note: If the data entry field is locked on the Place Plan Profile between Points 

dialog, you cannot set a new value.  

 Profile Line to Element 

 

Use the Profile Line To Element command to construct a profile line, at a delta slope, from a 

designated location to a reference element. 

1. Open the Civil Tools task pane to the Vertical Geometry task group then click the 

Profile Line to Element icon. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

 The Profile Line to Element dialog opens. 

 

 Checking the box next to any field locks the associated value. 

2. When you move the cursor into the Profile View, it is equipped with a prompt. When 

prompted to Locate Reference Profile, move the cursor to the element to which you wish 

to draw a line then data point on the target element. 
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3. Establish the End Point in the View by data pointing (i.e., left-clicking) at the desired 

location.   

 

 

4. Establish the Vertical Offset with one of the following methods: 

 Key in the desired distance and press the Enter key to lock then data point to accept. 

 Move the cursor to a station displayed on the prompt. Data point at the desired 

station. 

 

5. Use one of the following methods to establish the Delta Slope or Length; choose 

between the two by using the left or right arrow keys to toggle between them. 

 Key in the desired distance and strike the Enter key to lock then data point to accept. 

 As you move the cursor, a value is displayed on the prompt.  Data point at the desired 

distance. 

 Profile Line from Element 

 

Use the Profile Line From Element command to construct a profile line, at a delta slope, from a 

reference element to a designated location. 

1. Open the Civil Tools task pane to 

the Vertical Geometry task group 

then click the Profile Line From 

Element tool. 

Note:  If your View isn't in Profile 

mode, an error message will 
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indicate that you need to open a Profile Model. 

 The Profile Line from Element dialog opens.  

 

 Checking the box next to any fields locks the associated value. 

2. When you move the cursor into the Profile View, it is equipped with a command prompt 

requesting that you Locate Reference Profile, so move the cursor to the element from 

which you wish to draw a line then data point (i.e., left-click) on it. 

 

3. Establish the Vertical Offset with one of the following methods: 

 Key in the distance and strike the Enter key to lock then data point to accept. 

 As you move the cursor, a distance is displayed on the prompt. Data point at the 

desired distance. 

 

 

4. Identify the Start Point along the offset line at the location where the profile line should 

cross.  Data point at the location. 

 

5. To establish the Delta Slope or Length, select the left or right arrow keys to toggle 

between them then perform one of the following: 
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 Key in the value then data point. 

 The value is displayed on the prompt and updated as it moves. Data point at the 

value. 

 

6. To trim the element at the intersection with the Profile line or to extend the element to 

intersect with the Profile line, strike the up or down arrow keys to choose a 

Trim/Extend option. 

 

 

Dialog Customization 

Right-click on the Profile Line From Element dialog to customize it for specific tasks or to 

personal preference. 
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Manipulators 

 

Manipulators are available for: 

 Offset from base element (not shown here) 

 Delta Slope 

 Length 

 Drag a grip to dynamically adjust start and end distance 

 

Properties 

To View the new element's properties, equip the Element Selection tool. 

Select the element in the View then let the cursor hover over the selected element. Click the 

Properties icon to access rule data for the chosen element. 

  

Custom Tool 

These pre-customized versions provide a simplified prompt sequence for many common 

construction tools. Right-click on the Profile Line from Element icon then choose Show/Hide 

Profile Line from Element Tools to access the following option: 

Tangent Profile Line from Element - Creates a profile line from another element at 

zero deflection, applicable only when the From element is a profile curve, Offset locked 

at zero 

 Profile Complex by VPI 

Use the Profile Complex by VPI command to construct a profile complex defined by vertical 

points of intersection (VPI). 
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1. Open the Civil Tools task pane to the Vertical Geometry section then click the Profile 

Complex by VPI icon. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

 The Complex Element by VPI dialog opens.  

 

 Checking the box next to any of the fields locks-in the associated value. 

2. When the cursor moves into the Profile View, it is equipped with a command prompt 

requesting that you Enter First PI. Place the cursor over the initial point of intersection 

by data pointing at the location. 

3. When prompted to Enter Next VPI, use one of the following methods to designate a 

point through which the curve must pass (navigate the options by striking the left or 

right arrow keys on the keyboard): 

 

 As the cursor moves, the value is updated in the prompt. Data point at the required 

value. 

 Enter a value for the Curve Length then strike the Enter key to lock in the value.  

Data point to accept. 

 Enter a value for the Vertical Curve Parameter then strike the Enter key to lock in 

the value.  Data point to accept. 
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 Enter a value for the Slope then strike the Enter key to lock in the value. The slope 

can always be locked independently of the length or curve parameter.  Data point to 

accept. 

Note:  The VPI can be positioned dynamically or with the aid of Civil AccuDraw. The 

heads up prompt can also be used to lock desired slope value from the previous VPI to 

the current VPI. 

4. On the 3rd and subsequent VPIs, the Length and/or Curve Parameter can be used to 

control the curve placed at the previous VPI. For example, the length entered at the 3rd 

VPI prompt is used to define the curve at VPI 2 and 1. 

Vertical Curve Type 

The option for curve type can be changed in the dialog or by pressing Shift key on keyboard. 

Supported curve types are: 

 Parabola - Symmetric Parabolic Curve 

 Asymmetric - Asymmetric Parabolic Curve 

 Circular - A simple curve defined by radius 

 Profile Curve between Elements 

Use the Profile Curve Between Elements command to constructs a vertical curve between two 

designated elements.   

1. Open the Civil Tools task pane to the Vertical Geometry section then click the Profile 

Curve Between Elements icon. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

 The Profile Curve Between Elements dialog opens. 
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 The back and ahead elements can be lines or curves and can be attached or not.  If 

attached the elements will be clipped based on the curve parameters selected. 

 

 Checking the box next to any of the fields locks-in the associated value. 

2. Once the cursor is in the Profile View, a command prompt requesting Locate First 

Profile Element is presented.  Data point on the element that will come into the curve.   

3. Set the Back Vertical Offset either by keying in a value or locating a distance graphically 

by moving the cursor. 

4. When prompted to Locate Second Profile Element, move the cursor to the element to 

which the curve must extend then data point. 

5. Enter the Ahead Vertical Offset.  

6. Use one of the following methods to designate a point through which the curve must 

pass.  Navigate the options by selecting the left or right arrow keys. 

 As you move the cursor, a value is displayed on the prompt. Data point at the desired 

value. 

 Enter a value for Length and select the Enter key then data point. 

 Enter a value for Vertical Curve Parameter and select the Enter key then data point. 

7. To trim the element at the intersection of the curves or to extend the new curve to 

intersect with the old, your Offset value must be zero. Strike the down arrow key to 

choose the Both option then strike the Enter key. 

 

 

Custom Tool 

These pre-customized versions provide a simplified prompt sequence for many common 

construction tools. Right-click on the Profile Curve Between Elements icon then choose 

Show/Hide Profile Curve Between Elements Tools to access the following option: 

 Parabola between Elements - Creates a parabola between two elements, Offsets are 

locked at zero 
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 Asymmetric Parabola - Creates an asymmetric parabola between two elements, Offsets 

are locked at zero 

 Circular Curve between Elements - Creates a simple profile radius between two 

elements, Offsets are locked at zero 

Note:  Customized versions are pre-configured to select parabola or curve types negating the 

need to use ALT key to cycle types. 

 

 

 

 

 Profile Complex by Elements 

Use the Profile Complex by Elements command to construct a complex profile element from 

previously placed elements. 

1. Open the Civil Tools task pane to the Vertical Geometry section then click the Profile 

Complex by Elements icon. 

Note:  If your View isn't in Profile mode, an error message will indicate that you need to 

open a Profile Model. 

 The Complex Elements dialog opens.  

 

 Checking the box next to any of the fields locks-in the associated value. 

2. On the Complex Element dialog, expand the Method drop-down and choose the Manual 

Option.   

 Manual allows the identification of the elements to include and the direction of 

the elements. 

 Automatic will select the elements based on juxtaposition. 
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3. When you move the cursor into the Profile View, it is equipped with a command prompt 

requesting that you Locate First Element, move the cursor to one of the elements that 

you wish to include in the complex element and click on it. 

 

 

 

4. When prompted to Locate Next Element, move the cursor to another element that you 

wish to include in the complex element and data point. 

 

5. When prompted to Locate Next Element, move the cursor to another element that you 

wish to include in the complex element and data point. 
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6. When a line appears to link the elements, data point to create the new complex element. 

 

Note:  The line that appears between the elements vanishes upon confirmation. It is 

simply a visual aid to identify the component elements. 
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3.4 Group Exercise 1: Create Road1 Profile 

1. Within the J2P0200/data_03 folder, open the file:  Civil_Geometry_J2P0200.dgn 

2. Select MicroStation File > References > Tools > Attach.  Select the file 

Terrain_J2P0200_Existing.dgn.  

3. Select the Attachment Method as Coincident World. 

4. Set J2P0200 as the active Terrain Model. 

5. After Left Clicking on the Road1 Alignment select Open Profile Model from the heads 

up display. 

6. When prompted to Select or Open View, select View 8 from View Groups and data point 

in the view. 

7. Use Zoom (the roller button on the mouse) and the Pan (hold the roller button down) to 

navigate around the profile model.  

8. Select the   Profile Complex By VPI task and create a “rough draft” proposed 

profile that has 5 VPIs.  Adjustments to rough draft profile will be made in next steps. 

9. Using the chart below adjust the station values for the 5 VPIs that were place in the 

previous step.  The first and last VPI are AccuSnapped to the beginning and ending 

location of the exisitng ground. 

VPI Station Elevation Grade Curve Length 

VPI #1 0+00.000 R1 824.641   

   
-0.50% 

 VPI #2 14+50.000 R1 817.391 

 

600 

   

4.00% 

 VPI #3 23+60.000 R1 853.791 

 

500 

   

1.00% 

 VPI #4 32+75.000 R1 862.941 

 

400 

   
-3.64% 

 VPI #5 35+10.080 R1 854.386 

  
10. Using the chart above adjust the Grade values for profile that was place in the step 9.   

11. Using the chart above adjust the Curve Length for the Vertical Curve defined in the 

profile that was place in the step 9. 

12. Select the new Road 1 Propose Profile using the Heads Up display and select Profile 

Report.  Verfify that User Profile data matches data on next page. 
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VERTICAL ALIGNMENT REVIEW REPORT 
 

* BENTLEY VERTICAL ALIGNMENT REVIEW                                                 

*   

* Alignment name: Unnamed  

* Alignment description:   

* Alignment style: MoDOT_Baseline_Proposed  

*   

                                                          STATION   ELEVATION  

Element: Linear  

VPI #1                                         POB     0+00.00 R1     824.641  

                                               PVC    11+50.00 R1     818.891  

                                    Tangent Grade:         -0.50%  

                                   Tangent Length:       1150.000  

Element: Symmetrical Parabola  

                                               PVC    11+50.00 R1     818.891  

VPI #2                                         PVI    14+50.00 R1     817.391  

                                               PVT    17+50.00 R1     829.391  

                                              VLOW    12+16.67 R1     818.724  

                                           Length:        600.000  

                                   Entrance Grade:         -0.50%  

                                       Exit Grade:          4.00%  

                                r = (g2 - g1) / L:          0.750  

                                K = l / (g2 - g1):        133.333  

                                  Middle Ordinate:          3.375  

Element: Linear  

                                               PVT    17+50.00 R1     829.391  

                                               PVC    21+10.00 R1     843.791  

                                    Tangent Grade:          4.00%  

                                   Tangent Length:        360.000  

Element: Symmetrical Parabola  

                                               PVC    21+10.00 R1     843.791  

VPI #3                                         PVI    23+60.00 R1     853.791  

                                               PVT    26+10.00 R1     856.291  

  

                                           Length:        500.000  

                                   Entrance Grade:          4.00%  

                                       Exit Grade:          1.00%  

                                r = (g2 - g1) / L:         -0.600  

                                K = l / (g2 - g1):        166.667  

                                  Middle Ordinate:         -1.875  

Element: Linear  

                                               PVT    26+10.00 R1     856.291  

                                               PVC    30+75.00 R1     860.941  

                                    Tangent Grade:          1.00%  

                                   Tangent Length:        465.000  

Element: Symmetrical Parabola  

                                               PVC    30+75.00 R1     860.941  

VPI #4                                         PVI    32+75.00 R1     862.941  

                                               PVT    34+75.00 R1     855.663  

                                             VHIGH    31+61.23 R1     861.372  

                                           Length:        400.000  

                                   Entrance Grade:          1.00%  

                                       Exit Grade:         -3.64%  

                                r = (g2 - g1) / L:         -1.160  

                                K = l / (g2 - g1):         86.226  

                                  Middle Ordinate:         -2.319  

Element: Linear  

                                               PVT    34+75.00 R1     855.663  

VPI #5                                         POE    35+10.08 R1     854.386  

                                    Tangent Grade:         -3.64%  

                                   Tangent Length:         35.080 
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Group Exercise 1: Create Road 1 Profile Continued. 

13. Next we are going to create the profile a second way using Civil AccuDraw to place the 

Vertical Curve information.  First we need to delete the previously store profile by 

selecting the Road 1 Propose Profile and using the heads up disply and selecting Delete.   

14. With Civil AccuDraw active select the  Profile Complex By PI task.  

15. This time using Civil AccuDraw and it’s “Z” and “Slope” mode to create the same 

Road1 profile using the following criteria: 

 

VPI Station Back Grade Elevation Curve Length Addition Info. 

#1  0+00 

 

824.641 

 

(Snap to begging of Ex. Profile) 

#2 14+50 -0.50% 

 

600 

 #3 23+60 4.00% 

 

500 

 #4 32+75 1.00% 

 

400 

 #5 35+10.08 
 

854.386 
 

(Snap to end of Ex. Profile) 
 

16. Select the new Road1 Propose Profile using the Heads Up disply and select Profile 

Report.  Verfify that User Profile data matches data on previous page. 

17. Select File > Update Server Copy.  
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3.5 Individual Exercise 2: Create Route63 Profile 

1. Within the J2P0200/data_03 folder, open the file: Civil_Geometry_J2P0200.dgn. 

2. Verify J2P0200 is still the active the Terrain Model from the previous exercise. 

3. Select Vertical Geometry > Open Profile model from the Civil Tools Tasks 

4. When prompted to Locate Plan Element, select the RTE63 alignment. 

5. When prompted to Select or Open View, select View 3 from View Groups and Data 

Point in the view.   

Note:  If another profile already exists in the view, this will not lose any profile 

information for the profile currently in the window, the window will simply change the 

display to the profile of the current geometry selected. 
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6. Select the  Profile Complex By VPI task.  

7. Create the profile using the following criteria: 

 

VPI Station Back Grade Elevation Curve Length 

#1 9+50 

 

844.71 

 #2 23+50 

 

820.21 410 

#3 35+10 0.50% 
 

275 

#4 57+90 2.00% 
 

725 

#5 70+79 
 

859.80 
 

 

 

8. Select the new Route 63 Propose Profile using the Heads Up disply and select Profile 

Report.  Verfify that User Profile data matches data on next page. 

9. Select File > Update Server Copy.  
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BENTLEY VERTICAL ALIGNMENT REVIEW REPORT 
 

* Alignment name: Unnamed  

* Alignment description:   

* Alignment style: MoDOT_Baseline_Proposed  

*   

                                                          STATION      ELEVATION  

Element: Linear  

                                               POB     9+50.00 R1        844.710  

                                               PVC    21+45.00 R1        823.798  

                                    Tangent Grade:         -1.75%  

                                   Tangent Length:       1195.000  

Element: Symmetrical Parabola  

                                               PVC    21+45.00 R1        823.798  

                                               PVI    23+50.00 R1        820.210  

                                               PVT    25+55.00 R1        821.235  

                                              VLOW    24+63.89 R1        821.007  

                                           Length:        410.000  

                                   Entrance Grade:         -1.75%  

                                       Exit Grade:          0.50%  

                                r = (g2 - g1) / L:          0.549  

                                K = l / (g2 - g1):        182.222  

                                  Middle Ordinate:          1.153  

Element: Linear  

                                               PVT    25+55.00 R1        821.235  

                                               PVC    33+72.50 R1        825.322  

                                    Tangent Grade:          0.50%  

                                   Tangent Length:        817.500  

Element: Symmetrical Parabola  

                                               PVC    33+72.50 R1        825.322  

                                               PVI    35+10.00 R1        826.010  

                                               PVT    36+47.50 R1        828.760  

  

                                           Length:        275.000  

                                   Entrance Grade:          0.50%  

                                       Exit Grade:          2.00%  

                                r = (g2 - g1) / L:          0.545  

                                K = l / (g2 - g1):        183.333  

                                  Middle Ordinate:          0.516  

Element: Linear  

                                               PVT    36+47.50 R1        828.760  

                                               PVC    54+27.50 R1        864.360  

                                    Tangent Grade:          2.00%  

                                   Tangent Length:       1780.000  

Element: Symmetrical Parabola  

                                               PVC    54+27.50 R1        864.360  

                                               PVI    57+90.00 R1        871.610  

                                               PVT    61+52.50 R1        868.289  

                                             VHIGH    59+24.72 R1        869.332  

                                           Length:        725.000  

                                   Entrance Grade:          2.00%  

                                       Exit Grade:         -0.92%  

                                r = (g2 - g1) / L:         -0.402  

                                K = l / (g2 - g1):        248.610  

                                  Middle Ordinate:         -2.643  

Element: Linear  

                                               PVT    61+52.50 R1        868.289  

                                               POE    70+79.00 R1        859.800  

                                    Tangent Grade:         -0.92%  

                                   Tangent Length:        926.500  
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4.1 Objectives 

 Learn how to build rules based geometry that can be used to control the transition of 

template points. 

4.2 Definitions 

Point Controls are used to override the established horizontal and vertical locations of points 

from the original point location on the template.  Point controls are the equivalent of the criteria 

adhocs placed on plan graphics with D&C Manager to control widths, ditch slopes, etc.  

Consequently, point controls are used to control horizontal and vertical locations for EOP, EOS, 

sidewalks, retaining walls, barriers, special ditch profiles and ditch widths, etc. 

The transitional geometric elements are created using the Civil Geometry tools. 

4.3 Horizontal Geometry Tools for Transitional Geometry 

4.3.1 Offsets and Tapers  

 

Offsets and Tapers construct linear elements based on various methods of offsets from a base 

element. The base element may be a line, arc, spiral, or complex. There are four methods: 

 Single Offset Entire Element 

The offset element maintains a constant offset along the entire length of the base element. 

Workflow  

1. Select Single Offset Entire Element. 

2. Select the base element. Data point to accept. 

3. Key in the offset. 

4. Data Point to select Yes to Mirror or strike down arrow to choose No to place the offset 

on one side only and Data Point. 
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 Single Offset Partial 

The offset element maintains a constant offset along the given length of the base element.  The 

length can be defined by start and stop distance (stations) of a keyed in length. 

Workflow  

1. Select Single Offset Partial. 

2. Select the base element. Data point to accept. 

3. Key in the offset.  

4. Specify the beginning station by moving the mouse to beginning station, or if using the 

Civil AccuDraw Station-Offset favorite, key in the station.., or press the <Alt> key to 

lock the beginning point to the Start station. Data point to accept. 

5. Move the mouse to the ending station or press the <Alt> key to select the End station.  

Data point to accept. 

6. Data Point to select Yes to Mirror or strike down arrow to choose No to place the offset 

on one side only and Data Point. 

Manipulators (Single Offset Entire or Partial Element) 

 

Manipulators are available for: 

 Offset 

 Starts distance 

 End distance 

 Slide End Fixed Length 

  



GEOPAK Road 1      Chapter 4 – Plan & Profile Sheet Geometry 
 

 

4/22/16 Missouri Department of Transportation 4-3 

 Variable Offset Taper 

 The offset is variable and defined by station and offset at each end of the offset element. 

Workflow 

1. Select the Variable Offset Taper placement tool. 

2. Select the base element. Data Point to accept. 

3. Select the start point, offset, and distance dynamically or by key-in. This is a dual 

prompt. Use left/right arrows to toggle between the two. 

4. Set the end offset and distance. This is a dual prompt. Use left/right arrows to toggle 

between the two. 

Manipulators (Variable Offset Taper) 

 

Manipulators are available for: 

 Start offset 

 End offset 

 Starts distance 

 End distance 
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 Ratio Defined Taper 

The offset element is defined by a station offset and beginning, and the end point is defined by a 

ratio. 

Workflow  

1. Select the Ratio Defined Taper tool. 

2. Select the base element. Data Point to accept. 

3. Select the start point, offset, and distance dynamically or by key-in. This is a dual prompt. 

Use left/right arrows to toggle between the two. 

4. Set the ratio and end distance. This is a dual prompt. Use left/right arrows to toggle 

between the two. 

Manipulators (Ratio defined Taper) 

 

Manipulators are available for: 

 Start Offset 

 Starts distance 

 End distance 

 Ratio 

Use of ALT Key 

During the operation of the command, the <ALT> key can be used to toggle the check marks 

for Beginning of Element and Ending of Element. When the prompt is for first point of the offset 

line, pressing <ALT> will toggle the check mark for Beginning of Element. When the prompt is 

for second point of the offset line, then pressing <ALT> will toggle the check mark for End of 

Element. 

Properties 

Offset Transition rule data is also accessible in the properties. The properties are identical for all 

methods. Changing the method in properties will expose additional manipulators on screen. 
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4.3.2 Templates 

Create Geometry by Template 

Use the Create Geometry by Template command to generate geometry. 

1. Open the Civil Tools task pane to the Horizontal Geometry section then click the Create 

Geometry by Template tool. 

2. When you move the cursor into the view, it is equipped with a command prompt 

requesting that you Locate Reference Element. Select the element to which you wish to 

apply the template then data point (i.e., left-click). 

3. The Create Geometry By Template dialog opens. 

 

4. Checking the box next to any of the fields locks-in the associated value. 

5. When prompted to Select Template, hold down the Alt key and strike the down arrow 

key to open the Pick Template dialog. 
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6. When the dialog opens, navigate the tree to choose from the available templates then click 

OK and data point in the view. 

 

Note:  The Select Template command prompt retains your last selection, so if you wish to apply 

multiple instances of the same template, you need only data point when the populated prompt 

appears. 
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4.4 Group Exercise: Creating Geometry for Road 1 Corridor  

Design File Setup 

1. Within the data_04\data folder, open the file: Civil_Geometry_J2P0200.dgn. 

2. Create a new file named Plan_J2P0200.dgn based on the 2D seed file 

pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn 

This new file will hold the geometry that can be used for design changes to the proposed 

corridor.   

3. Reference in the 2D Project Civil Geometry file; Civil_Geometry_J2P0200.dgn. 

4. Reference in the 3D Project Terrain file; Terrain_J2P0200_Existing.dgn and set the 

terrain to active. 

Creating Horizontal Geometry Based on Centerline 

Horizontal geometry, vertical geometry and a combination of both can be used as point controls in 

the corridor model.  When attached to a point in a template, these geometries override the 

constraints put on the template point during creation.  Template points and constraints are covered 

in detail in GEOPAK Road 1 Chapter 05 Creating Templates.   

Create Geometry for a Right Passing Lane Proposed Edge of Pavement 

5. Turn Off Civil AccuDraw. 

6. Toggle On the Use Active Feature Definition on the Features Definition Toggle Bar. 

7. Set the active feature to be Design > Design Standards > Roadway > EOP New. 

8. Toggle On the Use Active Feature Definition on the Features Definition Toggle Bar. 

9. Select the Single Offset Partial  tool. Located under the Tasks/Horizontal Geometry 

tool set. 

10. When prompted to Locate Element, select ROAD1 

11. The offset will be 24’ to the right 

12. In the dialog select “Lock to Start”. 

13. When prompted to enter the End Distance key 

in 10+00.00.  

 

14. The passing lane is going to only be on the South Bound lane so select No for the Mirror 

option. 
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Place a Transition Taper 

15. Select Variable Offset Taper.   Located under the Tasks/Horizontal Geometry tool 

set. 

16. First in the dialog set the Start and ending Offset of 24 ft. and 12 ft. to the right 

respectively. 

17. Secondly in same dialog set the Start and Ending station of 10+00 and “Lock to End” 

respectively. 

18. When prompted to Locate Element, select ROAD1 near the end of the partial offset at 

station 10+00 R1. 

19. When prompted for the Start Parameters, hover near the end of North end of the partial 

offset, the tool should be locked in at the location of the start point listed in the dialog. 

 

20. Click twice to store Variable Offset Taper 

 

21. When prompted to Mirror select No.  

 

22. Data point to accept solution and reset to exit command. 

 

Complex the Proposed Edge of Pavement 

23. Set the active feature to be Design > Design Standards > Roadway > EOP New. 

24. Select the Complex by Elements  task. 

25. In the Create Complex by Elements dialog, verify the Method is set to Automatic. 

26. When prompted to Locate First Element, identify the beginning of the Partial Offset 

element with the 24 ft offset so the direction is south. 

27. Both offset elements will be highlighted. Data point to Accept Complex.  The new 

complex geometry will be created and use the symbology defined by the EOP_New 

Feature Definition. 
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Placing Right of Way Line 

28. Create a new file named Land_Boundary_J2P0200.dgn based on the 2D seed file: 

 pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn 

This new file will hold the geometry that can be used to display Right of Way information 

in the Plan and XS View.   

29. Reference the following files: 

Civil_Geometry_J2P0200.dgn. 

Terrain_J2P0200_Existing.dgn 

Plan_J2P0200.dgn 

30. Use the Horizontal Geometry Tool Complex By PI to place a line with a Feature 

Definition of RW_Controlled_Access_Proposed at the following locations: 

a. Note: use Civil AccuDraw to place line accurately along the Road1 Alignment. 

 

Station Offset 

0+00 -100 

7+53.43 -100 

10+00 -125 

15+00 -150 

20+00 -150 

23+62.95 -100 

35+10.08 -100 

 

31. Select the Terrain Model J2P0200 and make active (if not already). 

32.  Open the Profile View of the just placed RW_Controlled_Access_Proposed element. 

33. Give the Profile the Feature Name of “Existing” 

34. Set as Active the Profile. 

a. Note by setting active the Right of Way line profile, future cross section will now 

show a delimiter of the locations of said Right of Way line. 

35. Select File > Update Server Copy.  
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4.5 Individual Exercise: Create Corridor Geometry for Route 63 

If the edge of pavement and edge of shoulder of an existing road are required in the design file for 

visualization or for future corridor work you can use the transition tools explored in the Road 1 

exercise. Another option to create geometry is to use a template that matches what the existing 

conditions are or proposed conditions.  The Create Geometry by Template tool is used to apply 

a template along existing geometry to create additional geometry. 

Placing Right of Way Line Information. 

1. Continue working in Land_Boundary_J2P0200.dgn. 

2. Use the Horizontal Geometry Tool Complex By PI to place a line with a Feature 

Definition of RW_Controlled_Access_Proposed at the following locations: 

a. Note: use Civil AccuDraw to place line accurately along the Route63 Alignment. 

 

Station Offset 

9+50 150 

25+67.20 150 

27+67.20 150 

28+00 200 

30+00 200 

35+00 200 

40+00 200 

43+00 200 

43+79.95 150 

45+79.95 150 

70+79.95 150 

 

3. Select the Terrain Model J2P0200 and make active (if not already). 

4.  Open the Profile View of the just placed RW_Controlled_Access_Proposed element. 

5. Give the Profile the Feature Name of “Existing” 

6. Set as Active the Profile. 

a. Note by setting active the Right of Way line profile, future cross section will now 

show a delimiter of the locations of said Right of Way line. 

7. Select File > Update Server Copy.  
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4.6 Group Exercise Exporting and Plotting Profiles - Road 1 

1. Open the Civil_Geometry_J2P0200.dgn. 

2. Right Click and hold in a blank area and select User Preferences. 

a. Verify that the Working Directory is empty (clear out if needed). 

3. In the User Preferences dialog select COGO Preferences. 

a. Verify that the Job (GPK) Directory is empty (clear out if needed). 

4. Select the “OK” button twice to close the two previous preference dialogs. 

5. Open Classic COGO and open the 200 gpk. 

6. Select COGO Navigator and view the Chain and Profiles listed in the gpk. 

7. If the ROAD1 Chain, ROAD1EX or ROAD1PR profile is not listed, proceed to the 

following steps.  Otherwise skip to Step 11. 

8. Open the ROAD1 Profile Model. 

9. Select Task > General Geometry > Export to Native. 

10. Any item listed in Step 10 that does not exist in the 200 gpk, select and export using 

the Export to Native tool. 

11. Create a new file named Profile_J2P0200.dgn based on the 2D seed file: 

 pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn 

This new file will hold the profile sheet geometry.   

12. Reference in the following 2D Project dgn files: 

Civil_Geometry_J2P0200.dgn 

Plan_J2P0200.dgn 

Land_Boundary_J2P0200.dgn 

13. Move to a blank area in the drawing away from the plan geometry. 

14. Open D&C Manager by selecting the icon in the SS2 Tool Palette. 
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15. Plot the ROAD 1 existing ground profile using the following Design and Computation 

Manager item: 

Drafting Standards\Profile\Existing Ground Profiles\1”=50’ Existing Ground Profile.   

After selecting the item in D&C Manager, Click on Draw Plan & Profile in the 

Operations Box. 

 
 

Note: If prompted select the 200 gpk 

 

16. Be sure all options are turned off, and the Labeling Scale is set to 50. 

 

Choose the profile ROAD1EX. 

 
 

 

 

 

 

 

 



GEOPAK Road 1      Chapter 4 – Plan & Profile Sheet Geometry 
 

 

4/22/16 Missouri Department of Transportation 4-13 

17. 16.  Set the following parameters: 

 

Horizontal Scale: 50 

Vertical Scale: 10 

DP Station: 0+00 

DP Elevation: 800 

DP X and Y: Data point on the screen in an 

open area. 

PGL Chain: ROAD1 

 

18. Draw the Profile Cell with the Draw Cell at 

XY button. 

19. Draw the profile by selecting “OK”. 
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20. Plot the proposed profile using the following Design and Computation Manager item: 

 Drafting Standards\Profile\Proposed Ground Profiles\50 Scale Proposed Ground Profile 

1”=50’ H & 1”=10’ V. 
 

After selecting the item in D&C Manager, Click on Draw Plan & Profile in the 

Operations Box. 

 
 

Note: If prompted select the 200 gpk 

 

21. Turn on the following options: 

VPI Labels 

Horizontal Axis Labels 

Vertical Axis Labels 

V.C. Parameters 

Grade Labels 

K Value 

VPC/VPT Label 

Stopping Sight Distance 
 

Choose the profile ROAD1PR. 
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18. (Continued) 

 

Use the Identify Cell button to select the profile cell placed in step 6. 

 

Plot the profile ROAD1PR by selecting the OK button. 

 

 
 

22. Exit D&C Manager. 

23. Select File > Update Server Copy.  
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4.7 Individual Exercise Exporting and Plotting Profiles - Route 63 

1. Open the Civil_Geometry_J2P0200.dgn. 

2. Right Click and hold in a blank area and select User Preferences. 

a. Verify that the Working Directory is empty (clear out if needed). 

3. In the User Preferences dialog select COGO Preferences. 

a. Verify that the Job (GPK) Directory is empty (clear out if needed). 

4. Select the “OK” button twice to close the two previous preference dialogs. 

5. Open Classic COGO and open the 200 gpk. 

6. Select COGO Navigator and view the Chain and Profiles listed in the gpk. 

7. If the ROUTE63 Chain, ROUTE63EX or ROUTE63PR profile is not listed, proceed to 

the following steps.  Otherwise skip to Step 11. 

8. Open the ROUTE63 Profile Model. 

9. Select Task > General Geometry > Export to Native. 

10. Any item listed in Step 10 that does not exist in the 200 gpk, select and export using 

the Export to Native tool. 

11. Open the dgn file named Profile_J2P0200.dgn 

12. Move to a blank area in the drawing away from the plan geometry. 

13. Open D&C Manager by selecting the icon in the SS2 Tool Palette. 
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14. Plot the ROUTE 63 existing ground profile using the following Design and Computation 

Manager item: 

Drafting Standards\Profile\Existing Ground Profiles\1”=50’ Existing Ground Profile.   

After selecting the item in D&C Manager, Click on Draw Plan & Profile in the 

Operations Box. 

 
 

Note: If prompted select the 200 gpk 

 

15. Be sure all options are turned off, and the Labeling Scale is set to 50. 

 

Choose the profile ROUTE63EX. 
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16. Set the following parameters: 

 

Horizontal Scale: 50 

Vertical Scale: 10 

DP Station: 9+50 

DP Elevation: 800 

DP X and Y: Data point on the screen in an 

open area. 

PGL Chain: ROUTE63 

 

17. Draw the Profile Cell with the Draw Cell at XY 

button. 

18. Draw the profile by selecting “OK”. 
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19. Plot the proposed profile using the following Design and Computation Manager item: 

 Drafting Standards\Profile\Proposed Ground Profiles\50 Scale Proposed Ground Profile 

1”=50’ H & 1”=10’ V. 
 

After selecting the item in D&C Manager, Click on Draw Plan & Profile in the 

Operations Box. 

 
 

Note: If prompted select the 200 gpk 

 

20. Turn on the following options: 

VPI Labels 

Horizontal Axis Labels 

Vertical Axis Labels 

V.C. Parameters 

Grade Labels 

K Value 

VPC/VPT Label 

Stopping Sight Distance 
 

Choose the profile ROUTE63PR. 
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20. (Continued) 

 

Use the Identify Cell button to select the profile cell placed in step 6. 

 

Plot the profile ROUTE63PR by selecting the OK button. 

 

 
 

24. Exit D&C Manager. 

25. Select File > Update Server Copy.  
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5.1 Create Template Dialog 

The first step to creating a 3D model is to create templates for the roadway design. Templates are 

dynamic typical sections used in Corridor Modeling that use transverse geometry to create 3D 

models.  Each template contains a series of points and components that represent breaklines, 

which are used to create the roadway surfaces.  All these points, components, and templates are 

stored in the template library (itl). 

CADD Support has created a default template library.  This library contains most used 

components and end conditions at MoDOT.  A limited number of templates are available through 

this template library.  The intent is for the user to assemble his/her own templates giving the 

districts more flexibility in their design; therefore, the default MoDOT library needs to be copied 

to the user’s working directory using the Start Job routine when creating new projects. 

The user accesses all templates available in the standard MoDOT template library.  In addition, 

this is the tool to use to create new components and templates to be used within Roadway 

Designer. 

To access the Create Template Dialog, select the icon through the Corridor Modeler Tools in the 

Civil Tools Tasks.  

The Create Template Dialog is composed of three major areas: Folder Tree Window, Current 

Template Window, and the Template Preview Window, which are shown below. 

  

  

Folder 

Tree 

Window 

Template 

Preview 

Window 

Edit 

Template 

Window 
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5.1.1 Folder Tree Window 

This view allows the user to navigate through the template library selected.  The folder tree 

structure begins with the template library.  Underneath, the user will find the following categories: 

Point Name List, Components Folder, End Conditions Folder, CADD Support Templates, and 

District User Templates. This window is completely user definable, and it has all windows 

capabilities like right click functions, copy, paste, drag and drop. 

5.1.2 Point Name List 

This list contains previously created names to be utilized in the creation of new points for creating 

components for templates. Each point on a template must be unique, so no point can have the 

same name.  CADD Support has created a point name list for standardization. 

5.1.3 Components 

A component is a set of points defining an open or closed shape that represent different portions 

of the template.  For example, pavement structure, curbs, gutters, shoulders, medians, retaining 

walls, etc.  MoDOT default library has many components from which to choose to create 

templates.  These components are organized in categories according to functionality.  These 

components do not include side slope conditions. 

5.1.4 End Conditions 

End conditions are simply side slope condition components that tie to existing ground.  These 

include fill slope, cut slopes, ditches and/or combination thereof. 

5.1.5 CADD support templates 

The MoDOT standard template library will contain a limited number of templates.  Only these 

templates will be housed in this folder.  

5.1.6 District user templates 

The user will save the template library in his/her working directory and 

will be able to modify the library by adding new templates or components.  

Any templates created by a district user should be stored in this folder.   

5.1.7 Preview Template Window  

The template preview window shows the template that is highlighted in the folder tree view.  A 

Cyan color box denotes the placement location for that template.  Usually this is at the origin of 

the template, but the user can click on any point to move the placement point location. The user 

can drag and drop from the preview are to the current template window. 
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5.1.8 Current Template Window 

This is the large window on the right hand side of the Create Template Dialog where templates 

are assembled and edited.  The current template window shows the user the name, description 

and design of the template currently being edited, reviewed or assembled.   

 

5.2 Display Options 

The two radio buttons allow the user to choose what to display in the center window.  The 

Components option shows the typical section component/template picture.  The Constraints 

option show how each point in the component/template is constrained to each other.  Constraints 

will be covered in another section. 

There are two check boxes the user can select for displaying various portions of the template.  

When the Display Point Names option is checked on, all the point names in the current template 

are displayed.  Point names are long and when displayed the window can be too cluttered. 

Sometimes templates have hidden components controlled by certain design situations. This 

concept will be discussed in a later chapter. When the Display All Components option is 

selected, these hidden components are displayed.  



GEOPAK Road 1  Chapter 5 – Creating Templates  
 
 

5-4 Missouri Department of Transportation 4/22/16 

5.2.1 Center Window 

The center window is the main graph for creating/modifying templates.  This window has its own 

graphics engine and so it is not a MicroStation window. The scale of the graph is dynamic and 

changes as you zoom in and out. 

The center point of the window is marked by the dynamic origin, which is a magenta-colored box.  

The dynamic origin is used as a reference point and can be moved to any location in the graph. 

5.2.2 View Commands 

 

These commands are similar to the MicroStation view commands.  They allow the user to 

perform the standard zoom in/out, zoom in/out in the X direction, zoom in/out in the Y direction; 

window in an area, and fit the view, undo, redo, and set dynamic settings.  

5.2.3 Testing End Conditions 

Test – Opens the Test End Conditions dialog box.  This tool allows the user to test the end 

condition solutions. 

 

This tool displays the current template; the non-solved end conditions and their child components 

are displayed in dashed lines.  The normal components and solved end conditions are displayed as 

solid lines. 
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The Available Targets area lists all of the targets available whether they are surfaces or specific 

styles. The user simply selects the desired target, sets the Surface Slope, and then clicks on Draw 

to test. The Surface Slope is the slope of the surface that is being placed. The Reset button clears 

all the drawn targets. 

Display Rules - list the display rules for the current template. Left-click over a value to toggle 

between True and False.  Press the Reset button to restore the original Display Rules values. 

Failure Report – activates the Results dialog.  When a template fails to get a solution on one or 

both sides, the results show which components failed and which end condition start points were 

not solved. 

Check Priorities – tests the template for priority conflicts.   Each end conditions starting at the 

same point has a priority assigned, and must be unique.  When a conflict exists, a message is 

displayed indicating there are end conditions starting at the same point having the same priority 

assigned.  If there are no conflicts, a message box indicating no conflicts is displayed. 

Check Duplicates – checks for duplicate feature and component names for the given solution. If 

duplicate feature or component names are found, the Duplicate Feature Name List dialog is 

displayed. If no duplicates are found, a message to this effect is displayed.  

Close – dismisses the dialog. 

Help – displays the help for this dialog. 

5.2.4 Dynamic Settings 

Similarly to the MicroStation AccuDraw tool, the Dynamic Settings 

are used for precision input of the template components and to assign 

point names and styles when creating components. 

It also serves as a compass for the cursor location with respect to the 

dynamic origin.  The dynamic origin can be modified by using the 

“Set Dynamic Origin” at the bottom of the dialog box. 

5.2.5 Accessing the Dynamic Settings 

The Dynamic Settings can be accessed by selecting Tools>Dynamic Settings or by using the 

view control icon . The dynamic setting Step should be set to x = 0.1, y = 0.1 before creating 

templates to allow for easy dynamic positioning. 

5.2.6 Precision Key-In Commands 

XY = Key-in absolute coordinates (x, y) 

DL = Key-in delta coordinates from last point placed (defaults to the dynamic origin if it is the 

first point of a component 

HS = Key-in horizontal delta distance and slope from last point placed 
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VS = Key-in vertical delta distance and slope from last point placed 

OL = Key-in delta coordinates from dynamic origin 

OS = Key-in horizontal delta distance and slope from dynamic origin 

  

5.2.7 Creating Templates from Components 

Templates can be assembled by dragging and dropping components and end conditions into the 

Current Template window one at a time.   

Each point on a component has a unique point name.  These point names are created without 

being specific to “left” or “right” side of the roadway.  The user assigns a prefix or suffix to 

determine “left” or “right” when creating the template via the Dynamic Settings. 

Creating components will be covered in a later chapter. 

5.2.8 Dragging and Dropping Components 

When two points coincide, a heavy white plus sign will appear.  When connecting two 

components together, the existing connection point name will override the dropped point name.  

Dynamic Settings should be set before starting to drag and drop components to create a template. 

Once a component is created, it can be modified by editing any property, inserting new points, or 

creating display rules. Once two or more components have been combined, they can also be 

merged. 

To edit components, simply right-click between the components to access the editing commands.  
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Basic Template Creation Workflow 

1. Open Template Library 

2. From the folder tree view, right-click and select Create > New Template 

3. “Drag and drop” template components 

4. Merge Components 

5. Verify Point Names 

6. Save the Template Library 

5.2.9 Pull Down Menus 

File – allows the user to create a new template library, new folder, or new template; open another 

library, save the current library, or import a template from another library. 

Edit – has the common Windows commands undo, redo, cut, copy, paste, clear, delete, and 

rename. 

Add – has all the options for developing new components. Components are covered in a later 

chapter. 

The Tools menu offers several tools to manage the template library, but the only two tools 

pertaining to the MoDOT template library are the Dynamic Settings covered in section 2.6 and the 

Template Library Organizer, which allows the user to copy components and templates from 

one library to another. 

5.3 Point Constraints 

Templates and components are defined by the points making their shapes. Thus point constraints 

are used to manage the behavior of all template points. The purpose of point constraints is to 

create relationships between the points in a template so that if one point moves, the other points 

follow in a predictable manner. 

Each template point has a maximum of two constraints on it.  A template point with two 

constraints is considered “fully constrained” and is represented graphically by a red plus sign on 

the template display. A template point with only one constraint is considered “partially 

constrained” and is represented graphically by a yellow plus sign. A point with no constraints is 

considered “unconstrained” and is shown as a green plus sign. 

5.3.1 Types of Constraints 

There are a total of 11 different types of constraints:  

Horizontal - Allows the placement of a new point (or child point) a specified horizontal distance 

from a reference point (or parent point). 

Vertical - Allows the placement of a new point (or child point) a specified vertical distance from 

a reference point (or parent point). 
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Slope - Allows the placement of a new point (or child point) using a specified slope from the 

reference point (or parent point).  Slope constraints are absolute.  Slopes going from lower-left to 

upper right are positive regardless of whether the child point is to the left or right of the parent. 

Horizontal Maximum - The child point has two parent points and remains at the specified 

horizontal distance from the parent point that is farthest to the right (has a maximum horizontal or 

X value).   

Horizontal Minimum - The child point has two parent points and remains at the specified 

horizontal distance from the parent point that is the farthest to the left. 

Vertical Maximum - The child point has two parent points and remains at the specified vertical 

distance from the parent point that is the highest (has a maximum vertical or Y value). 

Vertical Minimum - The child point has two parent points and remains at the specified vertical 

distance from the parent point that is lowest (has the minimum vertical or Y value). 

Vector-Offset - The child point is projected onto the vector defined by two parent points.  If the 

offset is not zero, then the child point will maintain a perpendicular offset from the parent vector 

at the specified offset value.  Negative values indicate an offset to the left of the vector defined by 

the parent points. Positive values indicate an offset to the right. If the offset is zero, the child point 

is located on the parent vector. 

Project to Surface (to Existing Ground) - This constraint must be used in conjunction with one 

of the previously defined constraints. The other constraint will define the projection direction. The 

child point will then be projected to the surface with the specified name.  If the surface does not 

exist, or no solution is found, the point will remain where it is placed in the template. 

Project to Design - This constraint is similar to Project to Surface, except that the point is 

projected to the design surface of the template.  A projection value is given to indicate whether 

the projection is to be to the left or to the right.  Again, the point must also be constrained by one 

of the previous constraints, excluding the Project to Surface constraint, so that a direction for the 

projection may be determined.  If no solution is found, then the point will remain where it is 

placed in the template. 

Angle distance - This command is used to fully constrain a point in the template.  This constraint 

requires two parent points, a distance, and an angle.  The point is constrained to the location 

defined by the distance from the first parent, and the angle from the first parent relative to the 

vector defined by the two parent points.  This constraint creates a rigid-body rotation.  When 

selected, no other constraint types are available. 

 

 

 

 



Chapter 5 – Creating Templates  GEOPAK Road 1 
 
 

4/22/16 Missouri Department of Transportation 5-9  

5.3.2 Parent-Child Point Relationship 

When a template point is constrained by either one or two other points, it is considered the “child” 

of those reference points.  The reference points are then known as the “parent” point(s). 

If the parent point moves, the child also moves based on the constraints established. 

 

Example: 

Point B is a child of point A.  Point A is unconstrained and shown as a green plus sign on the 

screen.  Point B is fully constrained.  Point B has a horizontal and a slope constraint, and is shown 

as a red plus sign.  In addition, the parent point (Point A) has a blue arrow pointing to the child 

point (Point B). 

 

Visual Indicators for Vertical, Horizontal and Slope Constraints 

 
 

5.3.3 Modifying Constraints 

Once a point has been created with or without constraints in a template, it can still be modified. 

Modifications include: adding or deleting constraints, or changing the type of constrained 

originally set for a point. 

 

Child is vertically constrained to parent.  When the parent 

point moves, the child point follows at a constant vertical 

distance to that point. 

Child is horizontally constrained to parent. When the parent 

point moves, the child point follows at a constant horizontal 

distance to that point. 

Child is constrained to parent by a slope. When the parent 

point moves, the child point follows a constant slope with 

respect to the parent point. 

Point A 

Point B 
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5.4 Template Components 

Templates are a grouping of several components, and each component is a set of points that 

defined an open or closed shape.  Each component represents a material for the typical section at a 

particular location.  Each component is given a name and assigned a Feature Definition.  A 

Feature Definition is simply the MicroStation symbology used to draw the component both in 

cross section view as well as plan view. 

There are six types of components: Simple, Constrained, Unconstrained, Null Point, Overlay, and 

End Condition. 

Once created, components can be modified as desired. There is no limit to the number of points or 

components in a template. When templates are paired with horizontal and vertical alignments and 

superelevation, they define the surface of a corridor. Templates are flexible design components 

that allow you to model simple highway design items such as ditches and sidewalks to the more 

complex multi-lane highways with superelevated curves and variable side slopes. 

5.4.1 Simple Component 

A simple component is a closed parallelogram (4 constrained points) that is defined by the slope 

and thickness (for example, a pavement layer). In this case, if any point is moved, the entire shape 

moves keeping the same relationships determined by the original slope and thickness, making this 

a rigid shape. 

5.4.2 Constrained 

A constrained component consists of points that are all restricted to the movement of the first 

point. A constrained point is typically used to manage the behavior of other points in the 

template. When a point (parent) is moved, any constrained point (child) also moves. This 

restriction only affects the offset and elevation (x, y) of the restrained point and, the relationship is 

unidirectional (movement of child point does not move the parent point).  

5.4.3 Unconstrained 

An unconstrained component is open or closed-shaped with no movement restrictions. This type 

of component is only used for very specific purposes, such as “tracing” a previously placed 

component. 

5.4.4 Null Point 

A null point is a template point that is purposely not related to any particular component. It’s most 

often used as a reference for controlling other points.  A null point is considered a “check or test 

point”. For example, a null point is used to check if there is an entrance to the right or left of the 

alignment. 

5.4.5 Overlay 

This is a special type of component that allows the user to add overlay/stripping properties in 

order to calculate milling, and/or leveling (overlay) quantities.  
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5.4.6 End Conditions 

An end condition is a special open-shaped component that targets a surface, a surface style, an 

elevation, or an alignment.  In other words, the end condition components are simply the 

fill/cut/ditch slopes or benching which tie back to ground. The integrity of end conditions can now 

be routinely tested while the roadway template is being created. 

5.5 Creating Basic Components 

5.5.1 Point Name List and Feature Definition 

Each point used for creating a component must be given a name and a Feature Definition 

associated with such.  CADD Support has created a point name list from which to select.  Point 

naming convention is extremely important in the creation of 

templates, so especial attention must be paid while creating 

individual components. 

5.5.2 Setting Display Options 

The dynamic settings need to be set prior to creating a component, 

end condition or template.  

Key-In 

Specifies the type of key in to be performed. 

 XY= key in absolute coordinates 

 DL= key in delta coordinates from last point placed (defaults to the dynamic origin if it is 

the first point of a component. 

 HS= key in horizontal delta distance and slope from last point placed. 

 VS= key in vertical delta distance and slope from last point placed. 

 OL= key in delta coordinates from dynamic origin. 

 OS= key in horizontal delta distance and slope from dynamic origin. 
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5.6 The Sign of the Distance and Slope 

 

When defining components with precision input, the sign of the distance is dependent on the 

parent-child relationship. The parent is always the first point placed when creating template 

components. The distance is positive if the parent has a lower X or Y value than the child. The 

distance is negative if the parent has a higher X or Y value than the child. The sign of the 

component slope is based on the mathematical slope. 

5.6.1 Adding Components  

Adding components is a simple process guided by dialog boxes, but point name and placement 

must be carefully thought of before starting the process.  The steps are as follow:  

1. Create the component structure in the library folder tree to the left. 

2. Activate and set and activate the setting display options. 

3. Right click on the current template window and select Add New Component. 

4. Select the type of component desired. 
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5. Populate the display setting options and current component dialog. 

 

6. Data point to the origin to start placing the component or type 0, 0 using the x, y key-in.  

7. Add points by using the precession key-in commands in the dynamic settings to finish the 

desired shape. For unconstrained and constrained components, once the shape has been 

drawn, right click and select Finish to complete. 

Once a component has been created, it can be modified visually by adding, deleting points or 

taking away/adding constraints.  In addition, the entire component can be deleted. 

 

Also, the component can be modified through the point properties dialog box.   
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Note: In order to modify a component, the user must modify the points making up the component. 

5.6.2 Point Properties Dialog  

To access the Point Properties dialog box, right click on the point to modify and select Edit 

Point. 

 

5.6.3 Basic Component Creation Workflow 

1. Open a template library 

2. Navigate to folder where component will be placed 

3. Right click on folder, and select Create Template 

4. Select and set dynamic settings 

5. Create components by using the point names in the point list 

6. Edit any points if necessary 

7. Save template library 
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5.7 Creating an Overlay/Stripping Component 

Creating an overlay/stripping component is similar to creating a basic component.  The only 

difference is that overlay/stripping components are a single line “closed” components and they 

have additional attributes to determine overlay/milling quantities.  Detail creation of an 

overlay/stripping component will be covered in the Overlay Tools chapter. 

5.8 Creation of Basic End Conditions 

End conditions are components of the template used to create cut and fill treatments.  These end 

condition components have a specific target such as, terrain models, elevations, horizontal and 

vertical alignments.  

5.8.1 Target Types 

Target types are defined only for end condition components, and are a property of that 

component.  An end condition solution can intercept multiple targets and target types.  For 

example when designing a special ditch, the sideslope condition “targets” the special ditch profile 

elevation, and then intercepts the original ground terrain model to form the ditch bottom and 

backslope. 

5.8.2 End Condition Settings 

End conditions will draw based on the targets and settings set.  These settings are considered 

specifically end condition properties 

and are enabled/disabled through the 

point property dialog box. The end 

condition settings are described 

below. 

Check for Intersection – when set, 

the line segment will search for the 

specified target. If not set, the line 

segment will be created at its full 

width regardless of whether it 

intersects the target, provided that 

one of the segments connected to 

this segment successfully intersects the target. 

Place Point at Interception – when set, a point will be placed at the location of the interception. 

If not set, the line segment will be created at its full width, provided that one of the segments 

connected to this segment successfully intersects the target. 

End Condition is Infinite – when set, the line segment will automatically be extended to 

intercept the target. If not set, the line segment will only extend to its maximum constraint to meet 

its target. This applies only to the last line segment in an end condition. 
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Do Not Construct - If set, the end point of the line segment will be used as a reference point to 

find a subsequent point. The point will be solved like any other end condition point, but that point 

will be skipped when drawing the final component segments. This is normally not set and is used 

only for more complex condition testing. 

5.8.3 Testing End Conditions 

Testing end conditions gives the user the ability to verify the solutions and priorities as well as 

testing multiple targets without using the Create Corridor tool. 

When creating end conditions, the user should test to see if desired results are generated.  This can 

be done before, during or after creation of the end condition.   

5.8.4 Basic End Conditions Creation Workflow 

1. Open a template library 

2. Navigate to the folder where templates will be stored 

3. Select create template 

4. Create a new template 

5. Create end condition components 

6. Test end conditions 

7. Save the template library 
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5.9 Group Exercise 3-1: Creating a Constrained Component - Curb 

1. Within the data_05\data folder, open the PlanJ2P0200.dgn.   

 

2. From the Corridor Modeling task group, select the Create Template icon. 

 

3. Select File > Save As from the Create Template dialog menus.  Save the workspace 

template library to J2P0200.itl in the Randolph\J2P0200\Data_05\ folder. 

4. Right click on the file path at the top of the dialog and create the following folder 

structure: 

J2P0200 > Components > Curb 

 

  

5. Within the Curb folder, create a new template named Curb. 

6. If the Dynamic Settings dialog is not displayed, select Tools > Dynamic Settings.  Set 

the step increment to 0.10. 

7. If not set, toggle ON the Display Point Names check box in Create Template dialog. 

8. Right-click on the Current Template window and select Add New Component > 

Constrained. 
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9. Setup the Current Component portion of the Create Template dialog as follows: 

 Component Name: CONCRETE CURB   

 Feature: XS_Curb_Surface 

10. Setup the Dynamic Settings dialog as follows: 

 Point Name: SHDR (key in) 

 Style: XS_Curb_Surface 

 Apply Affixes: Disabled 

 Precision Input: x, y = 0, 0 

 Press the Enter key 

Notes: 

 The default units for precision input are feet. You can enter other units with the proper 

specification, such as 6" instead of 0.5. 

 Watch the prompts in the lower left corner of the Create Template dialog. 

 When creating a component using precision key-in, an ESC allows you to go back. 
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11. Setup the Dynamic Settings dialog as follows: 

 Point Name: TOC (key in) 

 Style: XS_Curb_Surface 

 Apply Affixes: Disabled 

 Precision Input: xy = 0.07,0.5 (from similar triangles) 

 Press the Enter key 

12. Setup the Dynamic Settings dialog as follows: 

 Point Name: BOC (key in) 

 Style: XS_Curb_Surface 

 Apply Affixes: Disabled 

 Precision Input: hs = 5.5",0.0 

 Press the Enter key 

13. Setup the Dynamic Settings dialog as follows: 

 Point Name: BOC_BOT (key in) 

 Style: XS_Curb_Surface 

 Apply Affixes: Disabled 

 Precision Input: dl = 0.0,-16" 

 Press the Enter key 

14. Setup the Dynamic Settings dialog as follows: 

 Point Name: TOC_BOT (key in) 

 Style: XS_Curb_Surface 

 Apply Affixes: Disabled 

 Precision Input: dl = -7.75",0 

 Press the Enter key 

15. Right-click on the Current Template window and select Finish. 

16. Enable the Display Point Names option. 

17. Save the template library. 
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5.10 Group Exercise 3-2: Creating an End Condition 

1. From the Corridor Modeling task group, select the Create Template icon: 

 

1. Select File > Open from the Create Template dialog menus.  Open template library 

named J2P0200.itl from the J2P0200/Data folder. 

2. Navigate to the J2P0200 folder and create a new folder called End Conditions. 

 

 

 

 

 

 

 

 

 

 



Chapter 5 – Creating Templates  GEOPAK Road 1 
 
 

4/22/16 Missouri Department of Transportation 5-21  

3. Within the End Conditions folder create a new template called Slopes (6:1). 

 

4. To create the new slope component, right-click on the Edit Template Window and select 

Add New Component > End Condition. 

5. Setup the Current Component portion of the Create Template dialog as follows: 

Name:   Fill 

Feature:   XS_Ground_Proposed 

Target Type:  Terrain Model 

Priority:   1 

Terrain Model:  <Active> 
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6. For the first point setup the Dynamic Settings dialog as follows: 

Point Name: Fill_Slope_T (select from list) 

Point Style: XS_Ground_Proposed 

Apply Affixes:  Disabled 

Precision Input:  xy = 0,0 

 

7. With your cursor in the xy=0,0 field, press the Enter key on your keyboard. 

8. For the second point setup the Dynamic Settings dialog as follows: 

 

Check for Interception:   Enable 

Place Point at interception:  Enable 

End Condition is Infinite:   Enable 

Do Not Construct:   Disabled 

Point Name:    Fill_Slope_B (pull-down) 

Point Style:    XS Ground Proposed  

Apply Affixes:    Disabled 

Precision Input:   hs = 30,-1:6 

 

 

 

 

 

 

 

 

With your cursor in the hs = 30 -1:6 field, press the Enter key on your keyboard. 

9. Right-click on the Edit Template window and select Finish. 

10. Create Ditch End Components by right-clicking in the Current Template window and 

select Add New Component > End Condition. 

  



Chapter 5 – Creating Templates  GEOPAK Road 1 
 
 

4/22/16 Missouri Department of Transportation 5-23  

11. Setup the Current Component portion of the Create Template dialog as follows: 

Name:   Ditch 

Feature:   XS Ground Proposed 

Target Type:  Terrain Model 

Priority:   1 

Terrain Model: <Active> 

 

12. For the first point setup the Dynamic Settings dialog as follows: 

 

Point Name:  Ditch_Frslp_1_T (select from list) 

Point Style: XS_Ground_Proposed 

Apply Affixes:  Disabled 

Precision Input:  xy = 0,0 

  

With your cursor in the xy=0,0 field, press the Enter key on your keyboard. 
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13. To place the Fore-Slope bottom point, set the Dynamic Settings dialog as follows: 

 

Point Name:   Dtch_Frslp_1_B (select from list) 

Check for Interception:   Disabled (this forces this line segment to be placed) 

Place Point at Interception:  Disable 

End Condition is Infinite:   Disabled 

Do Not Construct:   Disabled  

Apply Affixes:    Disabled 

Precision Input:    hs = 24,-1:6 

 

 

 

 

 

 

 

 

 

With your cursor in the hs = 24,-1:6 field, 

 Press the Enter key 

 

14. To place the Back of Ditch bottom point, set the Dynamic Settings dialog as follows: 

Point Name:    Dtch_Bkslp_1_B (select from list) 

Check for Interception:   Disabled (This forces this line segment to be placed) 

Place Point at Interception:  Disable 

End Condition is Infinite:   Disabled 

Do Not Construct:   Disabled 

Apply Affixes:    Disabled 

Precision Input:    hs = 4,0 

 

 

 

 

 

 

 

 

 

With your cursor in the hs = 4,0 field, 

 Press the Enter key. 
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15. To place Slope-Stake point, set up the Dynamic Settings dialog as follows: 

 

Point Name:    Dtch_Bkslp_1_T (select from list) 

Check for Interception:   Enable 

Place Point at Interception:  Enable 

End Condition is Infinite:   Enable 

Do Not Construct:   Disabled 

Apply Affixes:    Disabled 

Precision Input:    hs = 5,25%  

 

 

Toggle on End Condition is Infinite 

 

 

 

 

 

 

With your cursor in the hs = 5,25.0%, 

press the Enter key. 

 

16. Right-click on the Edit Template window and select Finish. 

17. Select File > Save to save the template library. 

18. Test the End Conditions by selecting the Test button located under the Current Template 

window.  A warning will be given about the template having end condition priority 

conflicts. 

 

19. Select Check Priorities on the right side of the Test End Conditions window. 
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Notice the Fill_Slope_T point is the point that has the priority conflicts. 

 

20. In the End Condition Priorities dialog select Edit. 

Notice that all the end conditions have the same priority number. 

 

Put your cursor in each of the fields and notice the segments highlighting. 

Assume that fill is the most desirable condition and change the Priority of the Ditch (or 

Cut) to 2. 

 

21. Click OK, and then Close. 

22. Click Draw on the right side of the Test End Conditions window.  Move your cursor 

over the end conditions. 

23. Close the Test End Conditions dialog.  Save the Template Library by selecting File > 

Save.  

24. Close the Create Template dialog.   
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5.11 Individual Exercise 3-3: Creating an End Condition 

1. From the Corridor Modeling task group, select the Create Template icon: 

 

2. Select File > Open from the Create Template dialog menus.  Open the template library 

named J2P0200.itl from the J2P0200/Data folder. 

 

3. Navigate to the J2P0200 > End Conditions folder and create a new template called  

Fill (4:1) Cut (3:1) 
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4. Create Fill End Components by right-clicking on the Template Window and select Add 

New Component > End Condition. 

In this exercise the design criteria calls for a 4:1 Fill and 3:1 Ditch slope. 

Using the previous exercise create the following two end conditions.  Also test end conditions 

to make sure there are no conflicts. 
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5.12 Group Exercise 3-4: Creating a Template 

1. From the Corridor Modeling task group, select the Create Template icon: 

 

2. Select File > Open from the Create Template dialog menus.  Open the template library 

named J2P0200.itl from the J2P0200/Data_05 folder. 

3. Navigate to the J2P0200 folder and create a new folder called Road1. 

 

Note:  In this exercise the User will create a template similar to the Two Lane Rural 

typical listed on the following page. 
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4. Within the Road1 folder, create a new template called Road1 Two Lane Rural by right 

clicking on the Road1 folder and selecting New > Template. 

  

5. Set the following Dynamic Settings: 
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6. In Create Template go to Tools > Options and confirm the following Affixes are set: 

 

7. In Create Template select the Components > Pavement - New > Pavement Only > 

Asphalt > Asphalt Pavement component.  

When placing the component, right click and select Mirror then place the component at 

the 0,0 coordinate. 

  

 

8. Select the Components > Shoulders > Aggregate and Rock Fill Bases > Aggregate 

Base component. 
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9. Place the shoulder component at the RT_AsphSurf_T_EOP location. 

 

   

10. Modify the two lower inner shoulder point constraints to follow the pavement wedge 

slope.  

  

11. Double click on the point RT_AggBase_B_EOP. This will bring up the Points 

Properties dialog where you can edit the detail of the point. 
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12. In the Point Properties dialog, adjust the constraint that controls the Horizontal Control 

to a Vector-Offset.  Set the Parent points to be the top and bottom pavement points (See 

below), also set vector offset Value: to 0.0.  Modify both shoulder points. 
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13. Merge Pavement Components. 

   

14. In the Create Template dialog, select the End Conditions > Ditches > Ditch 1 end 

condition, and then place the ditch component at the RT_AggBase_T_EOS location. 

   

15. Next, select the End Conditions > Fill Slopes > Fill Slope Combined component then 

place this fill component at the RT_AggBase_T_EOS location. 
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a. In Create Template select the Test button to view the End Condition Priorities. 

 

b. Save Template Library. 
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5.13 Individual Exercise 3-5: Creating a Template 

1. From the Corridor Modeling task group, select the Create Template icon: 

 

2. Select File > Open from the Create Template dialog menus.  Open the template library 

named J2P0200.itl from the J2P0200/Data_05 folder. 
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3. Navigate to the J2P0200 > Road1 folder and create a new template called Road1 Two-

Lane Urban by right-clicking on the Road1 folder. 

  

4. Set the following Dynamic Settings: 

 

 

 

 

 

 

 

5. In Create Template go to Tools > Options and confirm the following Affixes are set: 
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6. In Create Template use the following components to create the Road1 Two-Lane 

Urban template: 

 

Components: 
 

Left Side      Right Side 

 

Concrete Pavement w/ Agg Base   Concrete Pavement w/ Agg Base  

Curb and Gutter Type B w/ Agg Base  Curb and Gutter Type B w/ Agg Base 

Sidewalk w/ Outer Buffer    Berm (1%)  (Sloping down away from gutter) 

 

End Conditions: 

 

Left Side      Right Side 

 

Fill Slope Combined    Fill Slope Combined 

Ditch 1      Ditch 1 

 

*Notes 
 

a) Concrete Pavement w/ Agg Base is located in the following location: 

Components > Pavement New > Pavement Only > Concrete 

b) Merge the vertical line between common components. 

c) Make the concrete thickness 9-3/4” (-0.8125’) before adding Curb and Gutter Type B 

w/ Agg Base.  If you already place the Curb and Gutter select “Undo”. 

d) Check Priorities on End Conditions 

e) Save Template Library 
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6.1 Objectives 

 Create Corridor 

 Assign Multiple templates to one corridor 

 Create new templates from  existing templates  

6.2 Corridor Modeling Overview 

The Corridor Modeling toolset is a group of highly interactive commands to create new design 

surfaces that represent a new roadway or other type of surface. Tools for creation, modification, 

management, and report functions are supported. 

Corridor Modeling tools aggregate a variety of civil data. The geometry is created with the 

Horizontal and Vertical Geometry tools, while the existing ground is defined by a MicroStation 

mesh or Civil Terrain Model. Plan view elements, such as edges of pavement, shoulders, curbs, 

etc. can be 2D or 3D. Superelevation information is defined within a design file using standards 

or imported data. Templates are utilized from one or more template libraries. 

Reference files can be used extensively with Corridor Modeling. On a simple project, the data 

may be all in one file; larger projects may have geometry in one file, plan view graphics in a 

second, terrain in another, superelevation in a fourth and the actual model in a fifth. All files can 

reference the others, to present a complete picture of the project. 

When working with Corridor Modeling, you can draw in 2D or 3D. When using 2D (such as for 

plan-view graphics), a 3D view is automatically created and maintained. For example, when a 

vertical geometry element is initially defined for a horizontal geometry element, the Default-3D 

model is created, if there isn’t one already. The 3D baseline (combination of horizontal and 

vertical element) is drawn into the 3D model. As template drops are added, and progressed, they 

are added to the 3D model automatically. 

When starting to create a corridor, basic information can be used. A single template can be used, 

along with preliminary geometry and a high level terrain model. As the design progresses, more 

detail can be added.  Instead of a single template drop, perhaps more templates better define the 

roadway. Transitions can be added to smoothly move from one template to another. There may 

be multiple roadways all interconnected using the target aliasing tools. All the while, as changes 

are made, the corridor model is updating, so you see up-to-the minute results. Simple projects 

may not require all the tools, and a basic corridor model may be sufficient. But all the tools are 

available to handle basic to complex, small-scale to large-scale projects. 
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6.3 Prerequisites 

The following are minimum requirements to use Corridor Modeling. 

 One Civil horizontal element and one Civil vertical element, generally the centerline and 

profile of the design roadway 

 One template stored in a template library 

A terrain model is not required for corridor modeling. If the template includes end conditions 

and no terrain model is defined, the software generates as much of the model as possible, but 

will not complete the end condition that ties to ground and no error message is given. 

6.4 Corridor Modeling Tools 

 

6.4.1 Corridor Creation Tasks 

The first toolbox is used when beginning design on a corridor and includes tools for creating 

corridors, template drops, and transitions; along with various tools for working with the 

template library. 

 

 Create Corridor - The Create Corridor tool is the initial step in corridor design; names the 

corridor and identifies the geometry.  No processing of templates is done within this tool; rather 

it’s a set-up step prior to template work. 

A closed shape is drawn to represent the corridor (using the full length of the civil geometry 

element). Station ranges to better define the corridor are utilized in the next step, template drops. 

When hovering over a corridor, two pop-up displays are visible: 
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 Quick Properties - displays the corridor name, horizontal geometry element (Plan), 

vertical geometry element (Profile), and Level of the corridor 

 Context sensitive menu with tools applicable to corridors 

After the corridor is created/drawn, the software automatically advances to the Create Template 

Drop tool. 

 Create Template Drop - defines what the cross sections of the roadway look like for that 

portion of the road based on user-defined station range. A project may comprise of a single 

template drop or multiple template drops. Often, transitions are used between two template drops, 

rather than an abrupt change from one template to another. 

Careful consideration should be given for the Drop Interval used for a corridor, although it can be 

changed at any time. It specifies the distance between each processing of the template (in master 

units). Generally, this value is equal to or less than (but still a multiple) of the desired interval for 

the final cross sections, since cross section stations should be coincident with processing stations. 

It is not necessary to set the interval so small that it encompasses all desired cross section stations, 

as stations with particular project interest can be added to the model with the use of the Key 

Station tool. If the model is to be used in construction, the smaller the interval, the more detailed 

the model, but will require more processing time. 

Note Drop Intervals are impacted by the Design Stages. 

 Minimum Transition Before Drop and Minimum Transition After Drop are inputs in the 

Create Template Drop tool. If they are non-zero, then a transition drop is created at the 

beginning/end of the template drop with a length greater than or equal to the value 

entered. The actual length is determined by how far it is between the new drop and the 

drop before/after the new drop. If there isn’t enough space to meet the minimum, then the 

previous/next drop is shortened to accommodate the transition. If there is no 

previous/next drop, then no transition drop is created. 
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After completing the prompts, the corridor is automatically processed and can be viewed in both 

2D and 3D views. The corridor can be rendered, if desired. 

 

The symbology is based on the feature definitions within the template. The Project Explorer is 

also updated with the corridor information, including template drops, components and features. 

Create Template Drop Workflow 

Select the Create Template Drop tool. This tool is automatically invoked at the end of the Create 

Corridor tool, but you can use it independently of the Create Corridor tool. 

Select the Corridor wherein the template drop will be added. 

1. Select Template - Select the template from the pull-down list of recently used templates, 

or select <Alt> <Down> on the keyboard to open the active template library and select 

the template. Data point to accept the template and move to the next prompt. 

2. Start Station - Graphically define the start station or enter the value in the edit field.  

Data point to accept and move to the next prompt. The Start station can be locked by 

<Enter> after keying in the station or selecting <Alt>.  Selecting <Alt> again unlocks 

the field. 

3. End Station - Graphically define the end station or enter the value in the edit field. Data 

point to accept and move to the next prompt. The End station can be locked by <Enter> 

after keying in the station or selecting <Alt>. The template is copied to the new station 

range. Selecting <Alt> again unlocks the field.  

4. Drop Interval - specifies the distance between each processing of the template (in master 

units). Generally, this value is equal to or less than (but still a multiple) of the desired 
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interval for the final cross sections, since cross section stations should be coincident with 

processing stations. Note that this is impacted by the Design Stages. 

 

 

 Create Transition - A transition is created between templates of different names, as 

templates generally don’t instantaneously change from one template to another. This tool creates 

the transition by selecting the two templates drops which are adjacent to it. It does not define how 

to transition between the template drops, which is done in the Edit Transition tool. 

If the drop interval is not the same in the two template drops, the drop interval of the lower 

stationed template drop is utilized. However, this can be changed in the Transition Properties. 

Create Transition Workflow 

1. Select the Create Transition tool. 

2. Select the first template drop adjacent to the transition. It does not matter the order in 

which the two template drops are selected. 

3. Select the second template drop adjacent to the transition. The transition is created (and 

the corridor has automatically processed).  

 

 

 

 

 Edit Transition - Modifies the previously created transition between two template drops. 

Edit Transition Workflow 

Editing a transition is a two-step process. 

1. Connect the backbone points of the first template to the backbone points of the second 

template, as desired. Unconnected points are shown as thick (+) symbols; connected 

points are thin (+) symbols. End conditions are not shown. End condition transitions are 

handled through end condition exceptions. 

2. Edit the transition components. 

The color of the transition indicates the state of the transition. 

 Red - indicates that none of the backbone points of the first template connect to the 

backbone points of the second template. 

 Yellow - indicates that some of the backbone points are connected (initially this is done 

attaching points that have the same name. 

 Light Blue - indicates that not all of the points are connected, but you have reviewed 

and/or edited the transition at least once. 
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 Dark Blue - indicates that all of the points on both templates are connected. 

 Copy Template Drop - As an alternate to creating and modifying a template drop, this tool 

copies an existing template drop to a newly defined station range along the same baseline 

reference. 

The Copy Template Drop tool can be used as an alternate to creating and modifying a template 

drop, as the tool copies an existing template drop to a newly defined station range along the same 

baseline reference within the same corridor. 

Copy Template Workflow 

1. Select the Copy Template Drop tool. 

2. Locate Template Drop - Select the previously created template that you want to copy to 

a different location. 

3. Start Station - Graphically define the start station or enter the value in the edit field. 

Data point to accept and move to the next prompt. The Start station can be locked by 

<Enter> after keying in the station or selecting <Alt>. Selecting <Alt> again unlocks the 

field. 

4. End Station - Graphically define the end station or enter the value in the edit field. Data 

point to accept and move to the next prompt. The End station can be locked by <Enter> 

after keying in the station or selecting <Alt>. The template is copied to the new station 

range. Selecting <Alt> again unlocks the field. 

 Create Template - Opens the current template library to add a new template, delete or 

modify an existing template.   

 Display Template - Draws the selected template from the current template library at the 

user-defined data point in the drawing file using the active MicroStation symbology. All end 

conditions are drawn and there is no annotation. The drawing is useful as a starting point for 

documentation of the template library. 

6.4.2  Corridor Modification Tasks 

This toolbox contains tools for manipulation of a previously created corridor and associated 

template drops. These tools enable you to refine the model by adding more detailed information to 

respond to project-specific requirements and constraints. 

 

 Edit Template Drop - Opens the current template library and displays the template with the 

selected template drop.  While the dialog is the template library interface, keep in mind that the 

editing is only being done to the template within the template drop, not the actual template library. 

Therefore, if any changes are made, the template associated with the template drop is no longer in 
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sync with the template library. For project specific circumstances, this may be required. The tools 

and options within the edit template drop function identically to those in the template library, 

except the File tools are not available. 

If the changes are needed in the template library, use the Create Template tool. 

To update the template associated with the template drop to match the template in the template 

library, use the Synchronize with Library tool. When this tool is used, the template from the 

template library overwrites the template associated with the template drop, so all changes are lost 

with no warning given. 

Edit Template Drop Workflow 

1. Select the Edit Template Drop tool. 

2. Locate the Template Drop. Select the template drop whose template needs editing. The 

Editing Roadway Design Template Drop dialog (whose interface is identical to the 

Template Library dialog) opens with the current template. 

3. Edit as needed. Click OK to close the dialog. You do not have to File > Save to save your 

edits (most File functions are ghosted out). 

 Create Point Control These are used to override the normal locations of one or more points 

and or components in a cross section.  Examples of this include lane widening, staying within the 

right-of-way, maintaining a particular slope for a ditch, and superelevation. 

An example would be a ramp is merging into the main road. The ramps left edge is vertically 

controlled by the main road right edge of pavement. The ramps left edge is horizontally controlled 

by the main road right edge from 0+00 to 1+00, and then it is controlled by a horizontal alignment 

named rampLeft. 

Station Limits (Start/Stop) - specifies the start and stop stations for the control. 

Control Description - allows you to enter a description of the control. 

Point - allows you to select the point to be controlled. Select from the list or identify the point 

in the cross-section using the locate button. The selected point is highlighted in plan/cross 

section and profile or superelevation views as applicable. 

Mode - allows you to select the control mode: Horizontal, Vertical, or Both. 

Control Type - specifies the type of control. 

If the Mode is Horizontal or Both, valid control types are Linear Geometry, Feature 

Definition, or Corridor Feature. 

If the Mode is Vertical, valid control types are Linear Geometry, Feature Definition, 

Corridor Feature, Superelevation, Elevation Difference, Elevation and Grade. 

The selection combo boxes and/or field displayed depends on the selected Mode and 

Control Type. 
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Type - Linear Geometry If the type is Linear Geometry, a Horizontal Offsets combo box 

is displayed. If the mode is Both, a Vertical Offsets combo box is also displayed. 

Type - Feature Definition If the type is Feature Definition, a Feature Definition and 

Range text field is displayed. 

Type - Corridor Point For all modes, Corridor and Reference Feature combo boxes are 

displayed. These options allow you to set up the control of one corridor’s points(s) from 

another corridor’s point(s). 

Targeting another corridor's point cannot be done simultaneously with Target Aliasing of 

that same corridor. If Target Aliasing has been defined, the Corridor Point is not available 

for selection within the Point Control dialog. This produces a recursive situation, making 

the corridor point control unavailable for selection until that Target Aliasing is removed. 

Type – Superelevation This option displays a Superelevation control line combo box, and 

a Reference Point combo box. Superelevation control lines are stored in the roadway 

design, not on the alignment. The reference point is the pivot point (feature) about which 

the point will rotate. 

Type - Elevation Difference This option displays Horizontal and Vertical alignment 

combo boxes. The vertical alignment represents a vertical difference value to be applied to 

the points’ current elevation. 

Type - Elevation and Grade This option displays an Elevation field, and a Grade field. 

The control sets elevation of the point at the start station to the elevation specified. The 

slope of the point’s line is then at the grade specified until the end station is reached. 

Priority - determines the order of controls on a point. This value applies only when there are 

conflicting controls on a point. Where there is a conflict, the control with the lower priority is 

applied (that is, lower numbers are applied first). 

Use as Secondary Alignment - specifies that horizontal point controls are also used as 

secondary alignments. This option is available only when working with a 2D entity. If you are 

using a 3D object, the software skips the secondary alignment option. 

Horizontal Offsets (Start/Stop) - specifies the start and stop horizontal offset controls for the 

corridor. If the values are different, then the value applied at a given station is calculated using 

a linear algorithm. 

Vertical Offsets (Start/Stop) - specifies the start and stop vertical offset controls for the 

corridor. 

 Create Key Station - The Create Key Station tool is useful to add stations that are not 

coincident with the template interval, when a special circumstance of the project occurs and it’s 

desirable to include the station in processing. 

Create Key Station Workflow 

1. Select the Create Key Station tool. 
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2. Locate Corridor - Select the corridor for station addition. A display line dynamically 

running perpendicular to the baseline reference is visible. 

3. Station - Define the key station by dynamically moving the display to the desired 

location (and data point) or by keying in the station, <Enter> and data point to accept. 

The key station is added to the Key Station list, and the corridor is automatically 

reprocessed to include the new station. 

 Create Secondary Alignment - Sets parameters for secondary alignments, which are used 

to modify the direction of cross section processing. Requirements include corridor selection, 

secondary alignment definition, beginning and ending station (in cases where only part of the 

alignment element is to be used) and beginning and ending offsets. 

 Create Parametric Constraints - Sets up constraint value overrides for specified station 

ranges. 

 Create Curve Widening - Applies horizontal controls to points to move them farther from 

the centerline at each curve of the controlling alignment. 

 Create End Condition Exception - Defines end condition exceptions, which are used to 

modify the behavior of an end condition solution without requiring the use of additional template 

drops. 

 Corridor Objects - One-stop viewing of data relating to corridor objects. Excellent for 

managing your corridor data, as it encompasses template drops, key stations, parametric 

constraints, point controls, various references and end condition exceptions all within one dialog. 

 Process Corridor - Processes the corridor to ensure that it is up to date. 

6.4.3 Superelevation Tasks 

This toolbox contains tools for creating, calculating, and editing superelevation lanes. Tools are 

also supported for importing excel (CSV) data and reporting. 

 

 Create Superelevation Sections - Adds a superelevation sections (generally one per curve 

set) for the specified station range on the baseline reference. 

 Create Superelevation Lanes - Creates color-filled lanes based on width and offsets from 

the baseline reference, as a precursor to superelevation calculations. 



 Chapter 6 – Corridor Modeling Overview  GEOPAK Road 1 
 
 

6-10 Missouri Department of Transportation 6/13/16 

 Calculate Superelevation - Calculates station and superelevation transitions rates based on 

a preferences or rules file (*.sep,*.srl).  The values are augmented to the superelevation lanes, 

edit manipulators are created, and the color fill is recolored based on the cross slopes. 

 Import Superelevation - Optionally, imports data from a CSV file. 

 Assign Superelevation to Corridor - Associates superelevation with a corridor, so the 

pavement reflects the superelevation stations / cross slopes, rather than the pavement cross slope 

defaults in the template. 

 Insert Superelevation Station/Cross slope - Insert an individual station / superelevation 

transition (cross-slope) into a previously created and calculated superelevation lane. 

 Superelevation Editor - Opens the superelevation editor allowing the user to edit the 

calculated superelevation in a tabular format. 

 Superelevation Report - Creates a superelevation XML report and opens the Bentley Civil 

Report Browser. 

 Superelevation in Plan - Automatically generates annotation for superelevation station 

information in plan view. 

6.4.4 Corridor Cross-Sections Tasks 

This toolbox contains tools to display, draw, and annotate cross sections. 

 

 Open CrossSection View - Using the specified baseline reference to a corridor, or any Civil 

horizontal geometry, creates a dynamic cross section view in the user-selected MicroStation view. 

The corridor interval is used for the cross section interval. The specialized view has exaggeration 

feature, cross section scrolling, and ability to place temporary dimension lines. These sections are 

not used as a basis for drawn cross sections or sheets. 

 Create Cross Sections - Extracts multiple cross sections and draws them in a matrix pattern. 

These sections are subsequently used for cross section sheets and earthwork calculations.  The 

display configuration and layout is controlled by an .xin file.  This is covered in detail in 

Chapter_09 Cross Sections and Labeling. 

 Annotate Cross Sections - Placed with the Create Cross Sections tool. 
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 End Area Volume - Calculates the end-area volumes to compute cut, fill, and net volumes 

using a series of cross sections extracted along a previously defined alignment. 

 Edit Station - Allows the user to edit the cross section instance at a station. 

 Show Place Dimension - Places display text (width, slope) into the dynamic cross section 

view, based on two data points. Multiple show place dimension elements can be placed in a single 

cross section view. 

 Remove Temporary Dimension - Removes dimensions in the dynamic cross section view 

that were placed with the Show Place Dimension tool. 

 Locate Station Via Datapoint - Places a data point (in plan view) with this tool to view a 

dynamic cross section at a station not included on the list. 

 Cross Section Viewer - Windows in on specified cross sections in a model. Using Cross 

Section Viewer, you can view a single cross section, or you can view in succession each cross 

section in a model. 

6.4.5 Corridor Miscellaneous Tasks 

 

 Define Target Aliasing - Aliasing allows you to target other corridor surfaces or features or 

to set up a prioritized target list for end condition solutions on surfaces, features and alignments. 

This means that on a large job where the existing surface may have been broken up into more than 

one surface, you don’t need to be concerned about where those breaks occur, and you don’t need 

to create a different template for each existing surface. Use target aliasing to find the proper 

solution. 

In any situation where the active surface is the target, the software looks for the mainline corridor 

surface and uses whichever is closer because you have turned on that option. If the Use Closest 

option is not set, then it would search for the surfaces in the order they are displayed, and it would 

stop as soon as a solution was found. 

Target Aliasing cannot be defined with a corridor that targets that particular corridor with a 

Corridor Point Control. This produces a recursive situation, making the corridor unavailable for 

Target Aliasing until that corridor point control is removed. 

Target lists end-condition targets for the current corridor. 

does not list feature definition targets. 
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Surface or Corridor lists all the available aliases for the current target. If the target is a 

surface, it displays a list of alternate surfaces and corridors. If the target 

is a feature, then the list displays available surface features and corridor 

points. If the target is an alignment, it displays a list of available 

alignments. 

Aliases lists the aliases for the current target. The order of the list indicates the 

priority of the target aliases. 

Add, Remove, Move 

Up, Move Down 

activates as items are selected. The left and right buttons allow you to 

move items between lists. More than one item can be selected and 

moved. The up and down buttons allow you to change the priority of a 

single item in the alias list by moving up or down in the list. 

Use Closest Ignores the order of the aliases, when checked on. The solution seeks 

the closest alias that satisfies the solution (end condition). 

Define Target Aliasing Target Workflow 

1. Select the Define Target Aliasing tool. 

2. Select the corridor. This opens the Target Aliasing dialog. 

3. Use the Add, Remove, Move Up, Move Down, and Use Closest to set the Target Aliasing. 

 Synchronize Template - Updates a template within a template drop with the template of the 

same name from the current template library. Any changes previously made to the template in the 

template drop are overwritten with no warning. 

 Add Corridor Reference - The Add Corridor Reference tool adds graphical elements to the 

corridor processing. This must be done even if the feature is targeted in the template, otherwise 

the elements will not process. It enables only those elements associated with a particular corridor 

to be processed, rather than all elements of a particular feature definition. This speeds up 

processing, and eliminates processing of unwanted elements of the same feature definition. The 

elements can be selected within the tool, or a selection set can be created prior to commencing the 

tool. 

Add Corridor Reference Workflow 

1. Select the Add Corridor Reference tool. 

2. Select the Corridor. 

3. Select the First Reference Element - select the graphical element to be added as a 

reference. Continue selecting until all elements are referenced, then reset to exit tool. 
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 Remove Corridor Reference - The Remove Corridor Reference tool removes graphical 

elements from the corridor processing, but does not delete the element. The elements can be 

selected within the tool, or a selection set can be created prior to commencing the tool. 

Remove Corridor Reference Workflow 

1. Select the Remove Corridor Reference tool. 

2. Select the Corridor. 

3. Select the First Reference Element - select the graphical element to be removed as a 

reference. Continue selecting until all elements are referenced, then reset to exit tool. 

 Add Clipping Reference - allows you to remove areas of overlap when working with 

multiple corridors in a single surface. For example, in a corridor intersected by a crossing 

roadway, clipping would be used to remove all overlapped features within the intersection. 

Add Clipping Reference Workflow 

1. Select the Add Clipping Reference tool. 

2. Select the corridor to be clipped. 

3. Locate Clipping Reference - select elements until all are defined, then reset to complete. 

The corridor is processed and the clipping reference is added. 

 Remove Clipping Reference - Removes the clipping reference, reprocesses the corridor, 

restoring the clipping area to its previous state prior to clipping. 

Remove Clipping Reference Workflow 

1. Select the Add Clipping Reference tool. 

2. Select the Corridor where the clipping is to be removed. 

3. Locate Clipping Reference - select elements until all are defined, then reset to complete. 

The corridor is processed and the clipping reference is removed. 

 Overlay Vertical Adjustment - At each processed station, this command determines the 

ideal PGL point based on the input criteria and the distance from the top of the template to the 

existing ground. Each existing ground vertex in the cross section will be tested by measuring the 

vertical distance between that ground point and the top of the template. 

Geometry and corridor must be in the same DGN file for this command to operate. 

This command is not available when the geometry is in a reference file because the command 

creates a vertical alignment and the corridor must reprocess to determine criteria for the vertical 

alignment. 

 Import IRD - Imports (SELECTseries 2) and prior versions of corridors contained in 

Roadway Designer (IRD) files. 
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Import IRD Workflow 

Recommendations and limitations: 

1. Select the IRD file that contains the corridors to import. 

2. Select the corridor to import and data point to accept. 

3. If the selected corridor contains no missing dependencies, the corridor is imported. 

Otherwise, a Missing Corridor Dependencies report displays. 

4. If the Missing Corridor Dependencies report displays, select No to cancel the import or 

select Yes to continue the import process. Note: The report can be saved to a text file for 

later reference. 

5. If the import is canceled, resolve missing dependencies and then re-import the corridor. 
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Missing Dependencies 

If a corridor is selected to be imported and it contains corridor objects with missing dependencies, 

a missing dependencies report displays before the corridor is imported into the design file. The 

report dialog allows the import to be continued or canceled by selecting Yes or No. This allows 

missing dependencies to be resolved before a corridor is imported. 

A corridor may contain one or more corridor objects. Corridor objects include template drops, 

secondary alignments, key stations, parametric constraints, point controls, end condition 

exceptions and target aliases. Some of these object types depend on other entities in the design 

model. They include secondary alignments, point controls, and target aliases. If one of these 

objects depends on an entity that does not exist in the design model, its dependency is missing. 

Example, a secondary alignment object depends on a horizontal alignment. If a corridor is 

imported that contains a secondary alignment whose horizontal alignment is "Side Street 1", the 

horizontal geometry named "Side Street 1" must exist in the design model. If it does not, that 

secondary alignment is missing its dependency and cannot be imported. To resolve the missing 

dependency the alignment "Side Street 1" could be imported using the Import Geometry 

command or one of the horizontal geometry commands could be used to create "Side Street 1". 

Corridor object dependencies are always matched by name. They are not matched by GUID or 

object ids. Example: If a point control is a corridor feature point control, the corridor and the 

corridor feature must exist in the design model in order to import the point control. There must be 

a corridor in the design model whose name matches the corridor name stored in the point control, 

and that corridor must contain a feature whose name matches the feature name stored in the point 

control. 

Recommendations and Limitations 

 It is recommended that best practice rules for creating corridors be followed when 

importing corridors. 

 Only one corridor at a time can be imported using Import IRD. 

 In order to import a corridor, its baseline horizontal and profile geometry must exist in 

the design file or an attached reference file. 

 When a corridor is imported its end conditions will always target the active terrain model, 

but corridors may be imported without an active Terrain Model. In that case, end 

conditions will target nothing. 

 When importing corridors that contain secondary alignments, the ALG that contains the 

secondary alignment geometry must reside in the same directory as the IRD. This is 

because the secondary alignment geometry is a dependency that must exist in the design 

model and the dependency match is made by the name of the geometry. The ALG file 

must be accessed to look up the name of the geometry. 

 In order to import a Target Alias at least one of its dependencies must exist in the design 

model. Missing aliases will not be imported. Example, if a target aliases a terrain model 

and a corridor, but only the corridor exists in the design model. The target will be 

imported and the corridor alias will be imported, but not the terrain model alias. If neither 

the terrain model nor the corridor exists then neither the target nor any aliases will be 

imported. 



 Chapter 6 – Corridor Modeling Overview  GEOPAK Road 1 
 
 

6-16 Missouri Department of Transportation 6/13/16 

Managing Corridor Data 

Several tools can be used to help manage the corridor model data. Depending on the tool 

selected, the data may be read-only or may be manipulated. These include: 

Element Info 

 Properties 

 Corridor Objects - view and manage all the input objects in the corridor in one location 

 Project Explorer - see all corridor information in one place 

 Design Stages 

Element Info 

Clicking on the corridor border opens the Element Information with most of the same 

information found in the Project Explorer Corridor. It includes the corridor tree, symbology, 

Corridor Info (Name, Alignment Name, Profile Name, and Design Stage). 

 

The dialog changes as the tree is navigated, based on the current highlighted item in the tree. 

Much of the information can be edited, which is automatically reflected in the corridor model. 

 



GEOPAK Road 1 Chapter 6 – Corridor Modeling Overview 
 
 

6/13/16 Missouri Department of Transportation 6-17 

If a Template Drop is selected, the Element Information dialog reflects the template drop 

information, which can be edited. 
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Properties - is similar to Element Information, as the displayed data reflects the type of element 

selected. For example, the data displayed when a corridor is selected is different than when a 

template drop is selected. 

The Properties tool is accessed via the context sensitive menus. When a corridor is selected, the 

display shows names and design stages. 

Corridor Objects - Allows you to view and manage all the input objects in the corridor in 

one location. 

Project Explorer 

The Project Explorer located in Tools>Project Navigation>Links>Project Explorer is another 

location where corridor model data is organized and displayed. As the design progresses, the 

information is continually created / updated automatically. The information is located under the 

Civil Model tab. 
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Each corridor (and associated data) is listed separately. As the tree is navigated, additional data is 

exposed. In addition, right-click context sensitive menus are available for common tasks and 

information. 
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Project Settings  

Project Settings can be located under the Civil Standards tab in the Project Explorer. 

Template Management 

 

The Template Drop Interval Multiplier can be accessed by opening the Element Information 

tool, and expanding Project Settings in the Project Explorer window, then expand the 

Corridor Design Stages and selecting the stage to show Template Management.  

 

The Template Drop Interval Multiplier is used in conjunction with the Interval Drop specified 

when the template drop was created. Its purpose is to enable designers to use larger intervals for 

preliminary work and easily shorten the interval as the design is refined. To determine the 

interval used for processing, the Interval Drop is multiplied by the Template Drop Interval 

Multiplier and the result is used.  

MoDOT uses the following multipliers: 

 

Stage Multiplier Resultant Processing 

Interval 

Description 

Preliminary 40 200 As corridor is determined, 

areas of impacts and issues 

can be reviewed. 

Design 20 100 Used for general design work, 

until high level of accuracy is 

required towards the end of 

the project. 

Final 5 25 Used for cross section sheets 

with 25 or 50 feet between 

sections. 
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Include Critical Sections 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

Option Description 

Horizontal Cardinal Points When set to True, the location of cardinal points of the 

active horizontal alignment (PC, PT, CS, etc.) are used 
to compute a point or template drop interval location. 

Vertical Cardinal Points When set to True, the location of cardinal points 
of the active vertical alignment (VPC, VPT, VPI, etc.) 
are used to compute a point or template drop interval 

location. 

External Control Points When set to True, the location of horizontal and/or 
vertical point controls are used compute a point or 
template drop interval location. 

Densify Horizontal Curves When set to true, the processing along horizontal curves 
is at a closer interval. This option utilizes the 

CIVIL_DEFAULT_CURVE_STROKING configuration 
variable value, with extra points being computed based 
on the chord offset from the horizontal curve. The value 
defines the chord height used to calculate the extra 
points. If configuration variable is not set or Densify 

Horizontal Curves is set to False, the value defaults to 
0.01. 
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Display Settings 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

Option Description 

Corridor - Element Template Element template utilized to draw the corridor 
boundary in the Create Corridor tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 
on as needed. 

Corridor Handle Length Factor 

Template Drop Handle Length 

Factor Single Station Handle 

Length Factor 

Transition Handle Length Factor 

The Length Factors are a ratio of the handle length to 
the width of the corridor.  So 1.0 would make the 

handle as long as the width of the corridor at that point. 

Corridor Handle Spacing The handle spacing either is set to a physical distance as 
shown or set to zero. If you set to zero you will get 11 
handles per corridor regardless of its length.  Any non-
zero value is used as a distance between handles 

measured in master units along the horizontal 
alignment. 

Template Drop Element Template Element template utilized to draw the template drop 
boundary in the Create Template Drop tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 

on as needed. 

Transition Element Template Element template utilized to draw the transition 
boundary in the Create Transition tool.  As a best 
practice, place the graphics for the boundaries in a 
construction class to allow for easily turning them off / 

on as needed. 
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Output Settings 

This information is also located in the Element Information tool when the Corridor Design Stage 

is selected in the Project Settings of Project Explorer. 

 

For all options, when set to False, no elements, features, or meshes are drawn. 

Option Description 

Create Top Mesh 

Top Mesh Feature Definition 

When set to True, a mesh is created for each component in the 
corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled OFF.  The mesh is drawn using the specified 
Feature Definition. 

 

 

If Create Top Mesh is set to False, no Top Mesh Feature Definition 
can be selected. 

Create Bottom Mesh 

Bottom Mesh Feature Definition 

When set to True, a mesh is created for each component in the 

corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled OFF.  The mesh is drawn using the specified 
Feature Definition.  If Create Bottom Mesh is set to False, no Bottom 
Mesh Feature Definition can be selected. 
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Create Linear Features 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When set to True, 3D linear features are drawn based on Feature 
Definitions.  First, review the Point Properties within the template: 

 

 

Then review the corresponding Feature Definition. 

 

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 

 

 
 

 

 

Then review the corresponding Feature Definition. 

 

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 
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Create Linear Features Continued  

 

If the Create Template Geometry setting is set to True, then the linear 
feature is drawn, based on the 3D settings. 

 

 

Create Component Meshes When set to True, a mesh is created for each component in the 
corridor (based on its template) which has Exclude From Top / 
Bottom Mesh toggled On.  The mesh is drawn using the specified 
Feature Definition in the Component Properties. 

 

 

Include Null Point Linear Features When set to True, linear features for null points are drawn, basis on the 
same criteria as Create Linear Features. 
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6.5 Group Exercise: Creating a Corridor – Road1 

Setting up the Design files 

1. Within the J2P0200\data_06 folder, open the file: Plan_J2P0200.dgn 

2. Create a new file named Corridors_J2P0200.dgn based on the 2D seed file 

pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn.  

This new file will hold the proposed corridor.   

3. Reference in the following files: 

Terrain_J2P0200_Existing.dgn 

Civil_Geometry_J2P0200.dgn. 

 

4. Data point on the perimeter of the Terrain Model and select the Set As Active Terrain 

Model icon form the pop up menu. 

 

Setting up the project template Library 

5. From Corridor Modeling task group of the Civil Tools task menu, select Create 

Template.    Or press the <F8> key to open the Create Template dialog. 

6. Select file open and navigate to the the project diretory and open the project template 

library: J2P0200.itl. 

7. Expand the Concrete Pavement w/ Shoulders folder in the Templates folder. 

8. Within this folder expand the A2 Shoulders Agg Base folder. 

9. Right click on the Concrete Pavement 2 Lane w/ Agg Base Option 3 template and 

select Copy. 

10. Expand the J2P0200 folder and right click on the Road1 folder then select Paste. 

11. Expand the Concrete Pavement w/ C&G folder. 

12. Right click on 2 Lanes Type A C&G w/ Agg Base and select Copy. 

13. Expand the J2P0200 folder and right click on the Road1 folder and select Paste. 

14. Once the 2 Lanes Type A C&G w/ Agg Base is pasted in the Road1 folder we are going 

to modify the 2 gutter flowline points named RT_Curb_Surf_Flowline & 

LT_Curb_Surf_Flowline.  The project parameters call for the gutters not to super 

elevate with the roadway. 
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15. Below is the original Point Constraint for RT_Curb_Surf_Flowline. 

 

16. Change to a Slope Constraint to -7.41% and add a Parametric Label of 

RT_Gutter_Slope. 

   

17. Select apply to update the template. 

18. Edit the same flow line point on the left side. 
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19. Review the new Road1 templates by double clicking the name in the list.  Turn the 

Display Point names On/Off.  Select Test to verify the end condition functionality. 

 

2 Lanes Type A C&G w/ Agg Base 

 

Concrete Pavement 2 Lane w/ Agg Base Option 3 

 

 

20. Select File> Save to save the changes to the project J2P0200.itl. 

21. Close the Create Template dialog. 

Setting up the Corridor 
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22. From Corridor Modeling task group, select Create Corridor.  

Create Corridor command is also available from the context sensitive pop-up menu 

presented when hovering over a selected horizontal civil geometry element.  

 

 

23. When prompted to Locate Corridor Baseline, data point on Road1. 

 

24. Right-click to reset to select the active profile. 

 

25. Name the Corridor Road1. 

 

26. Data point to accept. 

27. Select <Alt> + Down to pick a template or use the Create Template Drop dialog box. 

28. Expand the project folder J2P0200 and Road1 folders.  Select the 2 Lanes Type A C&G 

w/ Agg Base template.  Click OK to dismiss the dialog and data point in the view to 

accept the choice of template. 

29. When prompted to enter the Start Station, select the <Alt> key to lock the Start Station to 

the start and data point in the view to accept it. 
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30. When prompted to enter the End Station, key in 25+30 and Tab to lock the value. Data 

point in the view to accept the end station. 

 

31. When prompted for the Interval, key in 5 and Tab to lock the value and data point to 

accept the value. 

32. Key in 0 (if it doesn’t default to 0) for the Minimum Transition Before Drop   and 

Minimum Transition After Drop, data point after each  until the corridor processes. This 

applies the template to the Road1 corridor for the stationing identified. 

33. Select <Alt> + Down to pick another template or use the Create Template Drop dialog 

box. 

34. Expand the folder J2P0200 and the Road 1 folder and select Concrete Pavement 2 Lane 

w/ Agg Base Option 3 template. Click OK to dismiss the dialog and data point in the 

view to accept the choice of template. 

35. When prompted to enter the Start Station, key in 25+30 and Tab to lock the value.  Data 

point in the view to accept the start station. 

 

36. When prompted to enter the End Station, select the <Alt> key to lock the End Station to 

the end and data point in the view to accept it. 

 

37. When prompted for the Interval, key in 5 and Tab to lock the value and data point to 

accept the value. 

38.  Key in 0 (if it doesn’t default to 0) for the Minimum Transition Before Drop   and 

Minimum Transition After Drop, data point after each  until the corridor processes. This 

completes the template drop for Road1 by applying the template to the stationing 

identified.  The corridor will process and display in both the 2D view and the 3D 

Isometric view. 

39. Select <F4> to close the Create Template Drop tool down. 

40. Press <F6> key to setup the 3D view. 

Hint: If you don’t see end conditions then the original ground terrain model was not 

active. 
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Review the model and the effect of Design stages 

41. Select the corridor by picking one of the handles. 

42. Select the Corridor Component Quantities option from the Corridor Reports pop-up. 

 

43. Key in some unit cost values. 

44. Select Report. 

45. Review the reports available.  Close the Report Browser. 

46. Display the pop-up menu again and select Properties. 

 

47. Select and explore the options for Design Stage. 
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48. Use the View Rotation tool to rotate the view to see 3D effects on the Road1 corridor. 

 

 

 

 

 

Set up Dynamic Cross sections 

49. From Corridor Modeling task group, select Open Cross Section View.  

Open Cross Section View command is also available from the context sensitive pop-up 

menu presented when hovering over a corridor handle.  
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50. When prompted to Locate Corridor or Alignment, identify the corridor by selecting a 

grab handle on the corridor. 

 

 

51. When prompted to Select or open View, select a view not in use and data point in the 

view.  This will present the first Cross Section of the corridor.  To Navigate up and down 

the corridor use the arrow indicators at the top of the view.  To navigate within in the 

view, use the mouse wheel; rolling the wheel forward zooms in, rolling back zooms out.  

Depressing the wheel and moving the mouse pans the view. 

 

Since superelevation will be changing the slopes, having feedback to the slope at each station is 

useful, the next steps describe how to place a dimension line from the edge of pavement to the 

center line on each side of the road. 

52. Select Show Place Dimension.  Located in the Corridor Modeling tools in the Civil 

Tools tasks. 

53. Select the Cross Section view. 

54. At the Start Point prompt, identify the left EOP named LT_Conc_T_EOP, data point to 

accept. 
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55. At the End Point prompt, identify the centerline point named Conc_T_CL, data point to 

accept. 

 

56. Place the dimension height above or below the component in a location that will be easy 

to read, data point to accept the location.   

 

Note:  This places the same dimension on all cross sections. 

Note:  The blue line on the alignment represents the location of the cross-section. 

 

57. Close View 7. 
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58. Save Settings on the design file.  The corridor is stored as MicroStation data; no .ird file 

is created. 

Important!  If you delete the graphics, you delete the corridor and both the 2D and the 

3D display. 

Note:  The User might notice there is no superelevation applied to the corridor, this is 

covered in the next chapter.  

59. Select File > Update Server Copy.  
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6.6 Individual Exercise: Creating a Corridor for Route63 

1. Continue working in Corridors_J2P0200.dgn.   

2. From Civil Tools task menu under Corridor Modeling, select Create Template.  

3. Select File > Open and navigate to the location of the project template file J2P0200.itl 

and open the file. 

4. In Create Template dialog right-click on the J2P0200 folder, select New > Folder and 

create a folder called Route63. 

 

5. Expand the Templates > Concrete Pavement w/ Shoulders folder. 

6. Expand the A3 Shoulders Agg Base folder. 

7. Right click on the Concrete Pavement 4 Lane Divided w/ Agg Base Option 3 template 

and select Copy. 

 

 



GEOPAK Road 1 Chapter 6 – Corridor Modeling Overview 
 
 

6/13/16 Missouri Department of Transportation 6-37 

 

8. Right click on the Route63 folder and select Paste. 

9. Test the template by clicking Test. 

10. Save your changes to the J2P0200.itl and then close the Create Template dialog. 

11. From Corridor Modeling task group, select Create Corridor  

12. When prompted to Locate Corridor Baseline, data point on Route63. 

13. Right-click to reset to select the Active Profile. 

 

14. Name the corridor Route63. 

 

15. Data point to accept. 

16. Select <Alt> + Down to pick a template or use the Create Template Drop dialog box. 

17. Expand the folder J2P0200 and the Route63 folder. 

18. Select the Concrete Pavement 4 Lane w/ Agg Base Option 3 template.  Click OK to 

dismiss the dialog and data point in the view to accept the choice of template 

19. When prompted to enter the Start Station, key in 10+00 R1, Tab to lock the station, and 

Data point in the view to accept. 

 

20. When prompted to enter the End Station, select the <Alt> key to lock the End Station to 

the end and data point in the view to accept it. 

 

21. When prompted for the Interval, key in 5 and Tab to lock the value. 

22. Key in 0 (if it doesn’t default to 0) for the Minimum Transition Before Drop   and 

Minimum Transition After Drop, data point after each  until the corridor processes. The 

corridor will process and display in both the 2D view and the 3D Isometric view.  This 

applies the template to the Route63 corridor. 
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23. Select <F4> to close the Create Template Drop tool down. 

24. Select the Corridor and from the Properties pop-up menu, select and explore different 

design stages. 

25. If the 3D View is not open select <F6> key to open a 3D view of the corridors. 

26. Using the View Rotation tool, rotate the view to see 3D effects of J2P0200 Route 63 

corridor.  

 

 

Set up Dynamic Cross sections 

27. Select Open Cross Section View  from the Corridor Modeling task group, to review 

the dynamic cross sections. 

28. When prompted to Locate Corridor or Alignment, identify the Route63 corridor by 

selecting a grab handle on the corridor. 

 

29. When prompted to Select or Open View, select a view not in use, (View 8) and data 

point in the view.  This will present the first Cross Section of the corridor.  To navigate 

up and down the corridor, use the arrow indicators at the top of the view.  To navigate 

within in the view, use the mouse wheel; rolling the wheel forward zooms in, rolling back 

zooms out.  Depressing the wheel pans the view. 

Since superelevation will be changing the slopes, having feedback to the slope at each station is 

useful, the next steps describe how to place a dimension line from the edge of pavement to the 

center line on each side of the road. 
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30. Select Show Place Dimension  from the Corridor Modeling task group. 

31. Select the Cross Section view. 

 

32. At the Start Point prompt, identify the left EOP named LT_Conc_T_EOP.  

 

 

33. At the End Point prompt, identify the right EOP named RT_Conc_T_EOP. 
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34. Place the dimension height above or below the component in a location that will be easy 

to read, data point to accept the location.   

35. Do this for both the North bound and the South bound lanes of Route 63. 

 

Note:  This places the same dimension on all cross sections. 

Note:  The blue line on the alignment represents the location of the cross-section. 

 

36. Close View 8. 

37. Compress and Save Settings on the design file.  The corridor is stored as MicroStation 

data; no .ird file is created. 

Important!  If you delete the graphics, you delete the corridor and both the 2D and the 

3D display. 

Note:  The User might notice there is no superelevation applied to the corridor, this is 

covered in the next chapter.  

38. Select File > Update Server Copy.  
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7.1 Objectives 

 Create a superelevation section and lane 

 Calculate superelevation using a SEP file, or import data from CSV file 

 Review / edit the data utilizing the table editor 

 Assign the superelevation information to a corridor 

7.2 Overview 

Superelevation tools calculate how much banking to apply to curves and spirals in the 

horizontal alignment to help offset centrifugal force. These commands also compute how 

the road will make the transition from normal crown to a fully banked curve and back again. 

Superelevation can be calculated in two ways: 

Rules-based – using a set of preferences (SEP file) the station and associated cross slopes 

of the transitions are based on design speed, curvature, and other design parameters. As the 

design progresses and parameters change (i.e., design speed exceptions) superelevation can 

be reprocessed to the revised parameter(s). 

Import – using a comma separate values (CSV) file to import the station and associated 

cross slope of each transition. In this option, the rules are not utilized; the data is simply 

applied to the superelevation lanes. 

The result of superelevation is a DGN file of graphic superelevation lanes with cross slope 

attributes. This file can be referenced to a corridor model and associated, so the 

superelevation transitions are incorporated into the corridor model. The superelevation data 

can be in its own DGN file, or can be drawn into any of the other project DGN files with 

geometry, corridor, etc. 

7.3 Prerequisites 

In order to create superelevation, the following are minimum requirements: 

 One Civil horizontal geometry element 

 Superelevation preferences (an SEP file set) - each of these preference files calls out 

other files within it so be sure you have the entire set 

In order to add the superelevation data to a corridor, you will need: 

 Superelevation lanes 

 Corridor whose template has superelevation flags for control points (for association 

step) 

Superelevation data is drawn using the active MicroStation attributes, so no features or 

element templates are used or supported.  Therefore, turning off the level with superelevation 

data removes it from the active view. 
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7.4 Settings 

The following two sets of settings are utilized within the superelevation tools. It is prudent to 

set them prior to drawing lanes. There are no required values; these are user preference. 

 fill settings for superelevation lanes 

 decimal place settings for element handlers 

7.5 Fill Settings 

Located under Workspace> Preferences from the main MicroStation or Power product 

menu, the View Options - Civil listing provides options for the superelevation fill. 

 
Option Description 

Color Shaded 
Fill 

Color Shaded Fill Color fills superelevation lanes AFTER calculations are complete. The coloring 
is hard-coded based on the cross slope: 

 

slope < -10% =blue 
 

-10% <= slope <= -0.5% = Calculated color between green and blue 

 

-0.5% < slope < 0.5% = white 
 

0.5% <= slope <= 10% = Calculated color between red and yellow slope > 10% = dark red 

Based on the side of road, the colors flip. In addition to setting this option, the View Attribute for 
Fill must also be toggled on. 

Boundaries 

Only 

In this option, only the outside boundary of each lane is displayed and can be selected. 

None No superelevation lanes / edit handlers are displayed; however, they are still in the file. To display 
them, set to one of the other two options. 
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7.6 Stationing and Decimal Place Settings 

Located under Settings > Design File from the main MicroStation or Power GEOPAK 

product menu, the Civil Formatting category listing has options for controlling display of 

element handlers. These settings are not unique to superelevation; the same settings are used 

throughout the Civil products. 

 
Option Description 

Station Settings: Used for section and lane edit handlers. 

Format Controls the number of places after the delimiter. 

Format Delimiter Controls the delimiter, generally the plus (+) sign. 

Precision Defines the number of decimal places for stationing. 

Profile Settings: Used for lane edit handlers. 

Slope Format Used for cross slope edit handlers. Generally set to percentage for superelevation. 

Slope Precision Defines number of decimal places in cross slope edit handlers. 

Superelevation General Workflow 

The general workflow for superelevation is described in the following steps. Steps 4-6 

can be done in a different order and not all steps are required. 

1. Create the super section(s). 

2. Define the lanes with Create Superelevation Lanes. 

3. Calculate superelevation transitions and cross slopes. 

4. Review and edit as needed. 

5. Add auxiliary lanes. 

6. Associate to a corridor. 

7.7  Create the Super Section(s) 

In this first step, the Civil horizontal geometry element is identified, and station limits of the 

superelevation are defined. Station limits are useful if the horizontal geometry element is 

substantially longer than the project limits. 

In a basic project where the through lane pavement configuration is consistent (i.e., all 2 lane 

rural with a few turn lanes), a single section may be used. However, if there are significant 

changes to the road, i.e., changing from 2 lane rural to 4 lane divided, separate sections 

should be created. 

The general rule is to create a new section if you are using rule-based calculations and the 

through lane configuration or pivot method changes. The changes should be based on the 

through lanes, as auxiliary lanes such as turn lanes, ramp entrances and exits and truck 

climbing lanes are handled independently. If you are importing superelevation, one section 

can be used for an entire alignment. 
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7.7.1 Create Superelevation Lanes 

Once the section is defined, define the lanes. Focus on the through lanes, as the turn lanes and 

intermittent lanes can be added at any time. Lanes are defined by selection of the horizontal 

geometry and offsets. Default cross slope, used for subsequent calculations, is also defined. 

The result of this step is that graphic lanes (filled with green and yellow, no choice of colors) 

are drawn. 

7.7.2 Calculate Superelevation Transitions and Cross Slopes 

In this step, there are two options: rule-based and imported data. Generally, one method 

would be selected, however, you can use rule-based for part of the project and import other 

parts (although this would be confusing). 

The rules-based tool uses a preferences file (SEP file) to compute the station and cross slopes 

of transitions, while the import superelevation method uses a comma separate values (CSV) 

file containing the station and cross slopes, which were calculated by an exterior program (or 

manually). The inputs vary depending on the method used and the preferences within the 

SEP file. 

The result of this step is the augmentation of station/cross slopes of transitions to the lanes 

created in the previous step. It is easy to see the results if the fill is toggled on as the lanes 

change from solid yellow and green to a gradient coloring, based on cross slopes. 

7.7.3 Review and Edit as Needed 

There are several ways to review the superelevation data and edit if desired. Highlighting a 

section displays station and cross slope values for review and editing. Stationing can be 

changed dynamically by selecting the gray wedge and dragging to the desired station. Each 

lane can be manipulated independently of the adjacent lanes. The station can all be keyed 

into the edit field. Slopes can be changed by keying the slope into the edit field. 

The superelevation editor is another way to edit the data, in a tabular format. Any changes 

made in the editor are automatically synced with the graphic lanes and vice versa. The fields 

in the editor can be customized so unused or unwanted fields can be hidden. Any data in gray 

cannot be edited, due to constraints used during calculations with the SEP method. 

7.7.4 Add Auxiliary Lanes 

At any time during the process, additional lanes can be added in any section. Primary lanes 

(those lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) 

can be added. The result of this step is graphic superelevated primary or auxiliary lanes. 

7.7.5 Associate to a Corridor 

At any time during the process, the superelevated lanes can be associated with a corridor. If 

the superelevated lanes are in a different file than the corridor, you must be in the corridor 

file with the super lanes attached as a reference. They can both be in the same file. 

The result of this step is the superelevated pavement is reflected in the corridor model. 
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7.8 Accessing Superelevation Tools 

 

From the Corridor Modeling task group 

 Create Superelevation Sections - In this tool the Civil horizontal geometry element is 

identified and station limits of the superelevation are defined. Station limits are useful if the 

horizontal geometry element is substantially longer than the project limits. 

Determination of Sections 

If you are importing superelevation, one section can be used for an entire alignment. The 

advantage of curve sets for each curve versus one large section is the ability to reprocess 

rules for a single curve set or two. Since rules are not used in an imported project, separate 

curve sets serve no useful purpose aside from shorter, piecemeal reports and more 

granularities in the editor. 

In a basic rules-based project where the through lane pavement configuration is consistent 

(i.e., all 2 lane rural with a few turn lanes), a single section may be used. However, if 

there are significant changes to the road, i.e., changing from 2 lane rural to 4 lane divided, 

separate sections should be created. 

The general rule is to create a new section if you are using rule-based calculations and the 

through lane configuration or pivot/rotation method changes. The changes should be 

based on the through lanes, as auxiliary lanes such as turn lanes, ramp entrances and exits 

and truck climbing lanes are handled independently. However, the auxiliary lanes must be 

drawn within a single section. 

Workflow 

1. Select Create Superelevation Section. 

2. Follow the heads-up prompts. 

Prompt User Action 

Name Name each section, suggestions include alignment name which can be appended -1, 2, etc. for projects 

with multiple sections. 

 

Locate Reference 

Element 

Select the Civil horizontal element to be used as a basis for superelevation lanes and calculations. 

 

Start Station Graphically define (based on the dashed line perpendicular to the reference element) the beginning of 

the section. The station can also be keyed in and locked 

 

End Station Graphically define (based on the dashed line perpendicular to the reference element) the ending of the 

section. The station can also be keyed in and locked 

 

Minimum 

Tangent 

Length 

Enter a value (in master units). If the tangent distance between two adjacent curves is less the specified 

value, the two curves and adjacent tangent are drawn into one curve set. If the tangent distance between 

two adjacent curves is greater the specified value, each curve and half of the adjacent tangent are 

drawn into each curve set. At the completion of this prompt, the sections are drawn and the software 

automatically advances to the Create Superelevation Lanes tool 
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Minimum Tangent Length 

This variable defines the minimum tangent between curves and is the determining factor 

on how curve sets are defined. When using rule-based calculations, there are times when 

you need to reprocess part of the superelevation calculations, perhaps due to a horizontal 

geometry change or design speed revision. If your project is one big section, then 

reprocessing is performed on the entire section, and overwrites any manual editing. For 

flexibility, curve sets enable the processing of one curve or multiple curves, while leaving 

manually manipulated sets intact. In the following example, the distance between curves is 

234.57 master units. 

 

The following results illustrate the impact of the Minimum Tangent Length. 

 

 

This line separates the 
two superelevation 
sections. 
Example: first section 
may have a speed 
limit of 30 mph and 
the second section 
may have a speed 
limit of 25 mph. Using 
the Minimum Tangent 
Length will allow for 
separate 
superelevation 
sections to 
accomplish the task. 
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 Create Superelevation Lanes - At any time during the process, additional lanes can be 

added in any section. Primary lanes (those lanes that are rule based) or auxiliary lanes (those with 

user-specified cross slopes) can be added. The result of this step is graphic superelevated primary 

or auxiliary lanes. 

Workflow for Through Lanes 

1. Select the Create Superelevation Lanes tool. 

2. Follow the heads-up prompts. 

 
Prompt User Action 

Locate First Superelevation 

Section 

Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines 
a square wherein the entire section must be encompassed in order to be 
included. 

Locate Next Superelevation 
Section or Reset to 
Complete 

Continue selecting sections until all are highlighted, then reset to move to 
the next prompt. 

Enter Lane Name Name each lane, suggestions include RT or LT which can be appended -

1, 2, etc. for projects with multiple lanes. 

Select Side of Centerline Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines 
a square wherein the entire section must be encompassed in order to be 
included. 

Inside Edge Offset Enter the offset (in master units) from the baseline reference. If the lane 
edge is the baseline reference, enter 0. 

Width Enter the width of the lane (in master units). 

Normal Cross Slope Enter the default cross slope to be used for calculations (in percent format). It 

not necessary to add the percent sign. 

Name The prompts are looping again, so you can define multiple lines with a single 

selection of the tool. You may need to move the cursor slightly for the 

prompt to appear. When you have no additional lanes to define, reset to exit 

the tool. 
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Adding Lanes 

At any time during the process, additional lanes can be added in any section. Primary lanes 

(those lanes that are rule based) or auxiliary lanes (those with user-specified cross slopes) can 

be added using the Create Superelevation tool, but within a single section. When a single 

section is selected, the prompts change to reflect adding an individual lane. The result of this 

step is graphic superelevated primary or auxiliary lane. The lane needs to be associated to the 

corridor, similar to the through lanes. 

Workflow for Individual Lane 

1. Select the Create Superelevation Lanes tool. 

2. Follow the heads-up prompts: 

Prompt User Action 

Locate First 

Superelevation Section 

Select the first section. 

Locate Next 
Superelevation Section or 
Reset to Complete 

Reset to move to the next prompt. 

Type Options include: Primary (calculations based on rules) or Auxiliary 
(based on user- defined). After the selection, the dialog/heads-up 
prompts change to reflect the selection. 

Application Type (Aux. 

lane only) 

How to define cross-slope: 

None - no cross slopes are assigned. 

Constant - Fixed slope of specified value. If lane is transition, use this 
option, and then modify one end in the editor or graphically after 
creation. 
Follow Adjacent - Projects cross slopes from adjacent lane to this lane. 

Select Side of Centerline Right or left 

Inside Edge Offset Enter the offset (in master units) from the baseline reference. If the lane 
edge is the baseline reference, enter 0. 

Width Enter the width of the lane (in master units). If the lane is of varying 
widths, you can use the widest width, or narrower than the width. In 
both cases, the template can control the width by parametric constraints 
or graphical features. 

Start Station Graphically define (based on the dashed line perpendicular to the 
reference element) the beginning of the lane. Station can be keyed in 
and locked. 

End Station Graphically define (based on the dashed line perpendicular to the 
reference element) the end of the lane. Station can be keyed in and 
locked. 

Normal Cross Slope Enter the default cross slope to be used for calculations (in percent 
format). It is not necessary to add the percent sign. 
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 Calculate Superelevation 

The rules-based tool uses a preferences file (SEP) to compute the station and cross slopes of 

transitions. 

Workflow 

1. Select Calculate Superelevation. 

2. Follow the heads-up prompts for SEP file. 

 

Prompt User Action 
Locate First Superelevation 

Section 

Select the first section. In lieu of selecting each section individually, drag your 
cursor diagonally across all desired sections. Your diagonal defines a square 
wherein the entire section must be encompassed in order to be included. 

Locate Next Superelevation 

Section; or Reset to Complete 

Continue selecting sections until all are highlighted, then reset to move to the next 
prompt. 

Standards File Name Select the SEP containing the superelevation standards/parameters. Use 

<ALT> <DOWN> to open the File Manager to select directory/file. Data prompt 
to accept and move to the next prompt. 

Note: The prompts below and their options may vary based on the options within the SEP file. 

e Selection 

L Selection 
The available e and length Selection fields are filled in according to the SEP file.  

Those combo boxes determine which table within the .sep file will be used for 
computation. 

Design Speed Design Speed is to be used either in the tables or equations for e and length 

computations. 

Pivot Method Rotation only 

Transition ID Linear or a variety of parabolic options, based on the settings in the SEPs. If the 
SEP file is set to parabolic, then the following options are supported: 

 
Parabolic reverse curve - This symmetrical option utilizes the parabolic transition 
with no tangent and the length of each parabola is one-half the transition length. 

 

 
 

Parabolic Reverse Nonsymmetrical Curve 1 - Lengths of the two parabolas are 
specified: Sag parabolic Length (L1) =45 and Crest Parabolic Length (L2) = 55. 
The Tangent Length = Transition Length - (L1+L2) as depicted below. 
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Parabolic Reverse Nonsymmetrical Curve 2 - Lengths of the two parabolas are 
specified: Sag parabolic Length (L1) =30 and Crest Parabolic Length (L2) = 40. 
The Tangent Length = Transition Length - (L1+L2) as depicted above. 

 

The values of the parabolic lengths are set by configuration variables by default. 

To change the values, add the configuration variable and the desired values. 

Number of Lanes Used to determine when adjustment factors are applied. 

Facility Divided or undivided: determines which values to use for Distribute Over and % on 

Tangent options. 

Ease Length Not utilized in SEP files. 

Add Constraints Not supported in SEP files. 

Open Editor When calculations are complete and lanes updated, the superelevation editor is 
opened and populated with the new calculated lanes. 
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 Import Superelevation 

In lieu of using rule-based superelevation transitions, the data may be imported from a CSV file, 

where calculations are done outside of the Civil products and just the results are imported. In this 

case, rules do not apply, so no SEP is needed or specified. 

Entire projects can be imported, in which case, only one superelevation section is needed. 

However, you can also import just a turn lane or two, or part of your project. Keep in mind the 

superelevation section and lanes must be created prior to importing, and lane names associated 

with the graphics must match the names in the import file. 

The Windows delimiter value is used, which is generally set to comma; however, if you are 

experiencing difficulties, you may want to verify this on your workstation or laptop. 

If a file is imported twice, duplicate lanes are not created; rather the values of the import file 

overwrite any values (including manual edits) of lanes. 

The file format of the comma separated values file is: 

  

Data Description 

Superelevation Lane Links the data to an existing superelevation lane. 

Station Units should match design file. 

Station equations supported based on the sections reference alignment. 

Cross Slope Formatted as a double value : ±0.0 (i.e. -2% == -0.02) 

Pivot About Enumerated list: {LS,RS} LS = left side 

RS = right side 

 

The following details the optional information:  

Data Description 

Point Type Enumerated list: 
{NC,NCIN,NCOUT,LC,LCIN,LCOUT,RC,RCIN,RCOUT,FS,FSIN,FSOUT,U} 

 
NC = Normal Crown, LC = Level Crown, RC = Reverse Crown, FS = Full Super, U = 
Undefined 

Transition Type Enumerated list : {L,PC,PRC,BRC,CRC,SRC} 

 
L = Linear, PC = Parabolic Curve, PRC = Parabolic Reverse Curve, BRC = Biquadratic 
Reverse Curve, CRC = Cubic Reverse Curve, SRC = Symmetrical Reverse Curve 

Non-Linear 
Curve Length 

Default Value = 0.0 
 

Only pertinent for transition type: parabolic curve or symmetrical reverse curve. 
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Workflow 

1. Create the CSV file, based on file format. 

2. Create superelevation section and lanes, ensuring the lane names match those used in the 

CSV file. 

3. Select the Import Superelevation tool. 

4. Follow the heads-up prompts: 
 

Prompt User Action 
Locate First 
Superelevation Section 

Select the first section. In lieu of selecting each section individually, drag 
your cursor diagonally across all desired sections. Your diagonal defines a 
square wherein the entire section must be encompassed in order to be 
included. 

Locate Next 
Superelevation Section or 
Reset to Complete 

Continue selecting sections until all are highlighted, then reset to move to the 

next prompt. 

 

 

 

  
Import File 

Name 

Use <ALT> <DOWN> to open the File Manager to select directory / CSV file. 
 

The results look identical to those of the calculated superelevation lanes. All functionality (i.e., 

editor, graphic manipulation, etc.) supported for calculation lanes is also supported for imported 

lanes, aside from reprocessing. 

 

Editing Lanes 

There are several ways to review the superelevation data and edit if desired. Highlighting a 

section displays station and cross slope values for review and editing. Stationing can be 

changed dynamically by selecting the gray wedge and dragging to the desired station. Each 

lane can be manipulated independently of the adjacent lanes. The station can all be keyed into 

the edit field. Slopes can be changed by keying the slope into the edit field. 

 



GEOPAK Road 1 Chapter 7 – Superelevation 
 
 

6/13/16 Missouri Department of Transportation 7-13 

 Assign Superelevation to Corridor 

At any time during the process, the superelevated lanes can be associated with a corridor. If the 

superelevated lanes are in a different file than the corridor, you must be in the corridor file with 

the super lanes attached as a reference. They can both be in the same file. 

The result of this step is the superelevated pavement is reflected in the corridor model. 

Workflow 

1. Verify that the template has the Superelevation Flag set for all pavement points used as 

candidate superelevation points. This flag is used for automatically setting the point 

controls.  To discover if the Flag has been applied to the template, Open the Edit 

Template Drop and select the Template Drop handle. Once inside the Editor, double click 

on the EOP point. 

 

2. From within the DGN containing the corridor model, select the Assign Superelevation to 

Corridor tool. 

3. Follow the heads-up prompts. 

Select the first section. In lieu of selecting each section individually, drag your cursor diagonally 

across all desired sections. Your diagonal defines a square wherein the entire section must be 

encompassed in order to be included. 

 

Prompt User Action 
 

Locate First 
Superelevation 
Section 

Select the first section. In lieu of selecting each section individually, drag 

your cursor diagonally across all desired sections. Your diagonal defines 

a square wherein the entire section must be encompassed in order to be 

included. 

 
Locate Next 
Superelevation 
Section or Reset 
to Complete 

Continue selecting sections until all are highlighted, then reset to move to 

the next prompt. 
 

Locate Corridor Select the corridor wherein the superelevation transitions are to be 

applied. 
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The Associate Superelevation dialog is displayed. 

 

1. If the information is correct, click OK. If not, click Cancel and review the template. 

Superelevation has been incorporated into the corridor model. 

2. Generate a dynamic cross section view to see the superelevation. 

 Insert Superelevation/Cross slope 

There may be times when an additional station and cross slope transition need to be added to an 

existing superelevation lane. Rather than deleting the lane and recreating it, the Insert 

Superelevation Station/Cross-slope tool can be used. 

Workflow 

1. Select Superelevation Station/Cross-slope. 

2. Follow the heads-up prompts. 

Prompt User Action 
Locate Superelevation Select a previously created superelevation lane 

that has superelevation calculations already 

assigned. 
Locate Reference Element Select the Civil horizontal element to be used 

as a basis for superelevation lanes and 

calculations. 
Start Station Graphically define (based on the dashed line 

perpendicular to the reference element) the 

beginning of the section. The station can be 

keyed in and locked. 
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 Superelevation Editor 

The superelevation editor is another way to edit the data, in a tabular format. Any changes made 

in the editor are automatically synced with the graphic lanes and vice versa. Any data in gray 

cannot be edited, due to constraints used during calculations with the SEP method. 

 

The editor is opened by selecting the tool, then selecting the superelevation section(s). The curve 

sets are listed along the left side. Highlighting any curve set populates the table. Colored points 

indicate: 

 Red - fully constrained 

 Yellow - partially constrained 

 Green - not constrained 

Between the diagram and the table are 

numerous short-cut icons to the 

superelevation tools. 

The superelevation diagram at the top is 

display only. Right click on the 

superelevation diagram to display the 

Superelevation Display List dialog. 

The fields in the editor can be customized so unused or unwanted fields can be hidden. This is 

accomplished by right-clicking on any Header in the tabular data area to open the pop-up menu. 
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 Superelevation Report 

Superelevation reports can be generated for a single or multiple sections. Reports are displayed in 

the Civil Report browser. 

Workflow 

1. Select Superelevation Report. 

2. Follow the heads-up prompts. 
 

Prompt User Action 

Name Name each section, suggestions include alignment name which can be appended 
-1, 2, etc. for projects with multiple sections. 

Locate Reference Element Select the Civil horizontal element to be used as a basis for superelevation 
lanes and calculations. 

Start Station Graphically define (based on the dashed line perpendicular to the reference 
element) the beginning of the section. The Station can also be keyed in and 
locked. 

 

 Display Superelevation In Plan 

Use the Display Superelevation in Plan command to automatically generate annotation for 

superelevation station information in plan view. 

The command uses the MicroStation active symbology to display the lines and the text. The user 

sets active text height and width, color, line weight, and line spacing. The line spacing is used to 

offset the text from the top and bottom of the superelevation lines. The justification is hardcoded 

to be center bottom to the right of the alignment and center top to the left for the station values. 

The cross slope value is displayed using left center justification. 

The arrow head uses the active text height to determine its height. 

All text, offsets, and the height of the arrow head are scaled by the MicroStation annotation scale 

factor. 

Workflow 

1. Select Display Superelevation in Plan. 

2. Follow the heads-up prompts. 
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7.9 Group Exercise – Road 1 Superelevation 

1. Within the J2P0200\data_07 folder, open the file: Corridors_J2P0200.dgn 

2. Create a new file named Superelevation_J2P0200.dgn based on the following 2D seed 

file: 

 pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn.   

3. Reference in the following file: 

Civil_Geometry_J2P0200.dgn 

 

Create Superelevation Sections 

4. Change the Primary Attributes by selecting the Superelevation Element Template from 

the Element pull down, navigating to the Section option and then double clicking. 

  

5. From the Corridor Modeling task choose Create Superelevation Sections.  

6. When prompted for the Name key in Road1 and data point or tab to accept. 

 

7. When prompted to Locate Reference Element data point on the Road1 horizontal 

geometry. 

 

8. When prompted to enter the Start Station either select the beginning of Road, key in 0 for 

the station or press the Alt key to lock to the beginning station.  Data point to accept. 
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9. When prompted to enter the End Station either select the end of Road, key in 3510.08 for 

the station or press Alt to lock to the ending station.  Data point to accept. 

 

10. There is only one curve on this section of Road1so there is no tangent length between 

curves.  Therefore enter a Minimum Tangent Length of 0.  Data point to accept. 

 

 

Note:  If the geometry had multiple curves with different design speed then you would 

create multiple Superelevation Sections. 

Create Superelevation Lanes 

11. When prompted Enter Lane Name, key in South (stationing starts at the north end of 

Road1).  Data point to accept. 

12. Verify Type is set to Primary.  Data point to accept. 

 

13. When prompted to Select side of the centerline, select Right from the drop-down menu 

by using the down arrow.  Data point to accept. 

 

14. There is no offset.  So when prompted to Enter the offset value for the inside edge, enter 

0.00.  Data point to accept. 

 

15. In the Enter the Width field, key in the width of the lane.  This value is based on the 

template assigned to the corridor.  Key in 12.00.  Data point to accept. 

 

In the Normal Cross Slope dialog, enter a normal cross slope of -2%.  Data point to 

accept. 
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16. When prompted to Enter Lane Name, enter North.  Data point to accept. 

17. Set the Type to Primary.  Data point to accept. 

18. Set the Side of Centerline to Left.  Data point to accept. 

19. There is no offset.  Set the Inside Edge Offset to 0.00.  Data point to accept. 

20. Enter a Width of 12. Data point to accept. 

21. Enter a Normal Cross Slope of -2%.  Data point to accept. 

22. Reset to continue. 

 

Calculate Superelevation 

23. Open the Calculate Superelevation Tool.    

24. Select <Alt> + Down or use the dialog box to pick the MoDOT_Standard_Plans-

Undivided.sep file delivered in the workspace.  

T:\MoDOT_Workspace\Gpk_Std\Superelevation\ MoDOT_Standard_Plans-Undivided.sep 

Data point to accept. 

25. In the Select e Selection prompt select 8% e max by using the down arrow.  Data point 

to accept. 

 

26. For L Selection select all cases.  Data point to accept. 

 

27. Select a Design Speed of 50.  Data point to accept. 

 

28. For Transition ID select Linear.  Data point to accept. 

 

29. Select 2 for the Number Of Lanes.  Data point to accept. 
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30. Select Undivided in the Select Facility option.  Data point to accept. 

31. Select Yes for the Open Editor.  This brings up the Superelevation Editor dialog.  

Facilitating adjustments to stations to full super, slopes etc. 

 

32. Compress the file and Save Settings. 
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Assign Superelevation to Corridor 

Once the superelevation is created based on the alignment it must be tied to the corridor.  

Assigning the superelevation requires the editing of the corridor model therefore the dgn file 

with the corridor model must be open.  Having the superelevation in a separate design file allows 

one user to work on super and another to work on the corridors.  Also the superelevation 

reference can be turned off when viewing is not required. 

33. Select File > Open and select the Corridor_J2P0200.dgn. 

34. Attach the Superelevation_J2P0200.dgn by opening the References dialog box and 

clicking Tools>Attach…, use the attachment method Coincident – World and No 

Nesting. 

35. Close the References dialog box. 

36. Select the Assign Superelevation to Corridor  in the Corridor Modeling task 

group. 

37. When prompted to Locate First Superelevation Section data point on the Road1 super 

section. 

 

38. There is only one section, when prompted, Reset to Complete. 

 

39. When prompted to Locate Corridor, identify one of the corridor grab handles.  These 

extend from the outside edge of the corridor. 

 

 

 

 

 

 



Chapter 7 – Superelevation    GEOPAK Road 1 
 

 

7-22 Missouri Department of Transportation 6/13/16 

40. A dialog with a list of the Superelevation objects will display.  Review to verify.  If 

changes to Stations, priorities, or points are required, they can be made here.  If correct 

click OK. 

 

41. Reset when prompted to Locate First Superelevation Section. 

42. Select File > References. 

43. Click on the frame of View 1. 

44. Turn off the display of reference file named: Superelevation_J2P0200.dgn. 

45. Open View 7 which contains the dynamic cross sections and review the superelevated 

sections. 

46. Select File > Update Server Copy 
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7.10 Individual Exercise - Route 63 Superelevation 

1. Within the J2P0200\data_07 folder, open the file: Superelevation_J2P0200.dgn 

 

Create Superelevation Sections 

2. From the Corridor Modeling task group select the Create Superelevation Sections.  

3. When prompted for the name key in Route63.  Data point to accept. 

4. When prompted to Locate Reference Element, select the RTE63 horizontal geometry. 

5. When prompted for the Start Station, press Alt to lock to the beginning station.  Data 

point to accept. 

6. When prompted for the End Station, press Alt to lock to the ending station.  Data point 

to accept. 

7. There is only one curve on this section of RTE63 so there is no tangent length between 

curves.  Therefore enter a Minimum Tangent Length of 0.  Data point to accept. 

 

Create Superelevation Lanes 

8. When prompted to Enter Lane Name, enter NBInside.  Data point to accept. 

9. Set the Type to Primary.  Data point to accept. 

10. Set the Side of Centerline to Left.  Data point to accept. 

11. The offset value for the inside edge is 30’.  Set the Inside Edge Offset to 30.00.  Data 

point to accept. 

12. In the Enter the width dialog, key in 12.000 for the width of the lane.  Data point to 

accept.  This value is based on the template assigned to the corridor. 

13. Enter a Normal Cross Slope of +2%.  Data point to accept. 

14. When prompted to Enter Lane Name, key in NBOutside.  Data point to accept. 

15. Set the Type to Primary.  Data point to accept. 

16. Set the Side of Centerline to Left.  Data point to accept. 

17. Set the Inside Edge Offset to 42.00.  Data point to accept. 

18. In the Enter the Width key in the 12.000 width of the lane.  Data point to accept. 

19. Enter a Normal Cross Slope of -2%.  Data point to accept. 

20. When prompted to Enter Lane Name, key in SBOutside.  Data point to accept. 
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21. Set the Type to Primary.  Data point to accept. 

22. Set the Side of Centerline to Right.  Data point to accept. 

23. Set the Inside Edge Offset to 42.00.  Data point to accept. 

24. In the Enter the Width key in the 12.000 for the width.  Data point to accept. 

25. Enter a Normal Cross Slope of -2%.  Data point to accept. 

26. When prompted to Enter Lane Name, key in SBInside.  Data point to accept. 

27.  Set the Type to Primary.  Data point to accept. 

28. Set the Side of Centerline to Right.  Data point to accept. 

29.  Set the Inside Edge Offset to 30.00.  Data point to accept. 

30. In the Enter the Width, key in the 12.000 for the width.  Data point to accept.  This value 

is based on the template assigned to the corridor. 

31. Enter a Normal Cross Slope of +2%. 

32. Reset to continue. 

Calculate Superelevation 

33. Select <Alt> + Down or use the dialog box to pick the MoDOT_Standard_Plans-

Divided.sep file delivered in the workspace.  

T:\MoDOT_Workspace\Gpk_Std\ MoDOT_Standard_Plans-Divided.sep.   

Data point to accept. 

 

34. In the Select e Selection prompt, select 8% e max.  Data point to accept. 

35. For the L Selection, select all cases.  Data point to accept. 

36. Set a Design Speed of 70.  Data point to accept. 

37. For the Transition ID, select Linear.  Data point to accept. 

38. Select 4 for the Number Of Lanes.  Data point to accept. 

39. Select Divided for the Select Facility option.  Data point to accept. 
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40. Select Yes for the Open Editor option.  Data point to accept.  This brings up the 

Superelevation Editor dialog for facilitating adjustments to stations, slopes etc. 

  

 

 

 

 

 

 

Assign Superelevation to Corridor 
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Once the superelevation is created based on the alignment it must be tied to the corridor.   

Assigning the superelevation requires the editing of the corridor model therefore the dgn file 

with the corridor model must be open.   Having the superelevation in a separate design file 

allows one user to work on super and another to work on the corridors.  Also the superelevation 

reference can be turned off when viewing is not required. 

41. Open the Corridors_J2P0200.dgn file. 

42. Turn on the display of the Superelevation_J2P0200.dgn file in View 1 in the References 

dialog box. 

43. Select the Assign Superelevation to Corridor  in the Corridor Modeling task 

group. 

44. When prompted to Locate First Superelevation Section, data point on the Route63 

Super Section. 

45. Reset to complete. 

46. When prompted to Locate Corridor, select one of the Corridor grab handles.  These 

extend from the outside edge of the corridor. 

47. A dialog with a list of the Superelevation objects will display.  Review to verify.  If 

changes to Stations, priorities, or points are required they can be made here.  If correct, 

click OK. 

 

48. Reset when prompted to Locate First Superelevation Section. 

49. Open View 8 which contains the dynamic cross sections and review the superelevated 

sections. 

50. Select File > Update Server Copy 
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8.12 Objectives 

The purpose of this chapter is to show the user how to 

use the multiple tools available in Corridor Modeling 

task group to achieve desired results for the design of 

the corridor.  

8.13 Create Corridor 

Creating a corridor, using the Create Corridor 

command, is the first step in creating a corridor model.  

One corridor should be established for each alignment.  

The corridor is saved in the MicroStation Design file.  

The following are the steps and prompts used by the 

Create Corridor command:  

1. When using the Create Corridor command, you are 

first prompted to Locate Corridor Baseline.  

Simply select the appropriate horizontal geometry. 

2. You will then be prompted to Locate Profile-Reset 

For Active Profile.  If the horizontal geometry has 

the appropriate profile active, simply reset.  You 

can select a different profile from a profile view. 

3. You will then be prompted to key in the Corridor Name.  The name of the corridor 

should be the name of the horizontal geometry.    

4. You will then be prompted to Select Template.  Hold down the Alt key and press the 

Down Arrow on your keyboard.  This will bring up the Pick Template dialog.  Select the 

appropriate template and click OK.  

5. You will then be prompted to select the Start Station.  To move to the beginning of the 

horizontal geometry, press the Alt key on your keyboard.  You can also key in the 

appropriate Start Station or move your cursor to location in the CAD view. 

6. You will then be prompted to select the End Station.  To move to the end of the 

horizontal geometry, press the Alt key on your keyboard.  You can also key in the 

appropriate End Station or move your cursor to location in the CAD view. 

7. You will then be prompted to key in the Drop Interval.  The Drop Interval represents 

how often to perpendicularly process the template along the geometry.  The Drop Interval 

should be a number that divides evenly into the cross section interval (ex. 10, 25). 

8. You will then be prompted to key in Start Transition – Minimum Transition Before Drop.  

If more than one template is being used for the project, the Start Transition – Minimum 

Transition Before Drop option represents the length of transition between the template 

selected in Step 4 and a different template located before the one selected in Step 4. 

9. You will then be prompted to key in Stop Transition – Minimum Transition After Drop.  

If more than one template is being used for the project, the Stop Transition – Minimum 
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Transition After Drop option represents the length of transition between the template 

selected in Step 4 and a different template located after the one selected in Step 4. 

10. To add different templates, repeat Step 4 to Step 9.  If you are adding different templates 

after you exit the Create Corridor command, use the Create Template Drop command to 

add different templates. 

8.14 Basic Workflow for Creating a New Corridor 

1. Select the Create Corridor icon from the Corridor Modeling tasks group. 

2. Select the horizontal geometry and reset for the active profile. 

3. Key in the Corridor Name. 

4. Select the appropriate template. 

5. Key in the corridor start and stop stations. 

6. Key in the transition lengths. 

8.15 Multiple Templates 

Create Corridor is a versatile tool that allows the user to use multiple design templates for one 

corridor.  The user should review the corridor and identify the possible locations for changes in 

the template before starting the corridor design in using the Create Corridor tool. 

8.15.1 Multiple Template Drops 

Anytime there is a situation where the design changes, for example from a 2-lane to 4-lane, or 

from rural to urban; the user needs to insert or “drop” multiple templates in the corridor to achieve 

the desired results. This is accomplished thru the Create Template Drop icon  from the 

Corridor Modeling tasks group. 

The Create Template Drop command has prompts similar to the Create Corridor command. 

8.16 Template Transitioning  

When multiple templates are used within one corridor, a transition from one to the other is 

introduced, and it will be shown in the MicroStation view.  The transition will be abrupt until the 

transition is fully defined using the Edit Transition icon  from the Corridor Modeler tasks 

group. These transitions are shown as an object between the template drops. 
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8.16.1 Transition Editing 

To review the transition areas, use the Edit Transition tool and select the transition when 

prompted.  This displays the Edit Transition dialog which shows the point connections between 

the two templates. 

 

Bold color points indicate no connection.  Point connections can be made by clicking on any bold 

color point followed by a click on appropriate connecting point.  A single point can have more 

than one connection to that point. To remove a connection line, right-click on the line and select 

Delete. 
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This window provides a 3D view and it can be manipulated using the view controls located at the 

bottom of the view. To move the template in the view, right-click on any template point and select 

Move Template.  Moving template makes it easier to edit. 

8.16.2 Transition Testing 

After the points are connected, the transitioning is reviewed and edited in the Edit Transition 

Midpoint dialog.  This dialog displays a cross section view of two templates as they transition.  

The display starts at the transition midpoint between the two templates, but can be viewed at the 

beginning, ending or any point in between.   

If the user desires to change point properties, double click on any point to bring the Point 

Properties dialog. 
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8.17 Template Point Controls 

Point controls are used to override the established horizontal and vertical locations of points from 

the original point location on the template.  Point controls are the equivalent of the criteria adhocs 

placed on plan graphics with D&C Manager to control widths, ditch slopes, etc.  Point controls 

then are used to control horizontal and vertical locations for EOP, EOS, sidewalks, retaining 

walls, barriers, special ditch profiles and ditch widths, etc. 

The Create Point Control icon  can be accessed thru the Corridor Modeling tasks group. 

Point Controls are used to override the normal locations of one or more points and or 

components in a cross section. Examples of this include lane widening, staying within the right-

of-way, maintaining a particular slope for a ditch, and superelevation. 

An example would be a ramp is merging into the main road. The ramps left edge is vertically 

controlled by the main road right edge of pavement. The ramps left edge is horizontally controlled 

by the main road right edge from 0+00 to 1+00, and then it is controlled by a horizontal alignment 

named rampLeft. 

The following are the prompts for the Create Point Control command: 

Locate Corridor Selects the corridor where the point controls are applied. 

Station Limits (Start/Stop) Specifies the start and stop stations for the control. 

Control Description Allows you to enter a description of the control. 

Point Allows you to select the point to be controlled.  Select from the list or identify the point 

in the cross-section using the locate button. The selected point is highlighted in plan/cross 

section and profile or superelevation views as applicable. 

Mode Allows you to select the control mode: Horizontal, Vertical, or Both. 

Control Type Specifies the type of control. 

If the mode is Horizontal or Both, valid control types are Linear Geometry, Feature 

Definition, or Corridor Feature. 

If the mode is Vertical, valid control types are Linear Geometry, Feature Definition, 

Corridor Feature, Superelevation, Elevation Difference, Elevation and Grade. 

The selection combo boxes and/or field displayed depends on the selected Mode and 

Control Type. 

Type - Linear Geometry If the type is Linear Geometry, a Horizontal Offsets combo box 

is displayed. If the mode is Both, a Vertical Offsets combo box is also displayed. 

Type - Feature Definition If the type is Feature Definition, a Feature Definition and 

Range text field is displayed. 



Chapter 8 – Designing with Corridor Modeling GEOPAK Road 1 
 
 

8-6 Missouri Department of Transportation 5/6/16 

Type - Corridor Point For all modes, Corridor and Reference Feature combo boxes are 

displayed. These options allow you to set up the control of one corridor’s points(s) from 

another corridor’s point(s). 

Targeting another corridor's point cannot be done simultaneously with Target Aliasing of 

that same corridor. If Target Aliasing has been defined, the Corridor Point is not available 

for selection within the Point Control dialog. This produces a recursive situation, making 

the corridor point control unavailable for selection until that Target Aliasing is removed. 

Type – Superelevation This option displays a Superelevation control line combo box, and 

a Reference Point combo box. Superelevation control lines are stored in the roadway 

design, not on the alignment. The reference point is the pivot point (feature) about which 

the point will rotate. 

Type - Elevation Difference This option displays Horizontal and Vertical alignment 

combo boxes. The vertical alignment represents a vertical difference value to be applied to 

the points’ current elevation. 

Type - Elevation and Grade This option displays an Elevation field, and a Grade field. 

The control sets elevation of the point at the start station to the elevation specified. The 

slope of the point’s line is then at the grade specified until the end station is reached. 

Priority Determines the order of controls on a point. This value applies only when there are 

conflicting controls on a point. Where there is a conflict, the control with the lower priority is 

applied (that is, lower numbers are applied first). 

Use as Secondary Alignment Specifies that horizontal point controls are also used as 

secondary alignments. This option is available only when working with a 2D entity. If you are 

using a 3D object, the software skips the secondary alignment option. 

Horizontal Offsets (Start/Stop) Specifies the start and stop horizontal offset controls for the 

corridor. If the values are different, then the value applied at a given station is calculated using 

a linear algorithm. 

Vertical Offsets (Start/Stop) Specifies the start and stop vertical offset controls for the 

corridor. 
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8.18  Superelevation 

The superelevation points create a special type of point control. 

This toolbox contains tools for creating, calculating, and editing superelevation lanes. Tools are 

also supported for importing CSV data and reporting. 

 

 Create Superelevation Sections - Adds a superelevation sections (generally one per curve 

set) for the specified station range on the baseline reference. 

 Create Superelevation Lanes - Creates color-filled lanes based on width and offsets from 

the baseline reference, as a precursor to superelevation calculations. 

 Calculate Superelevation - Calculates station and superelevation transitions rates based on 

a preferences or rules file (*.sep,*.srl).  The values are augmented to the superelevation lanes, 

edit manipulators are created, and the color fill is recolored based on the cross slopes. 

 Import Superelevation - Optionally, imports data from a CSV file. 

 Assign Superelevation to Corridor - Associates superelevation with a corridor, so the 

pavement reflects the superelevation stations / cross slopes, rather than the pavement cross slope 

defaults in the template. 

 Insert Superelevation Station/Cross slope - Insert an individual station / superelevation 

transition (cross-slope) into a previously created and calculated superelevation lane. 

 Superelevation Editor - Opens the superelevation editor allowing the user to edit the 

calculated superelevation in a tabular format. 

 Superelevation Report - Creates a superelevation XML report and opens the Bentley Civil 

Report Browser. 

 Superelevation in Plan - Automatically generates annotation for superelevation station 

information in plan view. 
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8.19 Parametric Constraints 

Parametric constraints are used to override the original constraint values established in the 

template from the library being used.  The Create Parametric Constraint icon  can be 

accessed from the Corridor Modeling tasks group. 

The parametric constraints are the equivalent of a re-definable variable.  So, the names of the 

parametric constraints established in MoDOT Template Library mirrors the criteria names as 

much as possible. 

Parametric Constraints are setup in the template and applied to the corridor using the Create 

Parametric Constraint command. 

The prompts for the Create Parametric Constraint command are as follows: 

Locate Corridor – select the corridor where you want the Parametric Constraints applied. 

Start/End Station - Specify the start/end station for the override. 

Constraint Label - Lists all labeled constraints in the design. The selected label receives the 

override. 

Start/Stop Value - Specifies the constraint value and can be transitioning from the first 

parametric value at the start and stop values. 

8.20 Design Changes 

The lifecycle of a roadway project is long, and complex.  Changes must be done to accommodate 

for unforeseen situations or to stay within budget.  The Corridor Modeling tools offers the 

flexibility to allow these design changes. 

8.20.1 Geometry Changes 

Once the horizontal and vertical geometry are created and used by a corridor, the user can go back 

and change the geometry.  Any changes will be reflected in the corridor design. 

8.20.2 Template Library Synchronization 

Changes to the template can be made either in the Corridor or in the Template Library.  Where a 

user makes the changes for his/her template depends on the circumstances and needs to be 

reviewed on a case by case basis. 

Any changes made in the template library can be obtained by synchronizing the template drops 

with the library.  This is accomplished by selecting the template drop on the corridor in the plan 

view and selecting Synchronize with Library icon from the heads-up menus.  
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Changes can be made to a template used in a corridor by using the Edit Template command.  

The Edit Template command can either be accessed by selecting the template drop on the 

corridor in the plan view and selecting Edit Template icon from the heads-up menus or from the 

Corridor Modeling tasks group. 

 

8.21 Basic Design Workflow with Corridor Modeling Tools 

1. Set up a corridor 

2. Insert template drops as needed 

3. Create any template point controls 

4. Design superelevation 

5. Set parametric constraints as needed 

6. Review design 

7. Make revisions as needed and re-review 

  



Chapter 8 – Designing with Corridor Modeling GEOPAK Road 1 
 
 

8-10 Missouri Department of Transportation 5/6/16 

8.22 Group Exercise: Road-1 Parametric Constraints (Left Side) 

Parametric Constraints: Resolving transition between templates - Below is an image of an 

adjoining Curb and Gutter and Shoulder Section. 

 

 
 

Note: 1)   In this exercise we will use a number of Parametric Constraints to fix the gaps 

between the two template drops.  Remember a Parametric Constraint will override 

the Point Constraint values.   

2) The goal of this section is to transition the differences between the two 

templates over a distance. 
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1. Within the Randolph\data_08 folder, open the file: Corridors_J2P0200.dgn 

2. Click on the one of the Road 1 Template Drop Handlers with the range of 0+00 to 25+30 

and edit the template. 

3. Review the Point Properties Dialog for the LT_Curb_Surf_Flowline Point. 

 

4. Resolving Gutter Slope - Using the Parametric Label in the Point Properties for the 

LT_Curb_Surf_Flowline point add the following Parametric Constraint: 

 

 

 

 

 

 

Start:   24+80 

Stop:   25+30 

Constraint Label: LT_Gutter_Slope 

Start Value:  7.41% 

Stop Value:  2.00% 
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5. Resolving the Gutter Width - Add a Parametric Label to the LT_Curb_Surf_Flowline 

point called LT_Gutter_Width that will control the Horizontal width of the Gutter. 

 

6. Using the Parametric Label in the Point Properties for the LT_Curb_Surf_Flowline 

point add the following Parametric Constraint: 

      

7. Removing Berm Width - Using the Parametric Label in the Point Properties for the 

LT_Berm_B point add the following Parametric Constraint: 

                      

 

 

 

 

Start:   25+20 

Stop:   25+30 

Constraint Label: LT_Gutter_Width 

Start Value:  -2.25 

Stop Value:  -3.25 

Start:   24+80 

Stop:   25+30 

Constraint Label: LT_Berm_Width 

Start Value:  -6.00 

Stop Value:   0.00 
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8. Resolving Berm Location – Right click on the Left Berm Line insert a point and place it 

on top of the point adjacent to the Back of Curb: 

 

9. Double click on newly place point and open the Point Properties dialog.  Rename the 

point to LT_Berm_T 

10. Right click on newly place point and select Delete Point.  Delete the 

LT_Curb_Surface_Back point: 

 
 

 Delete the LT_Berm Shape (Component) from the Point. 
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 Note:  The LT_Curb_Surface_Back point was included in both the Berm and Curb 

components. 

11. Right click on the point LT_Berm_T and add a Horizontal Constraint with the Parent 

Point being the LT_Curb_Surface_Back. 

 

 
 

12. Right click on the point LT_Berm_T and add a Vector Offset Constraint with the 

Parent Points being the LT_Curb_Surf_Flowline and the LT_Conc_T_EOP points. 

 

 

 

 

 

 

 

 

 

13. Add in a Parametric Label for the Vector Offset Constraint called the following:  

LT_Berm_Elevation_Offset 
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14. Edit the LT_Berm_B point so that its parent point is the newly created LT_Berm_T 

point.  

 

 
 

 

15. Lowering the Berm - Using the Parametric Label in the Point Properties for the 

LT_Berm_T point add the following Parametric Constraint: 

                      

Start:   24+80 

Stop:   25+30 

Constraint Label: LT_Berm_Elevation_Offset 

Start Value:  -0.5540 

Stop Value:  0.00 
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8.23 Individual Exercise: Road-1 Parametric Constraints (Right Side) 

Parametric Constraints: Resolving transition between templates - Below is an image of an 

adjoining Curb and Gutter and Shoulder Section. 

 

 
 

o In this exercise we will use a number of Parametric Constraints to fix the gaps between the 

two template drops.  Remember a Parametric Constraint will override the Point Constraint 

values.   

o The goal of this section is to transition the differences between the two templates over a 

distance. 
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1. Within the Randolph\data_08 folder, open the file: Corridors_J2P0200.dgn 

2. Click on the one of the Road 1 Template Drop Handlers with the range of 0+00 to 25+30 

and edit the template. 

3. Review the Point Properties Dialog for the RT_Curb_Surf_Flowline Point. 

 

4. Resolving Gutter Slope - Using the Parametric Label in the Point Properties for the 

RT_Curb_Surf_Flowline point add the following Parametric Constraint for the Right 

side: 

 

 

 

 

 

 

Start:   24+80 

Stop:   25+30 

Constraint Label: RT_Gutter_Slope 

Start Value:  -7.41% 

Stop Value:  -2.00% 
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5. Resolving the Gutter Width - Add a Parametric Label to the RT_Curb_Surf_Flowline 

point that will control the Horizontal width of the Gutter. 

 

6. Using the Parametric Label in the Point Properties for the RT_Curb_Surf_Flowline 

point add the following Parametric Constraint: 

      

7. Removing Berm Width - Using the Parametric Label in the Point Properties for the 

RT_Berm_B point add the following Parametric Constraint: 

                      

 

 

 

 

Start:   25+20 

Stop:   25+30 

Constraint Label: RT_Gutter_Width 

Start Value:  2.25 

Stop Value:  3.25 

Start:   24+80 

Stop:   25+30 

Constraint Label: RT_Berm_Width 

Start Value:  6.00 

Stop Value:  0.00 
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8. Resolving Berm Location – Right click on the Right Berm Line insert a point and place 

it on top of the point adjacent to the Back of Curb: 

 
 

9. Double click on newly place point and open the Point Properties dialog.  Rename the 

point to RT_Berm_T 

10. Right click on newly place point and select Delete Point.  Delete the 

RT_Curb_Surface_Back point: 

 
 

 Delete the RT_Berm Shape (Component) from the Point. 

 

 
 

 Note:  The RT_Curb_Surface_Back point was included in the both Berm and Curb 

components. 
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11. Right click on the point RT_Berm_T and add a Horizontal Constraint with the Parent 

Point being the RT_Curb_Surface_Back. 

 

 
 

12.  Right click on the point RT_Berm_T and add a Vector Offset Constraint with the 

Parent Points being the RT_Curb_Surf_Flowline and the RT_Conc_T_EOP points. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. Add in a Parametric Label for the Vector Offset Constraint called the following:  

RT_Berm_Elevation_Offset 
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14. Edit the RT_Berm_B point so that its parent point is the newly created RT_Berm_T 

point.  

  
 

 
 

15. Lowering the Berm - Using the Parametric Label in the Point Properties for the 

RT_Berm_T point add the following Parametric Constraint: 

                      

Start:   24+80 

Stop:   25+30 

Constraint Label: RT_Berm_Elevation_Offset 

Start Value:  -0.5540 

Stop Value:  0.00 
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8.24 Group Exercise: Horizontal Feature Constraint 

1. Within the Randolph\data_08 folder, open the file: Corridor_J2P0200.dgn 

2. Within the Corridor Modeling Task tools, select the Open Cross Section Tool to view 

cross sections of Road 1.  The current the Template is set up to draw 12ft lanes. 

 

3. Widen the Pavement Right Width – Within the Road 1 Template, use the Parametric 

Label in the EOP Point Properties for the RT_Conc_T_EOP point.  Add the following 

Parametric Constraint: 

                      

 

 

 

 

 

 

 

 

 

 

Start:   Lock to Start 

Stop:   Lock to End 

Constraint Label: RT_Pvmt_Surf_Conc_Width 

Start Value:  14.00 

Stop Value:  14.00 
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4. Once again within the Corridor Modeling Task tools, select the Open Cross Section 

Tool to view cross sections of Road 1.  The User should see that the Parametric 

Constraint overruled the current Template Setting of 12ft lanes on the Right side. 

 

 
 

 

 
 

 
 

5. In View 1 (Default), reference in the following file: 

Plan_J2P0200.dgn 
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6. After selecting View 1, turn off the display of all reference files except for 

Plan_J2P0200.dgn 

Note: The goal of this exercise is to have the Template Edge of Pavement follow the 

Feature Definition Line EOP_New drawn in the Plan File. 
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7. Within the Road 1 Corridor select one of the Corridor Grips to be up the Heads up 

Tools go to the Corridor Reference Pull-down and select “Add Corridor Reference”. 

 

8. Once again within the Corridor Modeling Task tools, select the Open Cross Section 

Tool to view cross sections of Road 1.  The User should see that the Horizontal Feature 

Constraint has overruled the Parametric Constraint, which overruled the current Template 

Setting of 12ft. 
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8.25 Group Exercise: Target Aliasing and Corridor Clipping 

1. Within the Randolph\data_08 folder, open the file: Corridors_J2P0200.dgn 

2. Select the Locate Station Via Datapoint icon  from the Corridor Cross Section 

tasks group. 

3. Select the Route 63 corridor when prompted to Locate Corridor or Alignment. 

4. Key in 60+00 R1 for the station and click to accept. 

5. Open another MicroStation View and data point in the view to display the cross section. 

 

6. Select the Define Target Aliasing icon   from the Corridor Misc. tasks group. 

7. Select the Route63 corridor when prompted to Locate Corridor. 

8. Select the Corridor – Road 1 and click the Add button. 

 

 

 

 

 

 

 

 

 

 

 



GEOPAK Road 1 Chapter 8 –Designing with Corridor Modeling 
 
 

5/6/16 Missouri Department of Transportation 8-27 

9. Select the Terrain Model – J2P0200 and click the Add button and click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Review the Cross Section. 

 

11. Select the Add Clipping Reference icon  from the Corridor Misc tasks group. 

12. Select the Road 1 Corridor when prompted to Select Corridor To Be Clipped. 

13. Select the Route 63 Corridor when prompted to Locate First Clipping Reference and 

reset to complete. 
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14. Review the cross section.   

Note: You may have to move to the next station to refresh the cross section view to 

see the Clipping Reference. 
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8.26 Group Exercise: View Right of Way in Plan and XS View 

1. Within the Randolph\data_08 folder, open the file: Corridors_J2P0200.dgn 

2. In View 1 (Default), reference in the Land_Boundary_J2P0200.dgn. 

3. Select the Open Cross Section View icon from the Corridor Cross Section tasks group. 

4. Select the Route 63 corridor when prompted to Locate Corridor or Alignment. 

5. Open another MicroStation View and data point in the view to display the cross section. 

6. Review Right of Way Line Information. 

Note: Below is a list of Right of Way Lines that will draw in a Cross Section View.   

 

R/W_Property_Limit_Access_Existing 

R/W_Controlled_Access_Existing 

R/W_Controlled_Access_Proposed 

R/W_Line_EXISTING 

R/W_Line_Proposed 

R/W_No_Right Of Access_Existing 

R/W_No_Right_Of_Access_Proposed 

R/W_Temporary_Access_Existing 

R/W_Temporary_Access_Proposed 

 

 

 

 

 

 

 

Section_Line 

State_Line 

Township/Range_Line 

US_Survey_Line 

 

Easement (Exist.) 

Easement (Permanent Line Access) 

Easement (Permanent) 

Easement (Temporary) 
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9.9 Objectives 

 Create cross sections along a previously designed corridor.    

 Annotate proposed cross sections. 

9.10  Cross Sections Overview 

Corridor Modeling Cross Section commands extract, display, annotate, and update cross sections. 

These commands also allow you to export data from cross sections to a surface. 

A cross section is a two-dimensional window of graphics representing a planar section of a three-

dimensional (3-D) model. Typically, the 3-D objects displayed in cross section are terrain models 

and objects such as the existing terrain or a proposed road. The graphics showing a terrain model 

in a cross section is a cross section surface. 

Cross sections are extracted across a horizontal alignment or some other linear feature. (Cross 

sections can be extracted at a skewed angle, but they are typically perpendicular to the 

alignment). The width of the cross section window is defined relative to the linear feature. For 

example, you might want your cross sections to span the range from 50 feet left of the alignment 

to 50 feet right of the alignment. The height of the cross section represents a range of elevation, 

for example from 380 to 400 feet. 

When you create one or more cross sections, you choose which surfaces to display. Each cross 

section displays the selected surfaces as they pass through the window. Each surface is 

represented in the cross section by a data line known as a cross section surface. 

Cross sections serve several purposes during a project. They allow you to examine your model in 

detail. For example, you can verify that a ditch you have designed is being placed properly or that 

your roadway side slope is at the correct grade. You can annotate the points and lines in cross 

sections by slope as well as offset and elevation.  

Other important uses for cross sections are computing cut and fill volumes. 
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9.11 Create Cross Sections  

Extracts multiple cross sections and draws them in 

a matrix pattern. These sections are subsequently 

used for cross section sheets and earthwork calculations. 

Only the surfaces that you select when you initiate the 

command are displayed in the cross sections. 

Typically, you use this command to extract cross sections 

along the active horizontal alignment; however, this 

command can generate cross sections along graphic 

elements. 

Features are projected based on Feature Definition Settings.  

Symbology        Cross Section Tools 

The Create Cross Sections command determines the surface symbology from a terrain model or 

an object. This gives predictable symbology results since the terrain model is driving the 

symbology.  

The cross section creation application requires the selection of an alignment in which the user 

desires to cut cross sections along.  In any given design, the user has the option to create all of 

their planimetrics and alignments in a 2D model or a 3D model.  If the user decides to work in 

2D, then a 3D model will be automatically created in the background for the user and maintained 

by the product as design changes are made.  In this scenario, the user should reference in the 2D 

model because that is where the alignment is stored.   

A 2D model is used for design as suggested as a “Best Practice”. When cross sections are created, 

the application “slices” the 3D model to determine the components to display on the cross section.  

It is required to reference in the proposed alignment.  If that alignment is in the 2D model, then 

simply referencing that model is not sufficient. In our 2D design model, we have referenced in 

automatically the 3D model once vertical geometry is created.  For the Create Cross Section 

application to have access to this 3D model, it must be referenced to the cross section drawing as 

well.  The most efficient way to accomplish this and make sure no references are missed.  

Finally, once the design model is attached, the user should at this time set each level display to the 

desired preference.  The create cross section application works on a WYSIWYG premises.  For 

example: suppose in your design, a guardrail was placed in your 3D model.  However, it was not 

desired to see this guardrail on your proposed cross sections.  By simply turning this level off and 

saving your settings, when cross sections are created, this level will not be displayed.  The level 

settings need to be made at the 3D model level.  Once each level setting is verified, make sure to 

Save Settings in the DGN file for those preferences to be remembered. 

The Create Cross Section application acts as a “cookie cutter” based on a WYSIWYG 

functionality.  The Create Cross Section application slices through the 3D design model at 

specified even intervals or customized cross section locations.  It is important that a template drop 

location exists in the design corridor at each station location where proposed cross sections are 

intended to be generated. We do this to avoid interpolation between template drop locations. For 
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example, if a design called for a template drop every 20 feet but the user wanted to create cross 

sections at a 10 foot interval, every other section would be interpolated and risks a chance of the 

proposed finished grade and existing ground not precisely connecting. In the MoDOT workspace, 

several design stages exist that may be assigned to any Corridor, which will directly affect the 

template drop interval multiplier. 

Corridor Design Stages directly affect the interval of template drops.  When creating a Corridor, 

one of the prompts will ask the user for the Template Drop Interval.  The user should always key 

in the desired final interval.  Then, based on the selected Corridor Design Stage selected, the 

template drop interval will be increased by the design stage template drop interval multiplier.  For 

example, the template drop interval multiplier for the Preliminary Design Stage is 40.  So if a user 

puts in a final template drop interval of 10 and then selects the Preliminary Design stage, the 

corridor design will contain a template drop every 400 feet or 10 x 40 = 400.  This concept has 

been adopted to allow for very fast model processing in the Preliminary Design stage. 

Consequently, the multiplier for the Design Stage is set to 2, and the multiplier for the Final 

Design Stage is set to 1.  These settings are stored in a DGNLib for Project Settings in the 

included MoDOT_workspace.  Each customer will likely want to review and modify these 

settings based on their individual workflows for in-house design work. 

When cross sections are created, the application automatically creates a DGN Drawing Model and 

writes the cross sections to that Model.  The user is granted the opportunity to name the Drawing 

Model before it gets created.  By default, the name will correspond to the name of the alignment 

the cross sections are being developed along.  It is acceptable practice to cut multiple sets of cross 

sections in the same DGN file.  Each time cross sections are created, they will be drawn to a new 

and differently named DGN Drawing Model. 

 

Finally, the created proposed cross sections are not presently “dynamic”.  Thus, if the design 

model changes, the user would be required to re-create the cross sections.  GEOPAK SS4 does 

contain a Dynamic Cross Section viewer, which does dynamically update as the model undergoes 

continued design updates.  Before re-creating the proposed cross sections, the user may choose to 

delete the previously created DGN Drawing Model. If the user intends to create an output of cross 

sections, such as, creating cross section sheets, legacy tools must be used. 

GEOPAK>ROAD>Cross Sections. 

 

Cross Section Workflow 

1. Create a new cross section DGN file. 

2. Reference in the proposed design to the cross section DGN file. 

3. Setting the appropriate levels on or off for cross section display preferences. 

4. Create the proposed cross sections from the 3D design model. 

Each DGN file contains one or more models, each of which has its own set of eight views. 

You can create a model as a 2D or 3D Design type, as a 2D Drawing type or as a 2D or 3D 

Sheet type. Sheet models let you attach references to create a set of working drawings for the 

model file. Icons at the top of the Models dialog give you access to its various functions. 
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5. Navigate the proposed cross sections. 

6. Annotate the proposed cross sections. 

7. Compute end-area volumes of the proposed cross sections. 

9.12 Create Cross Sections Dialog   

General Leaf 

 

 
 

 
 

 

1. The Preference dialog must be 

opened to be able to choose a 

predefined setting.   

3. MoDOT utilizes 3 different 

scaled sheet labels, 1 Geopak 

cross section cell and 1 

Geopak cross section cell with 

a grid and axis. 

When you choose a predefined 

setting it will show you which 

setting has been selected in the 

Preferences dialog at the 

bottom. 

2. Select a preference then 

select the Load button to load 

the preference. 
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Spacing Leaf - Use this dialog to define the settings for stacked or sheet modes. 

 

 

 

 
 

 

 

 

 

 

 

Distance between sections 

Stationing 

Annotation Scale at creation, impacts text sizes, 

and offsets plus multiplies the tick lengths. 

 

This defines the number of cross sections that display 

in each column of the matrix.   

Geopak cell 

offsets 

These options define the 

horizontal and vertical 

offset from one cross 

section to the next. 

 Window Clearance adds 

additional space at the top 

and bottom of each 

extracted cross section 

(inside each cross 

section).  The predefined 

preference already has the 

default set. 

 

Direction specifies the direction to 

display stacked cross sections. 
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Controls Leaf 

Grid - Use this dialog to control the display of grid lines in the cross section. You can display grid lines to 

correspond to major or minor ticks marks (which are defined on the Axes General leafs), and you can optionally clip 

horizontal and vertical grid lines so that they display only within the bounds of the cross-section surface data. 

  
 

Plan Display – If checked on, this option will create elements and/or labels in the Plan.DGN. 

 

 
 

Critical Sections – Use this dialog to control the occurrence of critical sections in cross sections. 

 

 
 

 

Major and Minor grid line attributes 

The predefined preference already 

has the default set. 
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Horizontal Cardinal Points - extracts cross sections at the cardinal points of the horizontal 

alignment specified on the General leaf (PC, PT, and so forth). 

 

Vertical Cardinal Points - extracts cross sections at the cardinal points of the active vertical 

alignment corresponding to the horizontal alignment specified on the General leaf. 

 

Symbols and Details – This option is not used within the MoDOT default set up. 

 

 
 

Axes Leaf - General 

 

Use this dialog to control which parts of each cross section axis to display and in what format. 

For each axis, you can display a number of features, including the axis line itself, a title text 

string and title box (next to the axis), annotation text for the data associated with the axis, and the 

major and minor ticks that are displayed along the axis. 

 

 
 

 

 

 

 

 

 

Major Ticks 

 

Length - defines the length of 

major tick marks. If the length 

is zero, the tick length will be 

one half of the label text height. 

 

Position - places major tick 

marks inside, outside, or on 

both sides of each axis. 

 

Spacing - specifies the distance 

between major ticks along the 

axis. For top and bottom cross 

section axes, a major tick is 

always placed at the axis 

endpoints, regardless of the 

stationing values at those points, 

while for top and bottom cross 

section axes, a major tick is 

always placed first at the 

centerline point. This parameter 

determines how to place all 

subsequent major tick marks 

along the axis. 

 

Minor Ticks 

 

Length - defines the length of minor tick marks. If the length is zero, the tick 

length will be one half of the label text height. 

 

Position - places minor tick marks inside, outside, or on both sides of the 

axis. 

 

Minors/Major - specifies the number of minor tick marks to display between 

neighboring major tick marks. 
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Axes Leaf – Symbology 

 

Use this dialog to specify the symbology settings for the Axes. These settings have been set up to 

MoDOT’s standards once the preference has been selected. 

 

  
 

 

 

 

 

Elevation Label - defines a text string for each axis other than the bottom axis.  The stationing value serves as 

the title for the bottom axis. 

 

Prefix - specifies a text string to place at the beginning of the axis annotation text. 

 

Suffix - specifies a text string to append to the axis annotation text. 

 

Precision - specifies the number of digits to follow the decimal point in the axis annotation text. 

Title Text - specifies text for individual axis. 

Mirror Left to Right - displays the identical 

settings on the Right axis.  

This option is only available if the label uses a text 

style. 

 

This option is not available if the label uses a text 

style. 

Double clicking the object brings up the 

Text Symbology dialog. 

Offsets of Horizontal and Vertical control 

where the text is located on the sheets. 
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Sheet Leaf 

 

Border 

 

 
 

 

 

Layout 

 

 
 

 

 

 

 

 

MoDOT’s border file located in 

ProjectWise is attached with using the 

“read only” option checked on. 

pw:\\GHPWISE10.dot.missouri:MoDOT\Documents\CADD_Standards\Borders\MoDOT_DE_2008.dgn 

Sheets per Column - 

defines the number of 

sheets per column for 

stacking sheets. If 1 is 

selected, sheets are 

placed horizontally and 

if a number greater than 

the number of sheets 

produced is selected for 

sheets per column, 

sheets are placed 

vertically. This gives 

you the ability to create 

sheets in a grid display 

instead of a long row or 

column for plotting. 

 

Scale - defines the size 

exaggeration for the cross section. 

 

Horizontal - defines the horizontal offset 

from one drawing sheet outline to the 

next. 

 

Vertical - defines the vertical offset from 

one drawing sheet outline to the next. 

 

Margins 

 

Left - defines the margin between the left border 

and the cross sections. 

 

Right - defines the margin between the right border 

and the cross sections. 

 

Top - defines the margin between the top border 

and the cross sections. 

 

Bottom - defines the margin between the bottom 

border and the cross sections. 
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Range - Use this dialog to specify the settings for displaying station range annotation on each 

sheet of cross sections. 

 

 
 

Annotation - Use this dialog to define settings for title block annotation that is automatically 

generated on cross section sheets. You can also define unique fields for annotation, such as 

project name, and so on. This feature is available only when borders are attached as reference 

files, and the tags are in the referenced border 

 

  
 

 

 

Horizontal - specifies the 

horizontal offset from the left of 

the sheet for the sheet annotation. 

 

Vertical - specifies the vertical 

offset from the bottom of the sheet 

for the sheet annotation. 

 

Precision - specifies the number 

of digits to the right of the decimal 

point in the annotation text. 

 

Format - specifies the station 

format of the annotation text. 
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The Tag values will need to be filled out the title block information. 

Select a Tag Name and enter a value then select the “Update” button to apply the changes to the 

tool settings. 

 

 
**Note – If a field is left blank then it will not place any text where the Tag location was 

defined.   

 

The last 3 Tags will be predefined with the value needed to compute the sheet number and total 

sheets along with the verbiage “SHEET OF.” 
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After the Tag values are completed the user can save a DAT file which saves the dialog 

information so that the values can be easily recalled and used again.   

 

The attached DAT file will be the default MoDOT.DAT file that resides on the 

T:\MoDOT_Workspace\Modeling\Cross Sections and cannot be overwritten so you will need to 

save a copy to your Job > Data folder. 

 

 
 

Once the file is saved your data folder the tool will revert back to that location when opening the 

tool the next time. 

 

The pick button allows the user to load the MoDOT default DAT file by navigating to the 

T:\MoDOT_Workspace\Modeling\Cross Sections folder and selecting the MoDOT.DAT file. 

 

 
 

Once the cross sections have been defined, the information has been defined in the dialog and the 

DAT file saved to the data folder the tool is ready to use. 

 

Click on the Apply button to create the cross section model.  The border will be referenced into 

the model with instances created for each sheet that is created.   
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The title block information will be filled out according to your settings and the informational 

block will be created in the lower right, vertically with the defined settings that were defined in 

the dialog. 

 

**Note – The Make PDF Request can only handle 50 borders at one time so it is recommended 

that you run all the cross sections in one model and then save as a copy (some may have 3 files 

for cross sections) from the original.   

 

Open the model containing the cross sections and remove the extra cross sections leaving the 

cross sections needed for the Make PDF Request tool. 

9.13 Annotate Cross Sections   

Annotate Cross Sections places text describing the characteristics of cross sections that were 

previously placed in the drawing file. These characteristics can include slope, width, elevation, 

and offsets. The cross sections may have been placed with any of the cross-section extraction and 

display options. Annotation allows you to know the characteristics of your design as you examine 

cross sections. 

Annotation for features obeys the design file annotation scale factor. 

Which Elements Are Annotated? 

The following controls what annotation appears in the cross section: 

The Points, Features, and Segments leafs are used as master switches to turn on or off annotation 

for points, segments, or features. For example, if Include Points is not checked, no point 

annotation appears in cross sections. If Include Points is checked, points will be annotated. 

 

The parameters on the Points, Features, Segments, and Frame leafs restrict which elements are 

annotated. 

The Annotate Cross Section command can annotate multiple surfaces in a single pass. On the 

General dialog is a list view, which lists each surface in the cross section set and a preference. 

The preference listed is either the active preference for the command or the preference defined in 

Surface Properties for that surface, depending on style lock. This list view allows you to select 

multiple surfaces to annotate. 

The Annotate Cross Section application has the ability to label any particular cross section model 

present in the active DGN file including models that are not active.  In addition, we have the 
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ability to label any surface found within all models of our DGN file.  The annotation application 

is highly versatile to meet many different types of labeling needs.  For example, the cross section 

annotation application can label the individual objects along the cross section, along a bottom 

axis, or in a frame mode.  It is possible to label points along a surface, crossing linear features, 

and component segments like the slopes of a proposed pavement for example.  The supported 

combinations are endless regarding all that can be labeled along a cross section.   

 

 

 

 

Preferences are stored in the MoDOT workspace in a XIN file. Several preferences are provided 

in the MoDOT workspace.  The scales of 5, 10 and 20 support the cross section settings in the 

MoDOT create cross section tool. 

 

 

Choose the Model of the 

Cross Section to annotate. 
Choose Surface to 

be annotated. 

Object - Places annotation text along the 

graphics in the cross sections 

Axis - Places annotation text along the 

bottom axis of the cross section.  This 

option places text for points and features 

only, not segments. 

Frame - Places annotation text in rows 

with frames around them.  The size and 

orientation of the frames are defined using 

the Frame leaf dialog boxes. 
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Points – Used to label points on cross sections. 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Include Points - If checked, 

includes points when 

annotating cross sections.   
The last column 

in the grid is the 

means of access 

to the symbology 

dialog. 

Offset Tolerance - if checked, will not annotate points within the 

defined tolerance. This applies to points coming from the surface line 

or from the ASCII file. 

Object - displays object attributes in rows. The first column has check 

boxes indicating which attributes are to be included in the annotation. 

Leader - leader line for the annotation to follow. 

Center - annotation of the centerline (zero offset) of the cross section. 

Offset - annotation of the offset of any point in the cross section. 

Elevation - annotation of the elevation of any point in the cross section. 

Station - the station of the feature relative to the alignment. 

Skew Offset - annotation of the offset of each point in the cross section. 

The offset is measured along the cross section (not by normal projection). 

Position - controls the position of 

the annotation text. A value of zero 

does not affect the text position. A 

value of 1 moves the text so that it 

displays one line above its original 

position. A value of 2 moves the text 

two lines above its original position, 

and so forth. Negative values move 

the text in the opposite direction. 

Drop Station Equation Name - if checked, 

drops the station equation name. If an equation 

name exists at the station, it is not formatted as 

part of the station. For example, station "a10+00" 

is formatted as "10+00.00" when this option is 

toggled on. When this option is toggled off, 

station "a10+00" is formatted as "a10+00.00". 

Leader Length - specifies the 

length of the leader line from the 

annotation text to the point being 

annotated. If you key in zero, the 

line is sized automatically according 

to the length of the annotation text. 
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Features - This dialog box is designed to use the grid control.  As on the Points and Segments 

dialogs the fields for position, prefix, suffix and precision are combined into one control with the 

symbology for each field.  

 

 

 

 

 

 

The following controls what annotation appears in the cross section: 

The Points, Features, and Segments leafs are used as master switches to turn on or off annotation 

for points, segments, or features. For example, if the Include Points is not checked, no point 

annotation appears in cross sections. 

 

Include Features - If 

checked, includes features 

when annotating cross 

sections.   

Leader Length - specifies the 

length of the leader line from the 

annotation text to the point being 

annotated. If you key in zero, the 

line is sized automatically 

according to the length of the 

annotation text. 

Drop Station Equation Name - if checked, drops the 

station equation name. If an equation name exists at the 

station, it is not formatted as part of the station. For 

example, station "a10+00" is formatted as "10+00.00" 

when this option is toggled on. When this option is 

toggled off, station "a10+00" is formatted as 

"a10+00.00". 

The user can select individual 

crossing features, select all or select 

none from this list. 
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Segments - The Segments General leaf is designed to use the grid control. As on the Points 

dialog, the fields for position, prefix, suffix, precision, and format are combined into one control 

with the symbology for each field. The appropriate tolerances are added to the Segments dialog. 

 

 

 

 

 

 

 

 

 

 

Include Segments - If 

checked, includes segments 

when annotating cross 

sections.   

Object - displays object attributes in rows. 

The first column has check boxes 

indicating which attributes are to be 

included in the annotation. 

 

Width - annotation of the width of any 

segment in the cross section. 

 

Slope Length - annotation of the slope 

length of segments in the cross section. 

 

Slope - annotation of the slope of 

segments in the cross section. 

 

Alternate Slope - annotation of the slope 

of certain segments in the cross section, 

depending on whether or not Use 

Alternative Slope if Slope Exceeds has a 

specified value. 

 

Position - controls the position of the annotation 

text. A value of zero does not affect the text 

position. A value of 1 moves the text so that it 

displays one line above its original position. A 

value of 2 moves the text two lines above its 

original position, and so forth. Negative values 

move the text in the opposite direction. 

 

Prefix - specifies text to insert at the beginning of 

the annotation. 

 

Suffix - specifies text to add at the end of the 

annotation. 

 

Precision - controls the number of digits to the 

right of the decimal point in the annotation. 

 

Format - specifies the format for the displayed 

annotation. 

 

Name - specifies the named symbology for the 

specified object. 
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Using MoDOT’s default preferences will allow for quick and easy annotations. 

 

 

 

 

 

 

 

 

Display Absolute Slopes - if checked, displays the absolute values of slopes. 

 

Use Alternate Slope if Slope Exceeds - allows a different set of parameters to control slope annotation 

depending on whether or not each slope of each segment is greater than or less than a specified value. This 

option allows you to annotate all segments whose slopes are less than 20%, for example, using one set of 

parameters, while using another set of parameters to annotate all segments whose slopes are greater than 

20%. The two sets of parameters involved are those in the Slope column and those in the Alternate Slope 

column in the Display Controls group box. Specify any slope you want for the “r;slope exceeds” value. 

 

Minimum Annotation Width - if a segment's width is less than the defined value it will not be annotated. 

 

Slope Tolerance - if checked, activates the slope tolerance check. If the difference in slope on adjacent 

segments is less than the slope tolerance only one slope value will be displayed. 
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9.14 Cross Section Viewer  

The Cross Section Viewer command windows in on specified cross section set in the Model. 

Using the Cross Section Viewer, you can view a single cross section, or you can view in 

succession each cross section in a model. The latter method, called Movie Mode, displays each 

cross section for a specified time. 

 

Dialog Options 

Cross Section Model defines which set of cross sections to view. Select one of the available 

models. 

Horizontal Alignment displays the horizontal alignment associated with the selected cross 

section.   

Zoom Factor defines the zoom factor for adjusting the drawing file view. Enter a value greater 

than 1.0 to zoom out from the cross sections. Enter a value less than 1.0 to zoom in toward the 

cross sections. Only applies to the cross section view. 

Plan View shows the plan location of the cross section viewed. Draws a temporary line in the 

plan view where the cross section is located and centers that line in the plan view. 

Movie Mode Time specifies the time for viewing each cross section in the selected cross section 

set. You can enter time values in tenths of a second. 

Run starts the movie mode of the cross section viewer.  Selecting the <Esc> cancels the run 

Cross Sections lists each cross section in the selected cross section set. Select a single cross 

section to immediately view it 
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9.15 Group Exercise: Cutting Road1 Cross Sections and Annotation  

Create a New Cross Section Design File 

1. Within the J2P0200\data_09  folder, open the file: Plan_J2P0200.dgn 

2. Select File > New and create a new MicroStation file named XS_ J2P0200_Road1.dgn  

Using the seed file: pw:\CADD_Standards\Seed Files\Design - 

English\i_project_2d_PowerGEOPAK.dgn 

 

3. Select OK to create the new dgn file. 

Attaching the Design as a Reference File 

4. In the file XS_J2P0200_Road1.dgn created above. 

5. Choose File > References in the MicroStation pull down menu or use the MicroStation 

icon . 

6. In the References dialog menu choose Tools > Attach. 

7. Select the files in your current working directory;  

Civil_Geometry_J2P0200.dgn  

Corridor_J2P0200.dgn  

Land_Boundaries_J2P0200.dgn 

Pattern_Lines_J2P0200.dgn 

Superelevation_J2P0200.dgn 

Terrain_J2P0200_Existing.dgn 

Then click the OK button 
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8. Close the References dialog. 

9. MicroStation Fit View to pan to the project location. 

10. With the Element Selection  tool, data point on the Existing ground perimeter and set the 

Existing terrain model as the Active Terrain Model using the heads up display. 

 

11. Window in to the Road1 corridor.  

 

Create the Cross Sections 

12. Continue in the same design file XS_J2P0200_Road1.dgn. 

13. From the Corridor Modeling tasks group, select the 

Create Cross Sections command  

14. When prompted to Locate Alignment, data point on the 

centerline of Road1.  

15. Located at the bottom of the Create Cross Section 

dialog, select Preferences. 

 

16. In the Preferences dialog select the preference titled Sheet – 10 Scale. 

17. In the Preferences dialog, click Load to utilize the selected preferences in the previous 

step. 
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Preferences are predefined settings stored in the active XIN settings file. These 

preferences will be used for creating, annotating and computing end area volumes on 

proposed cross sections. 

18. Close the Preferences selection dialog. 

19. In the Create Cross Section dialog, verify the General settings as shown below. 

 

 

 

 

20. Select the Custom leaf and fill in the following values by selecting the elements on the 

level Geopak-Pattern line 1: 
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Also add a station range of cross sections from 0+00 to 35+00 

 

A – Select Station Range from the pull down 

B – Edit the start station 0+00 and stop stationing 35+00 

C – Set the Interval to 50’ 

D – Edit the left offset -140 and the right offset 140 

E – Add the Station Range to the list by clicking the Add button 

F – The entry will display in the list 

21. Remove the Cardinal Points  

G - Navigate to the Controls leaf 

H - Select the Critical Sections option  

I - Uncheck the Horizontal and Vertical Cardinal Points.   
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22. Open the Sheet leaf (folder) and select the Annotation option. Change the Tag Values to 

include the following: 

 

Route = ROAD1 

District = NE 

County = RANDOLPH 

Job No. = J2P0200 

Contract ID = (leave blank) 

Project No. = (leave blank)  

Bridge No. = (leave blank) 

Info 1 = CROSS SECTION SHEETS 

Info 2 = ROAD1 CONSTRUCTION 

Sheet No. = (use default) 

Total Sheets = (use default) 

Sheet Of = (use default) 

 

23. In the Create Cross Section dialog, click Apply to create the cross sections into a new 

DGN Drawing Model entitled ROAD1. 

24. Close the Create Cross Section dialog after the cross sections have been generated. 

 

Note: New cross sections will need to be created if edits are needed. This may be done in the 

Cross Section Model if the tool is still open but if the tool has been closed then you will need to 

open the Default Model. 
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View the Cross Sections 

25. Continue in the same design file XS_Road1.dgn.  

26. From the Corridor Modeling task group, select the Cross Section Viewer tool.  

27. In the Cross Section Viewer dialog, verify the Cross Section Model: setting is set to your 

active Cross Section Drawing Model Road1. 

28. Populate the Cross Section Viewer dialog as shown. 

 

29. Select Run to automatically scan through the cross sections. 

30. Now select any individual cross section station from the list and notice how the view 

updates to the selected cross section station value. 

31. Close the Cross Section Viewer dialog. 

Annotate the Cross Sections 

32. Continue in the same design file XS_Road1.dgn. 

33. From the Corridor Modeling task group, select the Annotate Cross Sections tool.  

34.  Located at the bottom of the Annotate Cross 

Section dialog, click Preferences. 

35. In the Preferences dialog, select the preference 

entitled MODOT-Off/Elev/Slope.  

36. In the Preferences dialog click Load, to utilize 

the selected preferences in the previous step.  

Preferences are predefined settings stored in the 

active XIN settings file. These preferences will 

be used for creating, annotating and computing 

end area volumes on proposed cross sections.  

37. Close the Preferences dialog. 
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38. In the Annotate Cross Section dialog, complete the General settings as shown. 

 

39. Expand the Features folder and select Annotate on the left hand side of the dialog. 

40. Select all of the Crossing Features as shown below. 

 

41. Expand the Segments folder and select Annotate on the left hand side of the dialog. 

42. Select a few Crossing Features using the pick button to show offset/elevations to label. 

43. In the Annotate Cross Section dialog, select Apply to annotate the cross sections in the 

selected DGN Drawing Model labeling offsets, elevations, and slopes.  The cross section 

annotation labels are automatically made part of a MicroStation Graphic Group.  

Additionally, only the selected Features are labeled, so if none are selected all the slopes 

are labeled. 

44. Close the Annotate Cross Section dialog. 

45. In the MicroStation tool bar select Settings > Drawing Scale.  Change the setting from 

1”=10’ to 1”=20’.  What happens to the text size?  Return the setting back to the original 

setting of 1”=10’ when complete. 
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9.16 Individual Exercise 5-1: Cutting Route 63 Cross Sections and 

Annotation 

Create a new Cross Section Design File 

1. Select File > New and create a new MicroStation file named XS_J2P0200_Route63.dgn  

Using the seed file: pw:\CADD_Standards\Seed Files\Design - 

English\i_project_2d_PowerGEOPAK.dgn 

 

2. Select OK to create the new dgn file. 

Attaching the Design as a Reference File 

3. In the file XS_J2P0200_Route63.dgn created above. 

4. Choose File > References in the MicroStation pull down menu or use the MicroStation 

icon . 

5. In the References dialog menu choose Tools > Attach. 

6. Select the files in your current working directory;  

Civil_Geometry_J2P0200.dgn  

Corridor_J2P0200.dgn  

Land_Boundaries_J2P0200.dgn 

Superelevation_J2P0200 then click OK 

Terrain_J2P0200_Existing.dgn 

7. Close the References dialog. 
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8. Use the MicroStation Fit View to pan to the project location. 

9. With the Element Selection  tool, data point on the Existing ground perimeter and set the 

Existing terrain model as the Active Terrain Model using the heads up display. 

 

10. Window in towards the bottom of the project to see the area we will be identifying on the 

alignment. 

Create the Cross Sections  

11. Continue in the same design file XS_Route63.dgn. 

12. From the Corridor Modeling tasks group, select Create Cross Sections command  

13. When prompted to Locate Alignment data point on the centerline of Route 63. 

14. Select Preferences at the bottom of the Create Cross Section dialog. 

15. In the Preferences dialog, select the preference entitled Sheet – 10 Scale. 

16. Click Load to utilize the selected preferences in the previous step. 

Preferences are predefined settings stored in the active XIN settings file. These 

preferences will be used for creating, annotating and computing end area volumes on 

proposed cross sections. 

17. Close the Preferences dialog. 

18. In the Create Cross Section dialog, complete the General settings as shown. 
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19. Select the Custom leaf and fill in the values by selecting the elements on the level 

Geopak-Pattern line 2: 

Also add a station range of cross sections from 10+00 to 60+00 

 

A – Select Station Range from the pull down 

B – Edit the start station 10+00 and stop stationing 60+00 

C – Set the Interval to 50’ 

D – Edit the left offset -140 and the right offset 140 

E – Add the Station Range to the list by clicking the Add button 

F – The entry will display in the list 

20. Remove the Cardinal Points  

G - Navigate to the Controls leaf 

H - Select the Critical Sections option  

I - Uncheck the Horizontal and Vertical Cardinal Points.   
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21. Open the Sheet leaf (folder) and select the Annotation option. Change the Tag Values to 

include the following: 

 

Route = RTE63 

District = NE 

County = RANDOLPH  

Job No. = J2P0200 

Contract ID = (leave blank) 

Project No. = (leave blank)  

Bridge No. = (leave blank) 

Info 1 = CROSS SECTION SHEETS 

Info 2 = ROUTE 63 CONSTRUCTION 

Sheet No. = (use default) 

Total Sheets = (use default) 

Sheet Of = (use default) 

 

22. In the Create Cross Section dialog, click Apply to create the cross sections into a new 

DGN Drawing Model entitled ROUTE63. 

23. Close the Create Cross Section dialog after the cross sections have been generated. 

View the Cross Sections 

24. Continue in the same design file XS_Route63.dgn.  

25. From the Corridor Modeling task group, select the Cross Section Viewer tool.  

Select the Tag Name 

Input the Value 

Click Update button 

Value has been updated 
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26. In the Cross Section Viewer dialog, verify the Cross Section Model: setting is set to your 

active Cross Section Drawing Model RTE63. 

27. Populate the Cross Section Viewer dialog as shown. 

 

28. Select Run to automatically scan through the cross sections. 

29. Now select any individual cross section station from the list and notice how the view 

updates to the selected cross section station value. 

30. Close the Cross Section Viewer dialog.  

Annotate the Cross Sections 

31. Continue in the same design file XS_Route63.dgn.  

32. From the Corridor Modeling task group, select the Annotate Cross Sections tool.  

33. Located at the bottom of the Annotate Cross Section dialog, click Preferences. 

34. In the Preferences dialog select the preference entitled MODOT-Off/Elev/Slope.  

35. In the Preferences dialog select Load, to utilize the selected preferences in the previous 

step. 

36. Close the Preferences dialog. 

37. In the Annotate Cross Section dialog, complete the General settings as shown. 
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38. Expand the Features folder and select Annotate on the left hand side of the dialog. 

39. Select a few Crossing Features using the pick button to show offset/elevations to label. 

40. In the Annotate Cross Section dialog, click Apply to annotate the cross sections in the 

selected DGN Drawing Model labeling offsets, elevations, and slopes.  The cross section 

annotation labels are automatically made part of a MicroStation Graphic Group.  

Additionally, only the selected Features are labeled. 

41. Close the Annotate Cross Section dialog. 

42. In the MicroStation tool bar select Settings > Drawing Scale.  Change the setting from 

1”=10’ to 1”=20’.  What happens to the text size?  Return the setting back to the original 

setting of 1”=10’ when complete. 
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10.1 Objectives 

 Learn the procedures for calculating earthwork quantities with GEOPAK 

 Learn how to generate a volumes report 

10.2 End-area Volume 

The End-Area Volumes tool performs the traditional end-area 

volume calculation to compute cut, fill, and net volumes using 

a series of cross sections extracted along a previously defined 

alignment. A complete report listing all computed quantities 

on a station-by-station basis can also be generated with this 

command.  

10.2.1 Preferences 

Preferences are predefined settings stored in the active XIN 

settings file delivered in the MoDOT workspace.  These 

preferences will be used for creating, annotating and 

computing end-area volumes on proposed cross sections. 

Workflow 

Select Preferences located at the bottom of the End-Area Volumes dialog. 

In the Preferences dialog, select the preference named MODOT-Earthwork and click Load 
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Before Using This Command 

Create cross sections using the Create Cross Sections 

command. Make sure that you have a corridor and a 

Surface to run volumes against.  Display the components in 

the cross section so that you can determine the subgrade 

and compute the quantities of component materials, such as 

asphalt. 

Typically, you use this command to calculate excavation and analyze your design after you create 

a corridor. 

Once the Terrain Model is created, you can extract cross sections along the alignment, displaying 

these surfaces in each cross section. A surface displayed in a cross section is called a cross-section 

surface.                             

Because this command calculates volumes between any combinations of Surfaces, you can use it 

to compute the materials required in your roadway design.  

The End–Area Volumes application has numerous options available to handle most 

combinations of calculations required in the typical design process.  The user will be given the 

option to decide which surface(s) to perform calculations along.  This is most beneficial for staged 

construction volume calculations. 

Special circumstances such as Unsuitable Materials, Volume Exceptions, Added Quantities, 

Forced Balance, As-Built, Mass-Haul Diagram, Reporting, etc. are supported in this application.   

10.3 End-Area Volume Dialog Options 

10.3.1 General (End-Area Volume) 

Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a set of cross 

sections to use as the basis for End-Area volume calculations. When you select a cross section 

model from this list, the command places a region/fence in the drawing file around the cross 

sections that compose the model.  

Surface/Type Under the General Section lists surfaces and corridors in the selected cross section 

model. The default type for a new surface is ”Existing”. The default type for surfaces created by 

Corridor Modeling is “Design”. You may change the types to: Existing, Design, Substratum, 

None, or Subgrade using the Surface Properties command.  



GEOPAK Road 1 Chapter 10 – Earthwork  
 
 

4/12/16 Missouri Department of Transportation 10-3 

 

You may have multiple existing, designs, or substrata in a given cross section model. However, 

you must have only one existing surface for any given cross section at a given station in order to 

compute volumes. If you have more than one design surface in a section, they should not overlap. 

Display the components from the design surface in the cross section so that the subgrade path can 

be determined. The subgrade is determined starting at the left side of the design surface and 

following the rightmost path along the surface and its components. This path is then compared 

against the existing surface and any substrata to compute the areas of volume. 

When the Type is set to “subgrade”, end-areas follow the design type until a subgrade type is 

encountered. End-areas follow the subgrade type until it encounters a design type. If a design type 

is not connected then end-areas utilizes a vertical drop.  

Method – Located on the General Selection 

Standard employs the average end-area method for computing volumes. 

Correct for Curvature compensates for sections in a curve by computing the centroid 

offset and applying the correction to cut and fill.  

Limits – Located on the General Selection 

Station Range limits the sections for which volumes are calculated by defining start and 

stop stations. 

Start specifies the starting station of the section. 

Stop specifies the stopping station of the section. 

Ignore Areas Smaller Than specifies an area that you do not want reported. 

Create XML Report – Located on the General Selection this button indicates whether or not an 

XML report is created and if it is created, it will open the Bentley Civil Report Browser. The 

XML file contains cross section information and more detailed volume information. 
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Plot Mass Haul Diagram –This diagram is not used by MoDOT. 

10.3.2 Unsuitable Materials by Station (End-Area Volume) 

Use this dialog as an additional method to calculate unsuitable materials. Unsuitable materials of a 

specified style can be removed from the existing surface for the entire construction limits over a 

specified station range. You can specify separate cut and fill depths. Unsuitable Materials defined 

on this dialog supersedes any defined by the Unsuitable Materials By Feature command. 

Unsuitable material located under fill (embankment) is included in the Mass Ordinate calculation. 

This occurs because materials stripped from under fills automatically increase the amount of 

material required for a given embankment area. For more details, see the Classifications topic. 

Cross Section Model lists all the existing cross-section models, which are models of 

extracted cross sections that are assigned unique identification numbers. From this list, 

select a cross section model to use as the basis for end-area volume calculations. When 

you select a cross section model from this list, the command places a region/fence in the 

drawing file around the cross sections that compose the model. The command also 

displays the horizontal alignment and surface(s) used when the cross sections in the model 

were extracted. 

 

Settings: 

Start Station identifies the start station. Select a station from the list or use the locate 

button to identify the station. 

Stop Station identifies the end station. Select a station from the list or use the locate 

button to identify the station. 

Style specifies the style of the unsuitable material. 

Cut Depth specifies the cut depth for the material. 
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Fill Depth specifies the fill depth for the material.  

Unsuitable Materials lists all of the specified added unsuitable material sections. 

Add adds a single section to the list based on the settings provided. 

Change modifies the selected section to the settings provided. 

Delete removes the selected section from the list. 

10.3.3 Classifications (End-Area Volume) 

Use this dialog to control how volumes are calculated and reported for individual materials. 

Individual materials are those not normally included in the unclassified cut and fill volumes. 

These include substrata materials, component materials, and materials calculated from the 

Material Features leaf. 

The Cross Section Model lists all the existing cross-section models, which are groups of 

extracted cross sections that are assigned unique identification numbers. From this list, select a 

cross section model to use as the basis for End-Area volume calculations, or select the set 

graphically. When you select a cross section model from this list, the command places a 

region/fence in the drawing file around the cross sections that compose the model.  

 

(Materials List) 

Object lists all available materials. For components specified as Undercut (for moisture 

density control), the component is removed from the normal cut totals.  You can separately 

report on this portion of the component. 
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Source lists all surfaces containing material features. The existing surfaces are displayed first, 

followed by substrata surfaces, then cross section surfaces. 

Parent identifies the corridor containing the component material. 

Classification defines to which group the materials are reported: None, Unclassified, Rock, 

Designed, and Unsuitable. If you set the classification to Ignore, it is not reported. 

Mass Ordinate allows you to include the material into the mass ordinate and total volume 

calculation. Unsuitable material located under fill (embankment) is included in the 

calculation. This occurs because materials stripped from under fills automatically increase the 

amount of material required for a given embankment area. In this case, the Include/Exclude 

toggles are not available. 

Cut Factor specifies the cut factor for the surface. Substrata, existing surfaces, and material 

features use a cut factor. Compaction/Expansion parameters can override this value for 

existing surfaces. 

Fill Factor specifies the fill factor for the surface. Components and existing surface use a fill 

factor. Compaction/Expansion parameters can override this value for existing surfaces. 

10.3.4 Compaction/Expansion (End-area Volume) 

Use this dialog to specify aggregate cut and fill factors for given materials over a range of 

stations. This is necessary since most existing surfaces are topological surveys which do not 

regard the materials that make up the surface. 

Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a cross section 

model to use as the basis for End-Area volume calculations. When you select a cross section 

model from this list, the command places a region/fence in the drawing file around the cross 

sections that compose the model. The command also displays the horizontal alignment and 

surface(s) used when the cross sections in the model were extracted.  
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Settings 

Start Station identifies the start station. Select a station from the list or use the locate button 

to identify the station. 

Stop Station identifies the end station. Select a station from the list or use the locate button to 

identify the station. 

Cut Factor scales computed cut volumes. This parameter defines how much the volume of 

the cut material will increase after it is removed from the ground. For example, a value of 1.3 

means that the cut material will swell 1.3 times its original value. The default value is 1.0. 

Fill Factor scales the computed fill volume. This parameter defines how much the volume of 

the fill material will decrease after it is placed into the site. For example, a value of 0.8 means 

that the fill material will shrink to 0.8 times its original value. The default value is 1.0. 

Description allows you to specify the material description for reporting purposes. 

Compaction/Expansion lists all of the specified cut and fill factors.  

Add adds a single compaction/expansion factor to the list based on the settings provided. 

Change modifies the selected factor values to the settings provided. 

Delete removes the selected factor from the list. 
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10.4 Volume Exceptions (End-area Volume) 

Use this dialog to specify sections where you do not wish to compute volumes.  For a given 

volume exception, the volume at the start station is computed.  The volume of all stations greater 

than the start station and less than or equal to the stop station is not computed. 

The most common example of a volume exception is a bridge. Because no fill material is 

required under a bridge, you would not want to compute "fill" volume within these station limits. 

Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a cross 

section model to use as the basis for End-Area volume calculations. When you select a cross 

section model from this list, the command places a region/fence in the drawing file around the 

cross sections that compose the model. The command also displays the horizontal alignment and 

surface(s) used when the cross sections in the model were extracted.  

 

 

Settings 

Start Station identifies the start station. Select a station from the list or use the locate 

button to identify the station. 

Stop Station identifies the end station. Select a station from the list or use the locate 

button to identify the station. 

Volume Exceptions lists all of the specified volume exceptions. 
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Add adds a single volume exception to the list based on the settings provided. 

Change modifies the selected volume exception values to the settings provided. 

Delete removes the selected volume exception from the list. 

10.4.1 Added Quantities (End-area Volume) 

Use this dialog to add additional cut or fill values to the adjusted volumes. Added quantity may be 

injected at a single station (Start and Stop Station are the same) or distributed linearly over each 

section in the range that you specify. 

Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a cross 

section model to use as the basis for End-Area volume calculations. When you select a cross 

section model from this list, the command places a region/fence in the drawing file around the 

cross sections that compose the model.  

 

Settings:  

Start Station identifies the start station. Select a station from the list or use the locate 

button to identify the station. 

Stop Station identifies the end station. Select a station from the list or use the locate 

button to identify the station. 
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Type 

Cut indicates the addition is a cut value. 

Fill indicates the addition is a fill value. 

Volume specifies the additional volume. 

Factor defines how much the volume of the cut material will increase or decrease 

after it is removed from the ground. For example, a value of 1.3 means that the cut 

material will swell 1.3 times its original value. The default value is 1.0. 

Added Quantities lists all of the specified added quantities. 

Note: Added Quantities will have to change either the computational output or limit 

the input of the station range. 

Add adds a single additional quantity to the list based on the settings provided. 

Change modifies the selected quantity to the settings provided. 

Delete removes the selected quantity from the list. 

10.4.2 Forced Balance (End-area Volume) 

Use this dialog to apply forced balance at a given cross section station and apply it to either cut or 

fill. Forced balance allows you to balance your cut and fill to zero at critical points, such as a 

bridge, where hauling across may be impractical. 

A balance factor is calculated between stations where forced balance is applied. The balance 

factor is the accumulated fill divided by the accumulated cut up to the given station. If the forced 

balance is applied to cut, the adjusted cut volumes up to that station are multiplied by the balance 

factor. If the forced balance is applied to fill, the adjusted fill volumes up to that station are 

divided by the balance factor. At the forced balance stations, the accumulated cut and fill are reset 

to zero. 

Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a cross 

section model to use as the basis for End-Area volume calculations, or select the model 

graphically. When you select a cross section model from this list, the command places a 

region/fence in the drawing file around the cross sections that compose the model. The 

command also displays the horizontal alignment and surface(s) used when the cross sections 

in the model were extracted. 
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Settings 

Station identifies the cross section station. Select a station from the list or use the locate 

button to identify the station. 

Apply To: 

Cut indicates the forced balance is applied to cut. 

Fill indicates the forced balance is applied to cut. 

Forced Balance lists all of the specified forced balances. 

Add adds a single forced balance to the list based on the settings provided. 

Change modifies the selected forced balance to the settings provided. 

Delete removes the selected forced balance from the list. 

10.4.3 As Built (End-area Volume) 

Use this dialog to calculate volumes incrementally as the road is being built. Incremental 

reporting works against cut, fill, and substrata calculations. If you have unsuitable material, it is 

calculated in full when you specify the first As Built Surface. If you select Include Previous As 

Built Surface, the unsuitable material is excluded. 

If the As Built surface is incomplete, it is assumed to drop vertically. If this is not what you want, 

edit the cross section surface to reflect the way you want it to behave. 

Reporting and Annotation functionality reflect the As Built Volumes. 
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Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a cross section 

model to use as the basis for End-Area volume calculations. When you select a cross section 

model from this list, the command places a region/fence in the drawing file around the cross 

sections that compose the model. 

Settings: 

Compute As Built Volumes activates Settings and designates to compute As Built Volumes. 

As Built Surface allows you to select which cross section surface to use as the current As 

Built surface. Only cross section surfaces of type None appear in this list. Set the surface type 

to None before you cut the cross section or update the cross section. None surface type is used 

to ensure that the As Built surfaces do not interfere with design volume calculations. The final 

subgrade is included in this list to allow you to make the final incremental calculation. 

Include Previous As Built Surfaces when selected compares a previous As Built surface to 

the current As Built surface. Select this option and select a surface from the dropdown list. 

10.4.4 Annotation (End-area Volume) 

Use this dialog to annotate existing cross sections with area and volume information. 

Cross Section Model lists all the existing cross-section models, which are groups of extracted 

cross sections that are assigned unique identification numbers. From this list, select a cross section 

model to use as the basis for End-Area volume calculations. When you select a cross section 

model from this list, the command places a region/fence in the drawing file around the cross 

sections that compose the model. The command also displays the horizontal alignment and 

surface(s) used when the cross sections in the model were extracted. 

Note: All entities for display under End-Area Volumes >Annotation are annotated except Cut 

Volume, Fill Volume, Mass Ordinate and Tabulated Volume when a skewed section is 

encountered. Everything else on the End-Area Volume command is ignored. 
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(List) lists all of the entities available for display. 

Object lists available entities. For unsuitable materials shapes, cut and fill parts are displayed 

separately. 

Prefix specifies the alphanumeric text to include at the beginning of the annotation. 

Suffix specifies the alphanumeric text to include at the end of the annotation. 

Precision defines how many decimal places are expressed with the annotation. 

Location specifies where the annotation is placed relative to the cross section. 

Name/Color (Symbology) allows you to select a named symbology. Click on a color to open 

the Text Symbology or Line Symbology dialog. Set the horizontal and vertical offsets and 

justification values of the text symbology to control the exact placement of the annotation. 

You can annotate the total quantities of the substrata, component materials and material features 

by selecting the Tabulated Areas and Volumes. See Create Corridor for more information on 

creating component shapes, and Create Cross Section for their display. 

The display symbology for the component shape annotation and material feature shapes are 

defined by their respective surface feature styles. The display symbology for substrata shapes is 

defined by the cross section named symbology of the surface. 

10.4.5 End-Area Volume Report Generation 

Under the General tab there is the option to include the creation of XML output when the end-area 

volumes are run.  Upon completion the Bentley Civil Report Browser will automatically open. 

The XML file contains cross section information and more detailed volume information. 
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The XML files are temporary files that contain data that is formatted into reports by the View 

XML Reports command. The XML files are temporary unless you use the File > Save As on the 

Bentley Civil Report Browser to save them as HTML or text files.  

A report is the output generated when you display data from an XML file using the View XML 

Reports command. The View XML Reports command allows you to choose an XSL style 

sheet, which specifies exactly what information to pull from the XML file and how to format it. 

The XML file contains raw or computed data; the XSL file specifies how to format the data into 

a report. 

Dialog Box Options 

 

File (menu) 

Open activates the Open dialog, opens an XML data file. After you open an XML file, the 

name of the file is reported in the title bar at the top of the dialog. 

Save As displays the Save As dialog, which saves the report output into an HTML file, an 

XML file, a DOC file, XLS file or a text file. 

Many of the reports are formatted HTML content. Those reports can be saved as HTML files. 

However, some of the reports are composed of simple text. Those reports are saved as text 

files (*.txt).  

Note: If the style sheet used for the report contains embedded cascading style sheet 

references, you need to locate the CSS where it can be found by whoever opens the DOC file 

or you will get a warning that indicates the reference cannot be found. 

Append displays the Append dialog, which appends the contents of the right pane to an 

existing .txt file. 

Page Setup displays the Page Setup dialog, which allows you to select paper size, orientation, 

margins, and headers and footers for printing. 
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Print displays the print dialog, which allows you to print the report. 

Print Preview provides a preview of the printed report. The print preview reflects the current 

settings from the Page Setup dialog. 

Exit exits the Bentley Civil Report Browser  program. 

 

 

Tools (menu) 

 

Style Sheet Root specifies a directory for locating XSL files.  Bentley Civil Report Browser 

will find the XSL files in the specified directory and in any of its subdirectories. 

When you change the Style Sheet Root, the new root directory must contain copies of the 

following from the delivered directory structure: 

_Themes directory. 

format.xsl.contains the scripting that allows you to dynamically set the precision and 

formatting of the output. 

raw-xml.xsl.outputs file 

The browser will not operate correctly without them. The only exception is if all style sheets 

contained in the new root have been modified to remove the links to the cascading style 

sheets. In that case, the _Themes directory is no longer needed. Once the files are copied, you 

can modify them. 

Format Options activates the Format Options dialog, which lets you set the precision and 

format for displaying a variety of types of data in the report and utilizes the format.xsl. 
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10.5 Group Exercise: Road 1 Earthwork 

1. Within the data_10 folder, open the design file Corridors_J2P0200.dgn. 

2. Highlight the Road1 Corridor and in the Preferences and change the Design Stage from 

Preliminary design to Final design.  

This will drop the templates closer to each other and make interpolation much more 

accurate. 

3. Within the data_10 folder, open the design file XS_J2P0200_Road1.dgn. 

4. Open the road1 model. This model should contain the Road1 cross sections that we will 

use to run the End Area Volumes tool on. 

5. Select the End Area Volume tool  from the Corridor Modeling task group. 

6. Select Preferences located at the bottom of the End-Area Volumes dialog. 

7. In the Preferences dialog, select the preference named MODOT-Earthwork and click 

Load 

 

Preferences are predefined settings stored in the active XIN settings file delivered in the 

MoDOT workspace.  These preferences will be used for creating, annotating and 

computing end-area volumes on proposed cross sections. 

8. Close the Preferences selection dialog. 
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9. In the End-Area Volumes dialog, complete the General settings as shown below.  Make 

sure you toggle on the Create XML Report, and select the volume units of choice. 

 

 

10. Complete the Classifications settings as shown below. 
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11. Click Apply.  This will complete the following five tasks when processing. 

 Compute end-areas. 

 Compute volumes between sections. 

 Label cross sections with computed values. 

 When the volumes computations are complete, the Bentley Civil Report Browser will 

open when the toggle is activated.  The report browser allows the designer to review 

the end-areas as well as computed volumes for all surfaces. 

12. Look at multiple reports available in the Evaluation folder 

13. In the Bentley Civil Report Browser, select Tools > Format Options and adjust values to 

your preferences.  Notice how the report updates when changes are applied.  Click Close 

when adjustments are complete. 

14. In the report browser, toggle through the different earthwork reports available on the left 

to comprehend the many options available from these calculations. 

15. Close the Bentley Civil Report Browser. 

16. Close the End-Area Volumes dialog. 
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10.6 Individual Exercise: Route 63 Earthwork 

1. Within the data_10 folder, open the design file Corridors_J2P0200.dgn. 

2. Highlight the Route63 Corridor and in the Preferences and change the Design Stage from 

Preliminary design to Final design.  

3. Within the data_10 folder, open the design file XS_J2P0200_Route63.dgn. 

4. Open the Route63 model. This model should contain the Route63 cross sections that we 

will use to run the End Area Volumes on. 

5.  Select the End Area Volume tool  from the Corridor Modeling task group. 

6. Select Preferences located at the bottom of the End-Area Volumes dialog. 

7. In the Preferences dialog, select the preference named MODOT-Earthwork and click 

Load 

Preferences are predefined settings stored in the active XIN settings file delivered in the 

MoDOT workspace.  These preferences will be used for creating, annotating and 

computing end-area volumes on proposed cross sections. 

8. Close the Preferences selection dialog. 

9. In the End-Area Volumes dialog, complete the General settings as shown below.  Make 

sure you toggle on the Create XML Report, and select the volume units of choice. 
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10. Complete the Classifications settings as shown below. 

 

11. Click Apply.  This will complete the following five tasks when processing. 

 Compute end-areas. 

 Compute volumes between sections. 

 Label cross sections with computed values. 

 When the volumes computations are complete, the Bentley Civil Report Browser will 

open when the toggle is activated.  The report browser allows the designer to review 

the end-areas as well as computed volumes for all surfaces. 

12. Look at multiple reports available in the Evaluation folder 

13. In the Bentley Civil Report Browser, select Tools > Format Options and adjust values to 

your preferences.  Notice how the report updates when changes are applied.  Click Close 

when adjustments are complete. 

14. In the report browser, toggle through the different earthwork reports available on the left 

to comprehend the many options available from these calculations. 

15. Close the Bentley Civil Report Browser. 

16. Close the End-Area Volumes dialog. 
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11.1 Objectives 

 Understand and be able to use the GEOPAK Plan & Profile Sheet Generator 

11.2 Definitions 

Based on user-defined parameters and sheet size, sheet borders will be placed into a design file 

relative to a specific alignment.  Modifications may be made to sheet size and location.  Once the 

sheet boundaries are in the proper location, the designer may then place the sheet(s) into a design 

file(s) with the appropriate reference files and sheet cell. 

 

The CADD Support Center has set up a plan sheet library as a basis for generating typical plan 

and profile sheets.  These plan sheet library includes all of the settings, which include General 

Settings, Plan Drawing Area, Profile Drawing Area, Grid Settings, Tabular Data, etc. 

11.3 Accessing 

The Plan and Profile Sheets Generator must be invoked via the Road Project 

flow chart button Plan & Profile Sheets shown to the right. 

 

When the button is pushed the Plan & Profile Sheets Run Picker dialog appears.  

 

 
 

The user will copy the run that represents the scale in which he/she is interested.  Each run is 

configured to minimize user input. 
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RUN NAME  DESCRIPTION 

I100   English Sheet for a 1”=100’ scale 

I200   English Sheet for a 1”=200’ scale 

I50   English Sheet for a 1”=50’ scale 

I20   English Sheet for a 1”=20’ scale 

 

Upon entering a run, the Sheet Layout dialog appears.  The sheet scale part of the dialog is 

automatically set for each default run. 

 

 

11.4 Sheet Library 

A sheet library must be attached to the current session.  CADD Support has set up the tool so the 

MoDOT sheet library (modot.psl) is automatically attached. 

 

The sheet library contains all the parameters required to layout and to clip the sheets.  Only 

CADD Support is authorized to edit the MoDOT sheet library.  Any other sheet libraries will not 

be supported.  

11.5 Sheet Types 

The sheet library contains four types of sheets both for English and Metric projects.  They are: 

 

 Double Plan 

 Full Plan 

 Plan/Profile 

 Full Profile 

 

To select a sheet type, 

click in the list box 

area of the dialog, 

causing it to expand as 

shown to the right; 

move the cursor to the 

type of sheet desired and click again. 
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11.6 Sheet Layout 

Once the type of sheet has been selected, the user is ready to layout the sheets.  To access the 

layout process, select the layout icon from the dialog box or by selecting Tools>>Sheet Layout. 

 

 
 

The Layout Sheets dialog appears. 

 

 
 

11.6.1 Job Number 

The job number is populated based on the .gpk file selected through Project Manager.  With the 

job number selected, the user is ready to set up each port. 

11.6.2 Ports 

Depending on what type of sheet is selected, the user may have one or two ports.  A port is 

typically a rectangular area that shows a particular section in a sheet, for instance, a standard plan 

and profile sheet contains two ports, one plan port and one profile port. 

 

The job specific data for each port must be set.  If there are two ports, it is important to enter the 

data for Port 1 first.  Double click on a port to enter the data for that line. 

 

If it is a plan type port the next dialog box appears.  Select the chain via the pull down list box.  

Once the chain is selected, click the OK button. 
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If it is a profile port, the following dialog appears.  The profile must be selected from the Profile 

list box. 

 

 
 

The rest of the fields in the Profile Data area of the dialog can be filled in two ways.  One way is 

to manual fill each of the field with the proper information.  However, if a profile cell has been 

plotted for the alignment, the user can automatically populate the fields by clicking on the 

Identify Cell button and data pointing on the plotted cell.  If a profile cell does not exist, the 

Draw Cell at X, Y can be used to place a profile cell once the information has been manually 

entered into the dialog. 

 

The Profile Data fields contain the following information: 

 Station: station value of the data point used to define the location of the profile; 

 Elevation: elevation value of the data point used to define the location of the profile; 
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 Horizontal Scale: horizontal scale of the plotted profile; 

 Vertical Scale: vertical scale of the plotted profile; 

 DP X: the X coordinate of the profile location; and 

 DP Y: the Y coordinate of the profile location. 

 

The X and Y coordinates can be typed in or set by choosing the By DP button and data pointing 

in the MicroStation drawing to set the origin point.  If the profile has a station equation, the 

profile can be plotted with gaps or with no gaps. 

 

Once the profile information is populated, click on the OK button. 

11.6.3 Station Range 

The Beginning Station and Ending Station fields are automatically filled in with the station 

limits of the chain identified in the upper portion of this dialog box.  Should the user want to 

begin or end at a different location the user has the option to type in the station limits for sheet 

processing or click the DP button and data point a location on the screen along the center line. 

 

In addition, the user has the option to start the sheet layout before or after the beginning or end of 

the alignment by setting the appropriate values in the Extend field.  A positive number moves in 

the direction of increased stationing, while a negative number moves in the direction of 

decreased stationing.  For example, the values for the Begin Station shown below will cause the 

first sheet to start at station 445+00, which is 30.94 feet before the beginning of the chain. 

 

 
 

Based upon the begin and end station information the dialog will indicate how many sheets will 

be laid out as shown above.  The user then selects the Layout Sheets button to layout the sheets. 

11.7 Modify 

Once the above process is complete, the user should review the location of all the sheets to see if 

any modifications are needed. 

 

To access the Modify mode, select the Modify Sheets icon or the menu path Tools>>Sheet 

Modify. 
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Two major modifications are supported and are selected via icon in the upper left corner of the 

dialog box shown below.  The user has the options of Slide Sheets or Modify Drawing Area.  

As the modification type is selected, the dialog changes to reflect the selection. 

 

 
 

Slide Sheets - slides previously placed sheets along the alignment; adjacent sheets can remain in 

their original location or be moved as well. 

 

First, the user needs to identify the port to be modified by either selecting it from the list of all 

shapes in the current set or by pressing the Id button and graphically selecting the clipping shape 

for the port, which will automatically fill the Shape. 

 

 
 

Next, determine whether only one sheet is to be modified or if the modification should be carried 

over to adjacent sheets.  If the sheets preceding the current sheet are also to be moved, then 

activate the Slide Preceding Sheets toggle.  If the sheets after the current sheet are to be moved 

a corresponding amount as the original shape, activate the Slide Following Sheets.  If all sheets 

should be adjusted the same as the original sheet, activate both the Slide Preceding Sheets and 

Slide Following Sheets. 
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The sheets can be moved dynamically or by value.  The station of the sheet is populated when 

the sheet is selected.  To move the sheet along the alignment, enter the value (in terms of master 

units) in the Extend field or just enter the new station value.  If entering a value in the Extend 

field, a positive number moves in the direction of increased stationing, while a negative number 

moves in the direction of decreased stationing. 

 

To move dynamically, press the Dynamic button to the right of Extend, which attaches the sheet 

to the cursor.  Then place a data point to initiate moving the cursor, noting the station and Extend 

values changing as you move.  To stop the dynamics, place a final data point to identify the 

location and terminate sliding. 

 

To move the sheet further away (or closer to the alignment) without changing the stationing, use 

the Sheet Chord Offset using a value or dynamically 

 

The Rotation can be entered as an angle or dynamically.  Rotation always pivots about the left 

edge of the clipping shape.  Rotation alone does not cause Preceding or Following sheets to slide. 

 

Modify Drawing Area - modifies the Clip borders. 

 

 
 

The sheet must be identified using the same procedure as the Slide Sheets tool.  The Slide 

Preceding and Following Sheets is also supported. 

 

When the sheet is identified, the fields in the Lateral Dimensions are automatically populated.  

The user has the option to hold the Left Station, the Right Station or the Center Station.  Only 

one station can be held while the other two are adjusted to the revised drawing parameters.  Set 

the desired values and press the Apply button to commence redrawing. 

 

Note:  There are no dynamic options when changing the drawing area. 
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11.8 Sheet Number Manager 

Once the clipping shapes have been placed in the MicroStation drawing, the user can adjust the 

sequence of the sheets by using the Sheet Number Manager. 

 

The Sheet Number Manager can be accessed via pull down Tools >> Sheet Number Manager 

or by selecting the icon on the dialog box. 

 

 
 

Once the tool is selected the dialog below appears. 

 

 
 

The dialog lists all the sheets in the order they will be drawn.  By default the sequence of the 

sheets matches the sheet number.  If the sequence of the sheets needs to be adjusted, the user can 

highlight the sheet and use the up and down arrows on the right hand side of the dialog. 

 

The id icon allows the user to select a clip shape from the MicroStation file.  The associated line 

in the list box is highlighted. 

 

The Edit Sequence tool  may be used in the case that there are too many sheets to move 

with the arrows.  Highlight the sheet to be moved and press the icon.  The Edit Sequence 

Number dialog opens. 
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If for any reason the user needs to change the sheet numbers, the Edit Sheet Numbers  tool 

can be used.  The user needs to highlight the sheets to be changed and press the Edit Sheet 

Number icon, which opens the dialog shown below.  

 

 

 

 

 

 
 

The user has the option to add a prefix, append an alpha suffix, or do both.  The sheet numbers 

can be edited by the options shown below:  

 

To Sequence Number Add – It renumbers the sheet by adding a 

value to the original sheet number.  For example, if the original 

sheet number was 1 and sequence add number is 100; the new sheet 

number becomes 101. 

 

Starting at Sheet Number – The user specifies a given sheet number to start from. 

 

Fixed Alphanumeric - This field is used in combination with the bottom entries in the dialog.  

The user specifies to hold a fixed alphanumeric value and toggles the Append Alpha Suffix. 

11.9 Clip Sheets 

The Clip Sheets process can be accessed via pull down Tools>> Sheet Clip or by selecting the 

icon on the dialog box. 
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The following dialog appears. 

 

 

11.9.1 Output File 

Directory – Path to folder where the design file containing the sheet(s) will be placed. 

 

Sheet Name Prefix – Name of the design file containing the sheet (s).  GEOPAK will add a 1, 2, 

etc. to the end of each file name. 

 

Orientation - The tool supports two types of orientation, Rotate View and Rotate Reference. 

 

Rotate View - will attach all reference files and rotate the view to conform to the orientation of 

the sheet.  This option allows true coordinates for the file.  (Note: If Rotate View is used, tools 

such as Plan View Labeler, and DP Station and Offset can still be used).  Rotate Reference - 

Will rotate each reference file to orient itself with the sheet.  (Note: It is suggested to use the 

Rotate View mode.) 

 

Sheets per File - Indicates how many sheets are drawn per design file.  (Note: for Rotate 

Reference only) 

 

Model – The Clip Sheet Tool supports the use of models.  User can select the Active model or By 

Sheet Name. 
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Sheet Range – Allows the user to choose which sheets to clip by selecting a Begin and End 

range. 

11.9.2 Labels & Annotations 

Sheet Title- CADD Support has set this field to be the name of the project county for a standard 

MoDOT sheet title block. 

 

Match Lines – Will place a match line station. 

 

Auxiliary Sheet Annotations – Will allow the user to add any other notes not already set in the 

default settings.  Once the Auxiliary Sheet Annotations toggle is turned on, the Sample 

graphics button will become available, and the user can define the plot parameters accordingly. 

These Auxiliary Sheet Annotation will provide an additional label with the name of the chain, 

the rotation angle and the sheet number. 

 

 

 
 

Process Sheets - Once all the fields in the dialog box are entered, selecting the Process Sheets, 

initiates the sheet(s) creation. 

11.10 File Pulldown Menu  

Sheet Library – This menu option has options for creating, attaching, or editing a library.  

CADD Support maintains the MoDOT plan sheet library.  Other sheet libraries will not be 

supported. 
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Exit – Exits the Plan/Profile Sheets application. 

11.11 View Pulldown Menu  

When different types or scales of plan sheet shapes are placed within one plan view drawing, the 

view menu options allow the user to filter sheets by names or by scale to display the shapes 

accordingly. 

11.12 Settings Pulldown Menu 

Only one option is available in this pulldown menu.  The Sheet Layout settings option allows the 

user to set a Sheet Layout Progression, Profile Stair Stepping, and Sheet View Attributes. 

 

 

11.13 Tools Pulldown Menu 

Identify Sheet – Identifies the scale, port and number of the selected sheet shape  

 

Sheet Composition - Opens the sheet composition dialog box.  It allows the user to define the 

drawing area.  CADD Support has set up default settings for MoDOT users. 

 

Sheet Layout – Opens the layout sheet dialog. 

 

Sheet Clip – Opens the clip sheet dialog. 

 

Sheet Modify – Opens the modify sheet dialog 

 

Sheet Number Manager – Opens the sheet number manager. 

 

Draw Tabular Annotation (Sheet Clip Mode) – When the ports are set up in a tabular manner, 

this tool allows the user to define the tabular data to be included within the plan/profile sheets. 

 

Process Classic Plan & Profile Runs – This will import certain information from the Classic 

Plan & Profile runs to create a sheet library.  MoDOT has developed the modot.psl as the library 

to be used with the MoDOT default runs. 
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11.14 Group Exercise: Road1 

 

1. Within the J2P0200\data_11 folder, open the file: Plan_J2P0200.dgn 

 

2. Create a new file named Plan_Profile_J2P0200.dgn based on the following 2D seed file: 

 

pw:\CADD_Standards\Seed Files\Design - English\i_project_2d_PowerGEOPAK.dgn 
 

3. Reference in the following files: 

 

Civil_Geometry_J2P0200.dgn 

 

Corridors_J2P0200.dgn 

 

Land_Boundaries_J2P0200.dgn 

 

Plan_J2P0200.dgn 

 

Profile_J2P0200.dgn 

 
 

 

 

 

 

4. Click on the Project Manager icon and open the following GEOPAK project: 

 
pwname:\\MoDOT\Documents\District CADD\Design\Randolph#\J2P0200\project\J2P0200.prj 
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5. Edit the PRJ file so that the job200.GPK file located in the data_11 folder can be found. 

 

  
 

  
 

 

6. Enter the project as ClsUser for this exercise.   

 

 

  
 

 

 

 

 

 

 

 

 

 

 

A. Edit PRJ 

 

B. Clear out working directory 

 

C. Open COGO Preferences 

 

D. Clear out Job Directory 

 

E. Click OK to move on 
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7. Select Plan & Profile Sheets from the Road Project flow chart 

   

 
 

 

 

8. Select Run >> Copy >> Run and choose the I50 run. 

 

 
 

 

 

9. Name the new run Road1 and give it a description to identify a 50 scale has been used.  Then 

open the newly copied Road1 run. 
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10. Select the Plan/Profile sheet from the pull down. 

 

 
11. Select the Layout Sheets via icon as shown above or by pull down menu Tools>>Sheet 

Layout. 

   

 

 

12. Set up the Layout Sheets dialog with the information for the Road1 working alignment: 

 

Select Job 200 by clicking on the open folder icon, as shown below.  

 

Double click on Plan (Port 1).  Select the Road1 chain from pull down. 

 

 
 

Double click on Profile (Port 2).   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A. Select ROAD1PR profile 

 

B. Select ROAD1 chain 

 

C. Select Identify Cell 

 

D. Click OK to move on 
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13. Click the Layout 3 Sheets button to create the sheet blocks for the plan and profile sheets. 

 

  

 

 

 

 

 

 

 

 

 

14. Select the Clip Sheets icon or via pull down menu Tools >> Sheet Clip 
 

 

 

 

 
 

Populate the Clip Sheets dialog as shown below. 

  

 The directory to create the sheets to will be:  
 pwname:\MoDOT\Documents\ District CADD\Design\Randolph#\J2P0200\data_11 
 

      Once the information is filled out, select Process Sheets. 
 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A. Path the directory to place the sheet files 

- District CADD\Design\Randolph#\J2P0200\data_11 

 

B. Name the sheet prefix – PLPR_Road1 

 

C. Sheet Title county name – RANDOLPH 

 

D. Project Number – J2P0200 

 

E. Match Line – STA. (space after the period) 

 

F. Click the Process Sheets button to begin 

processing 
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15. Open a newly created plan-profile sheet.  

 

16. Open the Reference Dialog and detach the extra references that get created by default. 

 

 
As you select the references the plan or profile port will highlight.  

Remove the profile information from the plan port and the plan information from the profile port 

by detaching the “extra” references. 
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17. Open the MicroStation Level Display tool and using the “Off By Element” option from the 

right click menu turn off the display of the red shape surrounding the plan port and the white 

shape surrounding the profile port. 

 

18. Turn on Level Border-Plan-profile major grid lines in the MoDOT_DE_2008.dgn 

reference file in the plan sheets. 

 

 
 

 

 

 

19. Use the option in the reference dialog to do an exchange into any files that have text that 

need to be moved and rotated for the plan sheet to have the correct look and modify as 

needed. 
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20.  Place a north arrow using AccuDraw to complete the plan sheet. 
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11.15 Individual Exercise: Route63 

 

1. Using ProjectWise open the following MicroStation file: 

 
 pwname:\\MoDOT\Documents\DistrictCADD\Design\Randolph#\J2P0200\data_11\Plan_J2P0200.dgn 

 

 

 

2. Open the Project Manager icon and open the following GEOPAK project: 

 
pwname:\\MoDOT\Documents\District CADD\Design\Randolph#\J2P0200\project\J2P0200.prj 

 

        
 

 

 

 

3. Enter the project as ClsUser for this exercise.   
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4. Select Plan & Profile Sheets from the Road Project flow chart 

   

 
 

 

 

5. Select Run >> Copy >> Run and choose the I50 run. 

 

  
 

 

 

 

 

 

  Name the new run Route63.  Open the newly copied Route63 run. 

   

      Select the Plan/Profile sheet from the pull down. 

   
   

Select the Layout Sheets via icon or by pull down menu Tools>>Sheet Layout. 
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6. Set up the Layout Sheets dialog with the information for the Route63 working alignment: 

   

Select Job 200 by clicking on the open folder icon, as shown below.  

   

Double click on Plan.  Select the Route63 chain from pull down. 

   

  Double click on Profile.  Select the Identify Cell button and then select the Geopak Cell 

pertaining to Route63.   

 

7. Once the Ports have been populated, select the Layout Sheets button. 
 

This will place the sheet blocks around the plan and the profiles in the design file. 

 

 

 

 

8. Select the Clip Sheets icon or via pull down menu Tools >> Sheet Clip 
 

 

 

  

  

       

 The directory to create the sheets to will be:  
 pwname:\MoDOT\Documents\ District CADD\Design\Randolph#\J2P0200\data_11 
 

 Once the information is filled out, select Process Sheets. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

    

 

 

 

 

A. Path the directory to place the sheet files 

- District CADD\Design\Randolph#\J2P0200\data_11 

 

B. Name the sheet prefix – PLPR_Route63 

 

C. Sheet Title county name – RANDOLPH 

 

D. Project Number – J2P0200 

 

E. Match Line – STA. (space after the period) 

 

F. Click the Process Sheets button to begin 

processing 
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9. Open a newly created plan-profile sheet.  

 

10. Open the Reference Dialog and detach the extra references that get created by default. 

 

11. Open the MicroStation Level Display tool and using the “Off By Element” option from the 

right click menu turn off the display of the red shape surrounding the plan port and the white 

shape surrounding the profile port. 

 

12. Turn on Level Border-Plan-profile major grid lines in the MoDOT_DE_2008.dgn 

reference file in the plan sheets. 

 

13. Use the option in the reference dialog to do an exchange into any files that have text that 

need to be moved and rotated for the plan sheet to have the correct look and modify as 

needed. 

 

14. Place a north arrow using AccuDraw to complete the plan sheet. 
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